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FOREWORD

The Government of India has set an ambitious target of imparting skills to 30 crores people, one out of every

four Indians, by 2020 to help them secure jobs as part of the National Skills Development Policy. Industrial

Training Institutes (ITIs) play a vital role in this process especially in terms of providing skilled manpower.

Keeping this in mind, and for providing the current industry relevant skill training to Trainees, ITI syllabus

has been recently updated with the help of Mentor Councils comprising various stakeholder's viz. Industries,

Entrepreneurs, Academicians and representatives from ITIs.

The National Instructional Media Institute (NIMI), Chennai has now come up with instructional material to

suit the revised curriculum for COPA Volume II of II Trade Practical NSQF Level - 3 (Revised 2022) in

IT & ITES Sector. The NSQF Level - 3 (Revised 2022) Trade Practical will help the trainees to get an

international equivalency standard where their skill proficiency and competency will be duly recognized

across the globe and this will also increase the  scope of recognition of prior learning. NSQF Level - 3

(Revised 2022) trainees will also get the opportunities to promote life long learning and skill development.

I have no doubt that NSQF Level - 3 (Revised 2022)  the trainers and trainees of ITIs, and all stakeholders

will derive maximum benefits from these IMPs and that NIMI's effort will go a long way in improving the

quality of Vocational training in the country.

The Executive Director & Staff of NIMI and members of Media Development Committee deserve appreciation

for their contribution in bringing out this publication.

Jai Hind

Addl. Secretary/Director General (Training)
Ministry of Skill Development & Entrepreneurship,

Government of India.

         New Delhi - 110 001
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PREFACE

The National Instructional Media Institute (NIMI) was established in 1986 at Chennai by then Directorate

General of Employment and Training (D.G.E & T), Ministry of Labour and Employment, (now under Ministry

of Skill Development and Entrepreneurship) Government of India, with technical assistance from the Govt.

of the Federal Republic of Germany. The prime objective of this institute is to develop and provide instructional

materials for various trades as per the prescribed syllabi (NSQF LEVEL - 4) under the Craftsman and

Apprenticeship Training Schemes.

The instructional materials are created keeping in mind, the main objective of Vocational Training under

NCVT/NAC in India, which is to help an individual to master skills to do a job. The instructional materials are

generated in the form of Instructional Media Packages (IMPs). An IMP consists of Theory book, Practical

book, Test and Assignment book, Instructor Guide, Audio Visual Aid (Wall charts and Transparencies) and

other support materials.

The trade practical book consists of series of exercises to be completed by the trainees in the workshop.

These exercises are designed to ensure that all the skills in the prescribed syllabus are covered. The trade

theory book provides related theoretical knowledge required to enable the trainee to do a job. The test and

assignments will enable the instructor to give assignments for the evaluation of the performance of a trainee.

The wall charts and transparencies are unique, as they not only help the instructor to effectively present a

topic but also help him to assess the trainee's understanding. The instructor guide enables the instructor to

plan his schedule of instruction, plan the raw material requirements, day to day lessons and demonstrations.

In order to perform the skills in a productive manner instructional videos are embedded in QR code of the

exercise in this instructional material so as to integrate the skill learning with the procedural practical steps

given in the exercise. The instructional videos will improve the quality of standard on practical training and

will motivate the trainees to focus and perform the skill seamlessly.

IMPs also deals with the complex skills required to be developed for effective team work. Necessary care

has also been taken to include important skill areas of allied trades as prescribed in the syllabus.

The availability of a complete Instructional Media Package in an institute helps both the trainer and

management to impart effective training.

The IMPs are the outcome of collective efforts of the staff members of NIMI and the members of the Media

Development Committees specially drawn from Public and Private sector industries, various training institutes

under the Directorate General of Training (DGT), Government and Private ITIs.

NIMI would like to take this opportunity to convey sincere thanks to the Directors of Employment & Training

of various State Governments, Training Departments of Industries both in the Public and Private sectors,

Officers of DGT and DGT field institutes, proof readers, individual media developers and coordinators, but for

whose active support NIMI would not have been able to bring out this materials.

Chennai - 600 032      EXECUTIVE DIRECTOR
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INTRODUCTION

TRADE PRACTICAL

The trade practical manual is intented to be used in workshop . It consists of a series of practical exercises to be
completed by the trainees during the  course of the COPA Vol II of  II  Trade  supplemented and supported by
instructions/ informations to assist in performing the exercises. These exercises are designed to ensure that all
the skills in compliance with NSQF LEVEL - 3 (Revised 2022)

Module 30 - Set-up & Configure a Computer Network

Module 31 - Create Simple Static Web Pages using HTML Tags

Module 32 - JavaScript Embed JavaScript in HTML Pages

Module 33 - Data Visualization or Analysis using Excel

Module 34 - Browse E-Commerce Sites to Identify Products & Services

Module 35 - Protect  Information, Computers and Networks from Viruses, Spyware and other
Malicious Code

Module 36 - Cloud Computing

Module 37 - Develop an application and perform the Application Development Life Cycle

Module 38 to 42 - Elective Module I Programming in Python

Module 38 to 42 - Elective Module II Programming in JAVA

The skill training in the shop floor is planned through a series of practical exercises centred  around some practical
project. However, there are few instances where the individual exercise does not form a part of project.

While developing the practical manual a sincere effort was made to prepare each exercise which will be easy to
understand and carry out even by below average trainee. However the development team accept that there  is a scope
for further improvement.  NIMI, looks forward  to the suggestions from the experienced training faculty for improving
the manual.

TRADE THEORY

The manual of trade theory consists of  theoretical  information for the course of the COPA Trade.  The contents
are sequenced according to the practical exercise contained in the manual on Trade practical.  Attempt has been
made to relate the theortical aspects with the skill  covered in each exercise to the extent possible. This co-relation
is maintained to help the trainees to develop the perceptional capabilities for performing the skills.

The Trade theory has to be taught and learnt along with the corresponding exercise contained in the manual on trade
practical. The indicating about the corresponding practical exercise are given in every sheet of this manual.

It will be preferable to teach/learn the trade theory connected to each exercise atleast one class before performing
the related skills in the shop floor. The trade theory is to be treated as an integrated part of each exercise.

The material is not the purpose of self learning and should be considered as supplementary to class room  instruction.
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S.No. Learning Outcome Ref. Ex.No.

6 Install, setup/configure, troubleshoot, and secure computer network
including Internet. (Mapped NOS: SSC/N3022) 1.30.101 - 1.30.112

7 Develop web pages using HTML and CSS. (Mapped NOS: SSC/N0503,
SSC/N0501) 1.31.113 - 1.31.114
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SSC/N0501) 1.32.115 - 1.32.121

9 Create workbooks with advanced formulas, macros, charts, pivot tables
and demonstrate ability to use Power tools. (NOS: SSC/N9402) 1.33.122 - 1.33.129

10 Browse, select, and transact using E- commerce websites
(NOS: SSC/N9403) 1.34.130 - 1.34.137

11 Secure information from Internet by using cyber security concept.
(NOS: SSC/N9404) 1.35.138 - 1.35.139

12 Explain Cloud concepts &services and Describe Application Development
Life Cycle. (NOS: SSC/N9405) 1.36.140 - 1.37.145

13 Write programs using Python language. ( NOS: SSC/N9406) 1.38.01 - 1.42.11

14 Writing programs using JAVA. (SSC/N9407) 1.38.01 - 1.42.30

LEARNING / ASSESSABLE OUTCOME

On completion of this book you shall be able to
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IT & ITES	 	 Exercise 1.30.101	
COPA - Set-up & Configure a Computer Network	

View network connections
Objectives: At the end of this exercise you shall be able to
•	 view the status of Network connection available on your computer.

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 Network Connectivity (Wired 			 

/ Wireless)	 - 1 No.

PROCEDURE

TASK 1:  View and change the IP address of your computer 

1	 Choose the network icon and right click from the 
desktop.

Note : A menu displayed on the screen as on 
Fig 1.

2	 Choose “Properties”

Note: A “View your basic network information 
and setup connection” window appears as on 
Fig 2.

3	 Click “Change adapter setting” option as shown in 
Fig 2.

Note : A menu gets displayed on the screen
4	 Here you could identify the available Network 

Connections ( Wired – Ethernet / Wireless – WiFi) 
then Choose any “Local area connection” and right 
click it. (Fig 3)

5	 Click “ Status” – where you could see the status 
of Network Connection ( Connected / Disconnected) 
and other details (Fig 3)

6	 Click “ Details” to get the IP address of the Network 
Connection. (Fig 4 & 5)

•	 Network Switch	 - 1 No.

Fig 1

Fig 2
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Fig 3

Fig 5Fig 4
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IT & ITES	 	 Exercise 1.30.102	
COPA - Set-up & Configure a Computer Network	

Connect a computer to a network and share Devices i.e. Printers, files, folders 
and drives
Objectives: At the end of this exercise you shall be able to
•	 share the printer, folder and drives with the network
•	 share the specific files or folders in local network
•	 how to connect Shared Printer or Folders

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 Network Connectivity (Wired 			 

/ Wireless)	 - 1 No.

PROCEDURE

TASK 1:  Share the printer, folder and drives with the network 

1	 Share the printer panel as follows :

	 Start      Control panel       Hardware and Sound  
         Devices and Printers.

Note : There you will see a list with all  
external devices installed on your PC as in 
Fig 1.

2	 Select the printer you want to share, right click on it 
and select Printer properties.

Note : Now you will see a window with all the 
printer properties. Depending on the model 
of your printer, and its drivers, you can see 
different sets of options.

3	 Click on the Sharing tab.

Note : There, you will have some options 
similar to the Fig 2.

•	 Network Switch	 - 1 No.
•	 Network Printer	 - 1 No.

4	 Select any check box that says ‘Share this printer’.

Note : Then, you can edit the printer share 
name which, in most cases, is by default 
completed by Windows with the name of your 
printer model. If you want to change it, type 
the name you want to use.
Note : “Render all print jobs on the client 
computers” can help keep performance 
levels up on the computer where the printer is 
plugged in, especially when big printing jobs 
are ordered. When this option is checked, all 
the print jobs are rendered on the computers 
which order the print job, not on the computer 
on which the printer is plugged.

5 Click on OK

Note : Now the printer will be shared with the 
computers on your network.
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4

1	 In windows, search for and open File Explore.

2	 Browse to the folder or file you want to share.
4	 In the file sharing window select the user accounts 

(Everyone) with whom you want to share file with 
Permission of ( Read / Read Write ) and click on 
Share button.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.102

TASK 2 : Share the specific files or folders in local network

3	 Right-click on the file/folder which you want to share 
then Choose Give Access to Or Right-click the 
foldeí, and select the Properties option. Click on the 
Sharing tab and choose the Share button. 

5	 Confirm the folder’s network path that other users 
need to access the network’s content and click the 
Done button.

TASK 3 : How to connect Shared Printer

After setting up your shared printer, you can connect 
to it multiple ways. This method is from within Devices 
and Printer.

Open control panel           Devices & Printers

1	 Click the Add Printer button, then click the link, The 
printer that I want isn’t listed. Choose the Select a 
shared printer by name radio box, browse to the 
printer on your network, and click open.
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2	 You will be prompted to install the driver. Click Next 
to complete the installation of the printer.

4	 Another way you can connect to a shared network 
printer is from within File Explorer. Open the Network 
folder, browse the shared printer’s computer, right-
click it, then click Connect

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.102

3	 The printer will now show up in Devices and printers 
as a local device.

TASK 4 : How to connect Shared Folders

1	 Open File Explorer from the taskbar or the Start 
menu, or press the Windows logo key + E.

2	 Select This PC from the left pane. Then, on the 
Computer tab, select Map network drive.

3	 In the Drive list, select a drive letter. (Any available 
letter will do.)

4	 In the Folder box, type the path of the folder or 
computer, or select Browse to find the folder or 
computer. To connect every time you sign in to your 
PC, select Reconnect at sign-in.

5	 Select Finish.

6	 Connected Shared Folder available in This PC as 
Network Drive in Network Locations
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7	 To disconnect shared folder, just right-click the drive 
in File Explorer and choose “Disconnect.”

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.102
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IT & ITES	 	 Exercise 1.30.103	
COPA - Set-up & Configure a Computer Network	

Work with various Network devices, connectors and cables. Create straight 
and cross cable and punch a UTP cable in the patch socket and test the 
connectivity
Objectives: At the end of this exercise you shall be able to
•	 identify various network devices, cables and connectors used in networking
•	 create straight and cross cable and punch a UTP cable in the patch socket
•	 testing the cable connectivity with the LAN tester
•	 create workgroup and check the network connections
•	 create a home group on a local network

Requirements

Materials/components
•	 UTP cable (CAT6 /6e)	 - as reqd.
•	 RJ45 jack	 - as reqd.
•	 Thin coaxial cable RG48	 - as reqd.
•	 BNC connector	 - 1 No.
•	 T connector	 - 1 No.
•	 Terminator	 - 1 No.

Tools/Equipment/Instruments
•	 All the Available Network Devices	 - 1 No.
•	 Crimping Tool	 - 1 No.
•	 Cable Cutter	 - 1 No.

PROCEDURE

TASK 1:  : Identify Network Devices / cables and connectors 

1	 Identify a labelled component referring to Table 1 
and record the details in the Record sheet.

2	 Get the work checked by your instructor.

Record sheet - Table 1
	 Network Devices	 No.of Ports Available	 Name the Ports
	 Hub		

	 Switch		

	 Modem		

	 Firewall		

	 Gateway

	 Board Band Modem		

	 Fiber Modem

Record sheet - Table 2
	 Cable/ connector	 Label	 Brief application
	 UTP cable	 No.of pins color code Printed mark		

	 Coaxial cable		

	 RJ 45 connector	 No.of pins		

	 T connector		

	 Terminator	 Resistance between inner and outer core
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TASK 2 : Create straight and cross cable and punch a UTP cable in the patch socket 

Note to instructor : Instructor must arrange the 
required length of cross cable, the tool for crimping and 
two computer for making connection as shown in Fig 1.

1	 Use crimping tool (as shown in Fig 2) to cut through 
a cable and strip the cable jacket/insulation using 
cable stripper/ crimping.

Note : Crimp tools have two blades. One 
designed to cut the cable and other to strip 
the jacket. While stripping the cable care 
should be taken not to cut the internal wires. 
Remove the jacket insulation about an inch. 
When the jacket insulation removed you will 
find eight wires twisted in to four pair (for CAT 
5 cable as in Fig 3) and a separator inside the 
CAT 6 cable as shown in Fig 3a.

2	 Cut the separator off and untwist the wires back to 
within one-eighth inch of the jacket

3	 Arrange the wires from left to right in the order they 
are to be crimped. The normal crimping order for 
cross cable is shown in Fig 4 & Fig 4a

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.103

Fig 1

Fig 2
Fig 2

 

 

Fig 3a

 

 

Fig 3a

Fig 4

Fig 4a

Note : The color code wiring order is different 
for both ends in cross cable

•	 Cross over cable

•	 One end (Fig 4)

•	 Other end (Fig 4a)

4 	 Grasp the wires firmly between your fingers and 
flatten them to remove the curliness.

Note : The wires must lay flat and together 
aligned as closely as possible in order. When 
finished the cable should look like as shown 
in Fig 5 

 

 

Fig 5

5	 Cut a few mm while holding them firmly, so they are 
all of the same length as shown in Fig 6.
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6	 Slide the RJ45 connector on to the wires making 
sure the wires stay lined up.

Note : Try to make each wire fits in the slot 
of the connector and make each wire reach 
the end of its slot. The cable jacket/insulation 
should reach just beyond the end of the crimp 
point as shown in Fig 7. 

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.103

 

 

Fig 6

 

Fig 7

7	 Verify all the wires are in the correct order, and insert 
the connector in to the crimping tool and press to 
crimp as shown in Fig 8.

Fig 8

Note : Now half of the work done. The cable 
should look like as shown in the Fig 9 .The 
process must be repeated for the other end 
of the cable. However the color code wiring 
order changes for cross cable as shown in  
Fig 10.

Fig 9

Fig 10

Note : Similarly straight through cable and 
roll over cable can be prepared with the help 
of the instructor. The color code wiring order 
is shown in Fig 11.

 

Fig 11

 

Fig 11

Fig 11
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1	 Green White

2	 Green

3	 Orange White

4	 Blue

5	 Blue White

6	 Orange

7	 Brown White

8	 Brown	

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.103

Note : Cross over cable is used to connect 
be- tween two hosts(PC’s). Straight-through 
cable is used in a network when connecting 
a host to a switch. A rollover cable is used 
in a net- working environment where a outer/
switch is to be configured from a computer. 
One end is wired one way but on the other it 
is reversed. You would typically use one end 
into a serial port on a PC and the other into 
the console port of the switch/router.

TASK 3 : Testing the cable with the LAN tester

1 	 Insert one end of the cross cable (prepared in Task 
1)in to one socket and other end in another plugged 
in socket of the LAN tester as shown in Fig 12.

Fig 12

2 	 Switch ‘ON’ the LAN tester.

3 	 Note the order in which LED’s glowing in both the 
panelof the LAN tester should correspond to the 
order shownin Fig 13. 

If the LED’s doesn’t glow , then there is a break in the 
cable.

Note : Check for the batteries loaded in cable 
tester.

One side      other side
Fig 13
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IT & ITES	 	 Exercise 1.30.104	
COPA - Set-up & Configure a Computer Network	

Practice IP Addressing and Subnet masking for IPV4/ IPV6 and pinging to test 
networks
Objectives: At the end of this exercise you shall be able to
•	 configure IPV4/IPV6 address and subnet mask
•	 ping to test network.

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 Network Connectivity (Wired 			 

/ Wireless)	 - 1 No.

PROCEDURE

TASK 1:  Assign different classes of IPv4 addressing 

1	 Connect PCs with switch using RJ45 cable as shown 
Fig 1.

2	 Power on the PCs and network switch.

3	 Type network connections in the search in PC1.  
(Fig 2)

4	 Select “View network connections”. (Fig 3)

5	 Right click on Ethernet and select properties. (Fig 4)

6	 Select Internet protocol version 4 (TCP/IPv4) and 
click properties as shown Fig 5.

•	 Network Switch	 - 1 No.
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7	 Select use the following IP address and assign IPV4

	 For example : Class A IP address - 10.0.0.1 and 
subnet mask 255.0.0.0 (Fig 6)

8	 Assign IP address to other PCs 10.0.0.2, 10.0.0.3 
and 10.0.0.4 etc.

9	 Assign the same subnet mask to all PCs.

TASK 2: Test connectivity between computers

1	 For testing connectivity between computers using 
basic network commands.

2	 Open command prompt and Check IP configuration 
using the command ipconfig. (Fig 7)

3	 Note the systems IP configuration.

4	 Then check connectivity between system using ping 
command

5	 First self test to ping own IP. 

	 Ex: ping 10.0.01 and note the result. (Fig 8)

6	 Check the connectivity to other systems using their 
IP address and note the result.

7	 Change IP address and subnet mask of all PCs to 
class-B.

8	 Example: 172.16.0.1 to 172.16.0.2 and so on etc. 
with subnet mask 255.255.0.0 to all PCs.

9	 Repeat the steps 2 to 6 to test the network.

10	Change IP address and subnet mask of all PCs to 
class-C.

11	Example: 192.168.0.1 to 192.168.0.2 and so on 
etc. with subnet mask 255.255.255.0 to all PCs.

12	Repeat the steps 2 and 6 to test the network.

13	Change the IP address of PC1 to class B and keep 
all other systems in Class A.

14	Check the connectivity from PC1 to other system 
using Ping command.

15	Note the result.

16	Repeat the steps 13 to 15 by changing IP addresses 
to different classes.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.104

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



13

TASK 3: Configure IPV6 Address and Test

1	 Open Control Panel and Navigate  Network and 
Internet       Network Connections

2	 Select “View network connections”.

3	 Right click on Ethernet and select properties.

4	 Select Internet protocol version 6 (TCP/IPv6) and 
click properties as shown Fig 9.

5	 Select Obtain an IPV6 Address Automatically as 
assign from DCHP or Use the following IPV6 address 
as Static assign Manually.

6	 Assign IP address to all PCs 2001:DB8:ABCD:12::1, 
2001:DB8:ABCD:12::2 and 2001:DB8:ABCD:12::3 
etc.

7	 Subnet Prefix Length: 64 and assign the same to all 
PCs.

8	 Click OK to save Static IPV6 Address.

9	 To check the connectivity, use the PING command in 
CMD Prompt. 

	 Ping 2001:DB8:ABCD:12::1

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.104
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IT & ITES	 	 Exercise 1.30.105	
COPA - Set-up & Configure a Computer Network	

Configuring HUB & switch
Objectives: At the end of this exercise you shall be able to
•	 install and configure HUB and switch.

Requirements
Tools/Equipment/Machines
•	 Switch Rack	 - 1 No.
•	 Patch Panel	 - 1 No.
•	 Network Switch / Hub	 - 1 No.

PROCEDURE

TASK 1:  Configure hub and switch 
1	 Select the HUB / Switch.

2	 Select Switch Rack.

3	 Fit the HUB/ Switch in the Switch rack by screws.

4	 Insert all the LAN cables into the Switch rack.

5	 Punch the LAN cables in patch panel ports by 
Punching tools according to color code

6 	 Connect all the connected ports of Patch Panel to 
the HUB/ Switch ports by patch cables. 

7	 Connect the power source of HUB/ Switch.

8	 Now it is ready to use.

•	 UTP Cat6 / 6e  Cable 	 - as reqd.
•	 Krone Punching Tool	 - 1 No.
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IT & ITES	 	 Exercise 1.30.106	
COPA - Set-up & Configure a Computer Network	

Setup and configure wired and wireless LAN in a Computer Lab within at least 
three computers
Objectives: At the end of this exercise you shall be able to
•	 setup wired Ethernet network
•	 setup wireless network for LAN.

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 MS Office 2019 / Latest	 - 1 No.

PROCEDURE

TASK 1:  Setup wired Ethernet Network 

1	 Make sure that all computers are plugged into a 
powered electrical outlet and turned on.

2	 Make sure that the router, hub or switch is plugged 
into a powered electrical outlet and turned on.

Most routers, hubs, and switches have Power 
lights that indicate they are working.

3	 Make sure that your Ethernet RJ45 Jack Patch cable 
is plugged into the Ethernet Port on your computer.

4	 Make sure that the other end is plugged into a router, 
hub or switch.

5	 Make sure that all computers on your network have 
the same workgroup or Domain name.

6	 Make sure that all computers are assigned IP 
address by DHCP or Static.

7	 Make sure that all computers have unique IP 
addresses with same subnet mask.

8	 Check the connectivity using PING command.

9	 If connectivity established then all set to Work.

For home networks, IP addresses should be 
192.168.N.N where N is a number you assign 
between 0 and 254. The first N should be 
the same for all computers on your network 
and the second N should be different for all 
computers on your network.

The computer does not recognize an add-in Ethernet 
card
1	 Shut down and restart your computer.

2	 Make sure that you have installed the required 
software.

3	 Reset the card

TASK 2: Setup Wireless Network
1	 Make sure that all computers are plugged into a 

powered electrical outlet and turned on.

2	 Make sure that the Wifi router or Access Point is 
plugged into a powered electrical outlet and turned 
on.

Most Wifi routers and Access Points have 
Power lights that indicate they are working.

3	 Make sure that Wifi router or Access Point has 
configured SSID name with Secure Encrypted 
Password.

4	 Make sure that Wifi is ON or enabled in your 
computer.

5	 Make sure that your computer successfully connected 
to same SSID with Encrypted Password

6	 Make sure that all computers on your network have 
the same workgroup or Domain name.

7	 Make sure that all computers are assigned IP 
address by DHCP or Static.

8	 Make sure that all computers have unique IP 
addresses with same subnet mask.

9	 Check the connectivity using PING command. 

10 If connectivity established then all set to Work.

For more details refer Ex.no. 1. 4.19 Task 2.
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IT & ITES	 	 Exercise 1.30.107	
COPA - Set-up & Configure a Computer Network	

Use patch panel & I/O Box for wired LAN and installing & configuring Internet 
connection in a single PC and in a LAN
Objectives: At the end of this exercise you shall be able to
•	 how to Install and Configure Networking Using Patch Panel
•	 how to Terminate and Install Cat5e / Cat6 cable in IO Box.

Requirements
Tools/Equipment/Machines
•	 Any size Mountable rack	 - 1 No.
•	 Patching Panel 24 Port	 - 1 No.
•	 Cat6 / Cat 6e UTP cable	 - as reqd. 
•	 24 Port L2 Switch	 - 1 No.
•	 Patch Cable	 - as reqd.
•	 Punching Tool	 - 1 No.

PROCEDURE

TASK 1:  How to Install and Configure Networking Using Patch Panel 

1	 Determine where the patch panel and switch should 
be installed

	 Evaluate the operating environment, a place where 
the equipment and components can be maintained 
well and accessed easily. Unobstructed airflow and 
vents are crucial. 

•	 UTP Cable Cutter	 - 1 No.
•	 Lan tester	 - 1 No.
•	 IO Port	 - 1 No.
•	 IO Back Panel	 - 1 No.
•	 IO front Panel	 - 1 No.

2	 Build or purchase pre-terminated patch cords

	 Determine patch cord lengths as well as the quantity 
needed for the installation. If improper lengths are 
chosen, cables with excessive slack will not only 
increase material and installation cost but also 
hinder cable management.

3	 Map out the ports

	 Determine which switch port is connecting to which 
patch panel port, by doing this can reduce installation 
time.

4	 Mount the patch panel and switch

	 Ensure the server rack accommodates the size of 
your components (EIA standard 19” width is most 
common). 

•	 Choose the size of wall mounting Rack or Stand 
Rack to fix the Patch Panel

•	 Fix patch panel into Rack using screw at right 
and left sides.
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•	 Examine the 110-style punch down connectors 
on the back of the Cat6e patch panel.

•	 Remove the outer jacket from the end of each 
cable. 

•	 Spread out the cable wires.

•	 Set the wires into the patch panel connectors.  
There are two color patterns T568A and T568B. 
Make sure to terminate both sides of the cable on 
the same pattern used, Preparable T568B. 

•	 Begin terminating each wire using Punching Tool

5	 Connect the patch panel to the switch

	 With the prepared patch cords, follow the port 
mapping created in step 3 and patch the cables.

6	 Install cable management

	 Using horizontal and vertical cable management and 
cable ties to organize cables can help make future 
changes and upgrades easy.

7	 Label cable

	 Tag both ends of each cable the same; this can assist 
in troubleshooting your end-to-end connectivity 
between the patch panel and the switch.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.107
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TASK 2: How to Terminate and Install Cat5e / Cat6 cable in IO Box
Step 1

Insert the cable into the stripping tool to the required 
strip length. Strip off only as much cable jacket needed 
to properly terminate the pairs (1 to 1.5 inches should 
be sufficient to terminate pairs). 

Holding the cable near the tool, rotate the tool around 
the cable several times. Slightly bend the outer jacket 
and manually remove the cut piece or slide the cut outer 
jacket with the stripper.

Step 2
Bend each pair in one direction to expose the ripcord, 
binder, or cross-web filler on the cable.

Remove the ripcord, binder, or cross-web filler if they 
are present on the cable, leaving only the twisted pairs 
of wire. 

Step 3

Preserve the wire pair twists as close as possible to the 
point of termination. When connecting jacks and plugs, 
do not untwist the cable more than 0.5 inches for Cat5e, 
Cat6, and Cat6a cable.

Terminate all four pairs in the T568B wiring scheme for 
example.

Step 4

Make sure the punch-down tool is straight before 
punching down on the connector. 

Make sure the cut-side of the tool is facing outward. 
Inspect the connector to verify that the wires are fully 
engaged in the IDC terminals and they are cut properly. 

Place a dust cover on the jack for protection.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.107
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Ready to insert into a wall plate or keystone jack patch 
panel

Step 5

Mount the IO Back panel on wall and Fix the Punched 
IO Krone into Face plate then screw face into wall 
mounted back panel.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.107
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IT & ITES	 	 Exercise 1.30.108	
COPA - Set-up & Configure a Computer Network	

Set up a proxy server/ DHCP Server with firewall
Objectives: At the end of this exercise you shall be able to
•	 setup a proxy server
•	 configure a DHCP server with Sophos Firewall.

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 MS Office 2019 / Latest	 - 1 No.

PROCEDURE

TASK 1:  Setup a proxy server 

Setup Proxy Server in Windows 10
To set a proxy using an automatic configuration script, 
follow these steps:

1	 Open settings.

2	 Click network & internet.

3	 Click proxy.

4	 In the automatic proxy setup section, set the use 
setup script switch to ON.

5	 Enter the script address as it was given to you; then 
click save.

6	 Close Settings.

7	 Setting up an automatic proxy configuration script.

Set up a proxy manually (Fig 1)
8	 Open Settings.

9	 Click Network & Internet.

The list of network- and Internet-related settings 
appears. 

10 Click Proxy.

The list of available proxy settings appears.
11	In the Manual Proxy Setup section, set the Use a 

Proxy Server switch to On.

12	In the Address field, type the IP address. 13 In the 
Port field, type the port.

14 Click Save; then close the Settings window.

TASK 2: Configure a DHCP server with Sophos Firewall

When you configure Sophos Firewall as the DHCP server, 
it provides IP addresses and network parameters, such 
as the default gateway, subnet mask, DNS servers, and 
WINS servers to DHCP clients.

Introduction
In this scenario, we configure Sophos Firewall as the 
DHCP server to lease IP addresses to clients within the 
server’s subnet. Do as follows:

•	 Specify the DHCP server settings.

•	 Add static IP addresses if required.

•	 Start the DHCP server if required.

•	 Check the IP addresses leased by the server.

Specify the DHCP server settings
Configure Sophos Firewall as the DHCP server to lease 
dynamic IP addresses directly to endpoint devices and 
a static IP address to a test server within the server’s 
network.

1	 Go to Network > DHCP.

2	 Under Server, click Add.
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3	 The following settings are an example. You must 
specify your network’s settings

4	 Click Save.

Here’s an example:
Start the DHCP server

1	 Go to System services > Services.

2	 For DHCP server, click Start if required.

Here’s an example:
Manage leased IP addresses
You can see the start and end times for IP addresses 
leased by the DHCP server. You can also see the 
client’s MAC address and hostname.

1	 To see the list of leased IP addresses, go to Network 
> DHCP.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.108

2	 See the listed IP address ranges under IPv4 lease 
and IPv6 lease.

Here’s an example:
Note : All the DSC broad band routers 
has DHCP option to enable. The Same 
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IT & ITES	 	 Exercise 1.30.109	
COPA - Set-up & Configure a Computer Network	

Setting up video conferencing using open-source software
Objectives: At the end of this exercise you shall be able to
•	 set Video Conferencing using Skype.

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 Skype Software	 - 1 No.
•	 Web Camera	 - 1 No.

PROCEDURE

NOTE: Instructor should connect Web Cam and Microphone before starting this Practical to the 
Computer with good Graphic Adapter and high speed internet connection.

TASK 1:  Set Video Conferencing using Skype 

1	 Open Skype.com

2	 Select Download Skype .

3	 Select device e.g. Computer where you want to 
install it.(refer Fig 1)

4	 After download install it.

5	 Now run it. (Fig 2)

6	 Sign in to your account/ create your account.

7	 If creating account fill up the form and submit.

8	 Now log in to skype.

9	 Add contacts by selecting “Add a Contact” from the 
upper right of your contacts list and entering a Skype 
username.

10	Select an online contact from your contact list 11 
Select “Video Call” to initiate a video call.

12 Click the “+” sign then click “Add people” to add more 
Skype contacts to the video conference.

•	 Microphone or  Headset	 - 1 No.
•	 Internet Connection	 - 1 No.
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IT & ITES	 	 Exercise 1.30.110	
COPA - Set-up & Configure a Computer Network	

Use various tools (by open source /free) for network troubleshooting, 
maintenance and security for both Wired and Wireless
Objectives: At the end of this exercise you shall be able to
•	 explain the network troubleshooting tools.

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 Network Monitor software	 - 1 No.

PROCEDURE

Network Troubleshooting Tools

1	 Download Free 3 device Network Monitor software 
from below link: https://www.manageengine.com/
network-monitoring/download-free.html 

2.	 Install the software - ManageEngine_OpManager_
Free_64bit.exe

ManageEngine OpManager - a powerful network 
troubleshooting software with in-built workflow 
automation
Here are some the network troubleshooting tools 
available in OpManager:

1	 Ping (ICMP/ SNMP/ Proxy)

2	 Tracert/ Traceroute

3	 Browse

4	 Telnet/ SSH

5	 Remote Desktop

6	 Terminal

1	 Ping Tools
The ICMP ping tool is a basic network troubleshooting 
tool that lets you assess if a device is reachable on the 
network. It reports on errors such as packet loss, round-
trip-time, etc.

The usual ping requests are based on the ICMP echo 
request protocol. There are other variations of ping 
requests such as SNMP ping and proxy ping.

SNMP ping: It is used to check if the simple network 
management protocol (SNMP) is enabled in a network 
device. If SNMP is enabled, the device responds with 
a set of basic information such as DNS name, system 
name, location, system type, system description, etc.

Proxy ping: This is used to ping a destination device 
behind a proxy. Basically, the pinging device sends 
an SNMP SET command to the proxy router to send 
an ICMP echo request to the destination device. The 
response is collected by the proxy device. This response 
is fetched using the SNMP GET command. This ping 
also requires SNMP to be enabled in the proxy device 
with the write community string enabled.

•	 Internet connection	 - 1 No.
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These ping commands are useful to diagnose IP 
problems and network connectivity issues that could 
be due to faulty interfaces, LAN issues, unavailable 
ports, configuration issues, etc., and are mostly used in 
combination with the traceroute network troubleshooting 
utility.

2	 Tracert / Trace Route : Tracert (Windows) or 
traceroute (Linux) is a network diagnostic and 
troubleshooting tool to view the route and measure 
transit delays of data packets in a network. It 
displays the number of hops between the source and 
destination devices based on the hop limit concept, 
modifying the Time To Live (TTL) values.

A traceroute tool is useful to identify response delays 
(high latency), routing loops and points of failure or 
packet loss in a network.

3	 Browse : Browse allows you to connect to the 
built-in GUI of most network devices using a ‘http/ 

https’ request. This allows you to access the device 
settings or configuration to troubleshoot network 
issues with ease.

4	 Telnet/ SSH : Telnet or Secure Shell (SSH) utility 
allows you to troubleshoot issues by establishing a 
CLI session with Linux/Unix devices.

It is a simple yet effective network troubleshooting tool 
that enables you to act on any alert by executing CLI 
commands to remediate L1/L2 network problems.

5	 Remote Desktop : The remote desktop utility 
allows you authenticate and access the desktop 
environment of any remote Windows devices in the 
network, from OpManager’s user interface (UI). This 
allows for quick network troubleshooting like in the 
case of Telnet/ SSH for Linux/Unix based devices.

6	 Terminal : The terminal allows you to establish a 
secure and encrypted connection with the remote 

device to execute various commands, diagnose and 
troubleshoot network problems.

In the terminal, a network administrator can manually 
execute all supported commands, widely interpreted 
as basic network troubleshooting tools, such as ping, 
tracert/ trace route, ipconfig/ ifconfig, netstat, nslookup, 
pathping/MTR, route, etc., to analyze and troubleshoot 
network problems. Apart from troubleshooting issues, it 
is important to perform network optimization.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.110
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IT & ITES	 	 Exercise 1.30.111	
COPA - Set-up & Configure a Computer Network	

Set up Internet access & communication
Objectives: At the end of this exercise you shall be able to
•	 set-up internet connectivity
•	 set-up digital communication

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 Network Connectivity (Wired 			 

/ Wireless)	 - 1 No.

PROCEDURE

TASK 1:  Set-up internet connectivity

Connect a wireless router
To create your own Wi-Fi network, you’ll need a wireless 
router. 

1	 Connect it to your existing Internet modem.

2	 Connect an Ethernet cable from your modem to the 
wireless router (there is usually a short Ethernet 
cable included with your wireless router for this 
purpose).

3	 Plug in the power cable for the wireless router.

4	 Wait at least 30 to 60 seconds, and make sure the 
lights on your router are working correctly.

Configure your router
Next, you’ll need to use your computer to configure your 
router’s default settings. 

1	 Using your web browser, enter the router’s default IP 
address into the address bar, then press Enter. Your 
router’s has the most common addresses include 
192.168.0.1, 192.168.1.1, and 192.168.2.1.

2	 The router’s sign-in page will appear. most 
routers use a standard user name and password 
combination, such as admin and password.

3	 Choose router’s settings and select the Network 
Setting, then enter a SSIB network name.

4	 Select Network Password setting, and choose an 
Encryption option. Recommend WPA2, which is 
generally considered to be the most secure.

•	 FTTH Router / DSL Modem	 - 1 No.
•	 Patch Cable	 - 1 No.

5	 Enter your desired password. Make sure to use a 
strong password to help ensure no one else can 
access your network.

6	 Locate and select the Save button to save your 
settings.
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Connect!

That’s it! Now you’re ready to connect to your Wi-Fi 
network and make sure it’s working.

1	 Locate your computer’s network settings, and search 
for nearby Wi-Fi networks.

TASK 2: Set-up digital communication

Types of Internet service : The type of Internet service 
you choose will largely depend on which Internet service 
providers (ISPs) serve your area, along with the types 
of service they offer. Here are some common types of 
Internet service.

•	 Dial-up: Dial-up Internet uses your phone line

•	 DSL: DSL service uses a broadband connection, 
which makes it much faster than dial-up

•	 Cable: Cable service connects to the Internet via 
cable TV

•	 Satellite: A satellite connection uses broadband but 
does not require cable or phone lines; it connects to 
the Internet through satellites orbiting the Earth. 

•	 3G and 4G: 3G and 4G service is most commonly 
used with mobile phones, and it connects wirelessly 
through your ISP’s network. 

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.111

2	 Select your network, and enter your password.

3	 If the connection is successful, open your web 
browser and try navigating to a webpage like www.
google.com. If the page loads, it means your Wi-Fi 
connection is working correctly.

Hardware needed
Modem : The type of Internet access you choose 
will determine the type of modem you need. Dial-up 
access uses a telephone modem, DSL service uses a 
DSL modem, cable access uses a cable modem, and 
satellite service uses a satellite adapter. 
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IT & ITES	 	 Exercise 1.30.112	
COPA - Set-up & Configure a Computer Network	

Use the Internet
Objectives: At the end of this exercise you shall be able to
•	 browse a website through web browser, e-mail, social media
•	 use the phone for online activities.

Requirements
Tools/Equipment/Machines
•	 A Working PC with Windows 10 OS	 - 1 No.
•	 Network Connectivity (Wired 			 

/ Wireless)	 - 1 No.

PROCEDURE

TASK 1:  Browse a website through Web browser

First way to open
1	 Choose edge or chrome browser and open it.

TASK 2 : Use an Email Account

•	 Internet Connection	 - 1 No.

1	 Choose any browser and Click to open it.

2	 Click “Gmail” on the “Google” home page.

Note:Create your own personal email accout 
at any of free Email accout service. (Ex.Gmail, 
yahoo, Outlook, hotmail etc..)

3	 Click “CREATE AN ACCOUNT“

4	 Type your name details in first and last name box.

5	 Choose your username as you will keep secure.

6	 Password and retype the same in “confirm your 
password”

Note : While typing the password the 
password box has to denote strong.

7	 Choose personal details in mobile number in mobile 
number, and alternative email id if you have.

8	 Type the given quote “Prove your not an robot” box

9	 Select the location as “India”
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10	Click a the box “I agree to Google” and About person- 
alization box” as shown in Fig 5.
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11 Click “Next Step”

12 Click “ Continue to Gmail”

Note : A new Gmail account mail window 
appears on the screen with three mails of 
Google team appears.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.30.112

Note: Account create successfully!.

Try to compose Email and sent to others and 
also receive from others.

TASK 3: Use social network sites

1	 Open Brower.

2	 Enter address www.facebook.com

3	 Enter your gmail Id and Password to login. 

4	 In case no login Id , Fill the form and Sign Up.

5	 Add friends.

6	 Send friend request.

7	 Click ok.

8	 Now post some message with a picture.

9	 Open friends list.

10	Select some friend from the list by clicking. 

11 Post something in friends facebook.

12 Click logout.
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TASK 4: Use the phone for online activities 

Install Chrome
1	 On your Android phone or tablet, go to PlayStore 

and Search Google Chrome.

2	 Tap Install.

3	 Tap Accept.

4	 To start browsing, go to the Home or All Apps page. 
Tap the Chrome app  .

Uninstall and reinstall Chrome to fix most problems with 
your search engine, pop-ups, or Chrome updates.

Setup Gmail for mobile devices
If you have a mobile device, there are two main ways to 
access your Gmail account:

•	 Option 1: The native email app on your device

•	 Option 2: The official Gmail mobile app, available 
for iOS and Android. 

To set up Gmail with the native email app: 
Stock Android 11 
Step 1: Drag a finger down from the top to fully expand 
the Notification Shade, and then tap the Cog icon. This 
opens the Android settings panel.

Step 2: Scroll down and tap Accounts.
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Step 3: Tap Add Account on the following screen.

Step 4: Tap Google.

Step 5: Verify your identity by using your face, finger, 
or PIN.

Step 6: Enter your Google account address and then 
tap Next.

Step 7: Enter your Google account password and then 
tap Next.

Step 8: Tap I Agree on the Google Terms of Service 
screen.

Step 9: If prompted, add a credit card for purchases or 
tap No Thanks.

Once finished, you will be returned to Accounts in 
Settings. If you want to see the accounts that you have 
added or want to delete any, just tap Google.

Write an email
1	 On your Android phone or tablet, open the Gmail 

app  . 

2	 At the bottom right, tap   Compose. 
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3	 In the “To” field, add recipients. You can also add 
recipients:

•	 In the “Cc” and “Bcc” fields.

•	 When you compose a message, with a “+ sign” 
or “@mention” and the contact’s name in the text 
field.	

4	 Add a subject.

5	 Write your message.

6	 At the top of the page, tap Send  .

Tip: To add formatting, like bolding or changing the text 
color, select the text you want to format, then tap  . 

Personal Email Account Setup:
Step 1 - Open the Gmail app

Open the Gmail app on your Android device.

Step 2 - Go to Settings

1	 Click the menu in the top left corner to open Settings.

2	 Tap Settings at the bottom of the menu that opens.

Step 3 - Click Add account

Click Add account to start setup.
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Step 4 - Click Other

Select Other as the account you want to set up.

Tip: If you want to set up your email with Mobile Sync, 
choose Exchange instead.
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Step 5 - Enter your email address

1	 Type in the email address you want to set up.

2	 Click Next.

Step 6 - Select IMAP

Select IMAP as the account type.

Step 7 - Enter your password

1	 Type in your email password, the one you use to log 
in to Webmail.

2	 Click Next.

Step 8 - Enter imap.one.com for incoming server

1	 Type in imap.one.com as the incoming server.

2	 Click Next.
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Step 9 - Enter send.one.com for outgoing server

1	 Type in send.one.com as the outgoing server.

2	 Click Next.
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Step 10 - Select account options

Here you set how often Gmail should look for new 
emails, when you get notifications and more. Uncheck 
any options you don’t want and click Next to continue.

Step 11 - Done!

Your account is now set up and ready to go!
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IT & ITES	 	 Exercise 1.31.113	
COPA - Create Simple Static Web Pages using HTML Tags	

Practice HTML
Objectives: At the end of this exercise you shall be able to
•	 display a text message using HTML program.

Requirements

Tools/Equipment/Machines

•	 A Working PC with windows 				  
OS	 - 1 No.

PROCEDURE

TASK 1:  Display text message using HTML program 

1	 Type the following program in a Notepad file.

	 <html>

	 <head>

	 <title>First HTML program</title>

	 </head>

	 <body>

	 WELCOME TO COPA TRADE

	 </body>

	 </html>

2	 Save it as

3	 Open the browser ‘Internet Explorer’ and open the 
file

4	 The output will be as follows. (Fig 1)

•	 If correct output is not displayed, do the following

•	 Press Ctrl G to open the console window to view 
the errors in the HTML program.

•	 Note the errors

•	 Open program in Notepad to correct the errors 
and save it.

•	 Go to browser and press F5 to refresh the page 

or open the saved filed in browser.

5	 Get the output verified by the instructor.

• 	 Notepad	 - 1 No.
• 	 Browser	 - 1 No.

TASK 2:  Design simple web page with text, paragraph and line break and using HTML Tags 

Program

	 <HTML>

	 <HEAD>

	 <TITLE> HEADING TAGS </TITLE>

	 </HEAD>

	 <BODY>

	 <h1>This is heading 1</h1>

	 <h2>This is heading 2</h2>

	 <h3>This is heading 3</h3>

	 <h4>This is heading 4</h4>

	 <h5>This is heading 5</h5>

	 <h6>This is heading 6</h6>

	 </BODY>

	 </HTML>

Output
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Program

	 <HTML>

	 <HEAD>

	 <TITLE> PARAGRAPH TAG </TITLE>

	 </HEAD>

	 <BODY>

	 <P>

	 HTML is the standard markup language for creating 
Web pages.

	 HTML stands for Hyper Text Markup Language. 
HTML describes the structure of Web pages using 
markup.

	 HTML elements are the building blocks of HTML 
pages.

	 HTML elements are represented by tags.

	 </P>

	 </BODY>

	 </HTML>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> LINE BREAK </TITLE>

	 </HEAD>

	 <BODY>

	 <P>

	 HTML is the standard markup language for

	 creating Web pages.<br>HTML describes the 
structure of Web pages using markup.<br>HTML 
elements are the building blocks of HTML 
pages.<br> HTML elements are represented by 
tags.

	 </P>

	 </BODY>

	 </HTML>

Output

TASK 3:  Format text, change ground colour and inset pictures in web page

Program

	 HTML>

	 <HEAD>

	 <TITLE> FORMATTING TEXT</TITLE>

	 </HEAD>

	 <BODY>

	 <PRE>

	 <CENTER> <U> <B> FORM CONTROLS </ B> </
U> </CENTER>

	 <BIG> Check Box </BIG>

	 <SMALL> Text Box</SMALL>

	 <STRONG> Option button </STRONG>

	 <I> Command Button <I>

	 <EM> Toggle Button <EM> LOG<SUB>2</SUB>10 
(A+B)<SUP>2</SUP>

	 </PRE>

	 </BODY>

	 </HTML>

Output	

	 Note
	 <center> - center text
	 <u> - underline text
	 <b> - Bold text
	 <strong> - Important text
	 <i> - Italic text
	 <em> - Emphasized text
	 <big> - <big text>
	 <small> - Small text
	 <sub> - Subscript text
	 <sup> - Superscript text
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Program

	 <HTML>

	 <HEAD>

	 <TITLE> FONTTAG</TITLE>

	 </HEAD>

	 <BODY>

	 <FONT COLOR=”BLUE” SIZE=”20” FACE = 
“ALGERIAN”>

	 World Wide Web

	 </FONT>

	 </BODY>

	 </HTML>

Output
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Program

	 <HTML>

	 <HEAD>

	 <TITLE> BACKGROUND TAG </TITLE>

	 </HEAD>

	 <BODY BGCOLOR = “AQUA”>

	 <BIG> Nice Background Color </BIG>

	 </BODY>

	 </HTML>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> INSERT IMAGE </TITLE>

	 </HEAD>

	 <BODY>

	 <IMG SRC=”C:\Users\Public\Documents\iti-logo- 
1.JPG” ALT = “ITI SYMBOL”>

	 </BODY>

	 </HTML>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> ADD SYMBOLS </TITLE>

	 </HEAD>

	 <BODY>

	 <PRE>

	 (A &gt B) and (A &gt C) (X &lt Y) and (X &lt Z) (A+B) 
&AMP&AMP (C+D)

	 </PRE>

	 </BODY>

	 </HTML>

Output
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TASK 4:  Design simple webpage with tables and lists

Program

	 HTML>

	 <HEAD>

	 <TITLE> ORDERED LIST </TITLE>

	 </HEAD>

	 <BODY>

	 <B><U> PROTOCOLS </U></B>

	 <OL TYPE = “1”>

	 <LI> FTP </LI>

	 <LI> HTTP </LI>

	 <LI> SMTP </LI>

	 <LI> TCP/IP </LI>

	 <LI> UDP </LI>

	 </OL>

	 </BODY>

	 </HTML>

Output
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Note: The type attribute of the <OL> tag, 
defines the type of the list item marker:
type=”A” - The list items will be numbered 
with A,B,C,…

type=”a” - The list items will be numbered 
with a,b,c,…

type=”I” - The list items will be numbered with 
I,II,III,IV,…

type=”i” - The list items will be numbered with 
i,ii,iii,iv,….

Program

	 <HTML>

	 <HEAD>

	 <TITLE> UNORDERED LIST </TITLE>

	 </HEAD>

	 <BODY>

	 <B><U> CABLES USED FOR NETWORKING </

U></ B>

	 <UL TYPE = “square”>

	 <LI> Sheilded Twisted Pair Cable </LI>

	 <LI> Unsheilded Twisted Pair Cable </LI>

	 <LI> Fibre Optic Cable </LI>

	 </UL>

	 </BODY>

	 </HTML>

Output

Note: The type attribute of the <UL> tag, de- 
fines the type of the list item marker:
type=”disc”	- Sets the list item marker to a 
bullet (default)

type=”circle “ - Sets the list item marker to a 
circle

Program

	 <HTML>

	 <HEAD>

	 <TITLE> DESCRIPTION LIST </TITLE>

	 </HEAD>

	 <BODY>

	 <B><U> MS OFFICE </U></B>

	 <dl>

	 <dt>MSWORD</dt>

	 <dd>- Microsoft Word or MS-WORD (often called 
Word) is a graphical word processing program that 
users can type with. It is made by the computer 
company Microsoft. Its purpose is to allow users 
to type and save documents. Similar to other 
word processors, it has helpful tools to make 
documents.<dd>

	 <dt>MSEXCEL</dt>

	 <dd>- Microsoft Excel is a spreadsheet developed 
by Microsoft for Windows, macOS, Android and 
iOS. It features calculation, graphing tools, pivot 
tables, and a macro programming language called 
Visual Basic for Applications.</dd>

	 <dt>MSACCESS</dt>
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	 <dd>- Microsoft Access is a database management 
system (DBMS) from Microsoft that combines the 
relational Microsoft Jet Database Engine with a 
graphical user interface and software-development 
tools. It can also import or link directly to data stored 
in other applications and databases.</dd>

	 </dl>

	 </BODY>

	 </HTML>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> NESTED LIST </TITLE>

	 </HEAD>

	 <BODY>

	 <B><U> MS OFFICE </U></B>

	 <ul>

	 <li>INPUT DEVICES

	 <ul>

	 <li>KEYBOARD</li>

	 <li>MOUSE</li>

	 <li>SCANNER</li>

	 </ul>

	 <li>OUTPUT DEVICES

	 <ul>

	 <li>PRINTER</li>

	 <li>PLOTTER</li>

	 <li>MONITOR</li>

	 </ul>

	 <li>MEMORY DEVICES</li>

	 </ul>

	 </BODY>

	 </HTML>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> TABLE 1 </TITLE>

	 </HEAD>

	 <BODY>

	 <B> PARTICULARS OF GOVERNMENT ITI 
(WOMEN) </B> <BR> <BR>

	 <table BORDER=”5” CELLPADDING=”5” 
CELLSPACING=”10”>

	 <tr>

	 <th>SNO</th>

	 <th>NAME OF THE TRAINEE</th>

	 <th>TRADE</th>

	 <th>SEMESTER</th>

	 </tr>

	 <tr>

	 <td>1.</td>

	 <td>ANITHA.C</td>

	 <td>COPA</td>

	 <td>II</td>

	 </tr>

	 <tr>

	 <td>2.</td>

	 <td>VENI.T</td>

	 <td>IT</td>

	 <td>II</td>

	 </tr>

	 <tr>

	 <td>3.</td>

	 <td>PRIYA.S</td>

	 <td>ICTSM</td>

	 <td>II</td>

	 </tr>

	 </table>

	 </BODY>

	 </HTML>
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Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> TABLE 2 </TITLE>

	 </HEAD>

	 <BODY>

	 <H1> TRADE : COPA </H1>

	 <H2> PRACTICAL MARK LIST </H2>

	 <TABLE BORDER=”5” 
B O R D E R C O L O R = ” G R E E N ” 
BGCOLOR=”ORANGE” WIDTH=”50%”>

	 <tr> <td>1</td> <td>AMBIKA.S</td> <td>98< td> 
</tr>

	 <tr> <td>2</td> <td>VIJI.K</td> <td>98</td>

	 </tr>

	 <tr> <td>3</td> <td>ANU.D</td> <td>97</td>

	 </tr>

	 <tr> <td>4</td> <td>MAMTA.B</td> <td>96</ td> 
</tr>

	 <tr> <td>5</td> <td>JORONA.S</td> <td>95</ td> 
</tr>

	 </TABLE>

	 </BODY>

	 </HTML>

Output

Note: Table’s border colour in set to Green 
and background colour is set to orange.

TASK 5:  Use Marquees, hyperlinks and mail to link in designing webpages 

Program

	 <HTML>

	 <HEAD>

	 <TITLE>MARQUEE TAG</TITLE>

	 </HEAD>

	 <BODY>

	 <H1> <FONT TYPE=”broadway”>

	 <MARQUEE>

	 NATIONALINSTRUCTIONALMEDIAINSTITUTE, 
CHENNAI

	 </MARQUEE>

	 </H1> </FONT>

	 </BODY>

	 </HTML>

Output

The output will be “NATIONAL INSTRUCTIONAL MEDIA 
INSTITUTE, CHENNAI” which is scrolling towards left. 
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Program

	 <HTML>

	 <HEAD>

	 <TITLE> MARQUEE WITHATTRIBUTES-1 </ 
TITLE>

	 </HEAD>

	 <BODY>

	 <FONT SIZE=”25” COLOR=”Blue”>

	 <MARQUEE BEHAVIOR=”scroll” DIRECTION = 
“right” SCROLLAMOUNT=”40”>

	 Directorate General of Employment & Training 
(DGE&T)

	 </MARQUEE>

	 </FONT>

	 </BODY>

	 </HTML>

Output

1	 The output will be “Directorate General of 
Employment & Training (DGE&T)” which starts faster 
scrolling towards right.TASK 3: Set the BGCOLOR 
and WIDTH attributes to <MARQUEE> tag.
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Output

1	 The output will be “National Council for Vocational 
Training (NCVT)” which starts scrolling towards left 
and bounces back and forth in 70% screen width 
with yellow background color.

Program

	 <HTML>

	 <HEAD>

	 <TITLE> MARQUEE WITHATTRIBUTES-2 </ 
TITLE>

	 </HEAD>

	 <BODY>

	 <FONT SIZE=”25”>

	 <MARQUEE BEHAVIOR=”alternate” BGCOLOR = 
“yellow” WIDTH = “70%”>

	 National Council for Vocational Training (NCVT)

	 </MARQUEE>

	 </FONT>

	 </BODY>

	 </HTML>

Program

	 <HTML>

	 <HEAD>

	 <TITLE> MARQUEE WITHATTRIBUTES-3 </ 
TITLE>

	 </HEAD>

	 <BODY>

	 <FONT SIZE=”40”>

	 <MARQUEE DIRECTION = “UP” HEIGHT=”100%” 
SCROLLAMOUNT = “40%” LOOP=”-1”>

	 The Ministry of Labour and Employment

	 </MARQUEE>

	 </FONT>

	 </BODY>

Output

1	 The output will be “The Ministry of Labour and 
Employment “which starts scrolling towards up 3 
times (Loop).

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



42 IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.31.113

Program

	 <HTML>

	 <HEAD>

	 <TITLE> MARQUEE IMAGE </TITLE>

	 </HEAD>

	 <BODY>

	 <MARQUEE BEHAVIOUR=”slide” 
SCROLLAMOUNT=”20%”>

	 <IMG SRC=”TRAIN.PNG” alt=”TRAIN”>

	 </MARQUEE>

	 </FONT>

	 </BODY>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> Hyperlink </TITLE>

	 </HEAD>

	 <BODY>

	 <!— link to Home page of NIMI website —>

	 <A Href=”http://nimi.gov.in/”> Visit to NIMI website

	 </a>

	 </BODY>

	 </HTML>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> Hyperlink </TITLE>

	 </HEAD>

	 <BODY>

	 <!— Opens the link in new window —>

	 <a href=”https://www.google.co.in/” TARGET = “_
blank”>Visit Google</a>

	 </BODY>

	 </HTML>

Output

Program

	 <HTML>

	 <HEAD>

	 <TITLE> Hyperlink </TITLE>

	 </HEAD>

	 <BODY>

	 <p> An image as a link:</p>

	 < a h r e f = ” h t t p s : / / e n . w i k i p e d i a . o r g 
/ w i k i / Brihadeeswarar_Temple#/media”>

	 <img src = “Brihadeswara_Temple_Landscape.
jpg” height=100” width=”100”>

	 </a>

	 </BODY>

	 </HTML>

Output
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Program

	 <html>

	 <head>

	 <title> Mail to Link </title>

	 </head>

	 <body>

	 <p>

	 This is an email link:

	 <ahref=”mai l to :g i t i tn@mai l .com”target=”_
top”>Send Mail</a>

	 </p>

	 </body>

	 </html>

Output

1	 Mail to link is a type of HTML link that activates the 
default mail client on the computer for sending an 
e- mail. The web browser requires a default e-mail 
client software installed on his computer in order 
to activate the e-mail client. If you have Microsoft 
Outlook, as your default mail client, pressing the 
Send Mail link opens a new mail window.

TASK 6:  Create frames, and add style and Design Layout 

1	 Type the following program in Notepad file and save 
it as PRG1.HTML

	 <HTML>

	 <HEAD>

	 <TITLE> PRG1 for VERTICAL FRAMES </TITLE>

	 </HEAD>

	 <BODY BGCOLOR = “CCAABB”>

	 <H1>

	 <OL> MEMORY DEVICES

	 <BR><BR>

	 <LI>PRIMARY MEMORY</LI>

	 <BR><BR>

	 <LI>SECONDARY MEMORY</LI>

	 </OL>

	 </BODY>

	 </HTML>

2	 The output will be as follows. (Fig 1)

3	 Type the following program in Notepad file and save 
it as PRG2.HTML

	 <HTML>

	 <HEAD>

	 <TITLE> PRG2 for VERTICAL FRAMES </TITLE>

	 </HEAD>

	 <BODY BGCOLOR = “AABBCC”>

	 <H1>

	 <OL TYPE = “A”> PRIMARY MEMORY

	 <BR><BR>

	 <LI>RANDOM ACCESS MEMORY</LI>

	 <BR><BR>

	 <LI>READ ONLY MEMORY</LI>

	 </OL>

	 </BODY>

	 </HTML>

3	 The output will be as follows. (Fig 2)
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4	 Type the following program in Notepad file and save 
it as PRG3.HTML

	 <HTML>

	 <HEAD>

	 <TITLE> PRG3 for VERTICAL FRAMES </TITLE>

	 </HEAD>

	 <BODY BGCOLOR = “CCBBAA”>

	 <H1>

	 <OL TYPE=”a”> SECONDARY MEMORY

	 <BR><BR>

	 <LI>HARD DISK</LI>

	 <BR><BR>

	 <LI>DVD</LI>

	 </OL>

	 </BODY>

	 </HTML>

Output
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5 Type the following program to create VERTICAL 
FRAMESET in Notepad file and save it as 
VERFRAME.HTML

	 <HTML>

	 <HEAD>

	 <TITLE> VERTICAL FRAMES </TITLE>

	 </HEAD>

	 <frameset cols=”35%,30%,*”>

	 <frame src=”PRG1.html”>

	 <frame src=”PRG2.html”>

	 <frame src=”PRG3.html”>

	 </frameset>

	 </HTML>

Output

	 <HTML>

	 <HEAD>

	 <TITLE> HORIZONTAL FRAMES </TITLE>

	 </HEAD>

	 <frameset ROWS=”35%,30%,*”>

	 <frame src=”PRG1.html”>

	 <frame src=”PRG2.html”>

	 <frame src=”PRG3.html”>

	 </frameset>

	 </HTML>

Output

1	 Type the following program in a Notepad file and 
save it as MIXFRAME.HTML

	 <HTML>

	 <HEAD>

	 <TITLE> MIXED FRAMES </TITLE>

	 </HEAD>

	 <frameset COLS=”40%,*”>

	 <frame src=”PRG1.html”>

	 <frameset ROWS=”50%,*”>

	 <frame src=”PRG2.html”> frame src=”PRG3.html”>

	 </frameset>

	 </HTML>

Output

1 	 Type the following program in a Notepad file and 
save it as HORFRAME.HTML
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1	 Type the following program in a Notepad file and 
save it as STYLE.HTML

	 <HTML>

	 <HEAD>

	 <TITLE> STYLE </TITLE>

	 </HEAD>

	 <body style=”background-color:yellow;”>

	 <h1 style=”font-size:300%;text- align:center;color:i
ndigo;”>ROUTER</h1>

	 <p style=”color:blue;font-family:comic sans MS;”> 
A ROUTER IS A DEVICE THAT FORWARDS DATA 
PACKETS ALONG NETWORKS. A ROUTER IS 
CONNECTED TO

	 ATLEAST TWO NETWORKS, COMMONLY TWO 
LANS OR WANS OR A

	 LAN AND ITS ISP’S NETWORK. ROUTERS ARE 
LOCATED AT

	 GATEWAYS, THE PLACES WHERE TWO OR 
MORE NETWORKS CONNECT.

	 </p>

	 </body> </HTML>

Output

TASK 7: Display a webpage within a webpage using iframes

Program

 <html>
 <head>
    <title>Opening Links in an iFrame</title>
	 <style>
		  iframe {
			   width: 50%;
			   height: 500px;
			   }

	 </style>
 </head>
 <body>
    <iframe src=”https://nimi.gov.in/index.html” 

name=”myFrame”></iframe>
 </body>
 </html>

Output: © N
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TASK 8:  Insert textbox, check box and combo box in webpage 

Program

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <form action=”/action_page.php”>

	 Trainee Name: <input type=”text” name=”Trainee 
Name” value=”Rhitika”><br><br>

	 Father Name : <input type=”text” name=”Father 
Name” value=”Velliangiri”><br><br>

	 Mother Name : <input type=”text” name=”Mother 
Name” value=”Rajeshwari”><br><br>

	 <input type=”submit” value=”Submit”>

	 </form>

	 <p><b>Click the “Submit” button and the form- 
data will be sent to a page on the server called “/ 
action_page.php”.</b></p>

	 </body>

	 </html>

Output

Program

	 <!DOCTYPE html>
	 <html>
	 <body>
	 <form action=”/action_page.php”>
	 <p> Known Softwares </p>
	 <input type=”checkbox” name=”software1” 

value=”windows”>Windows OS
	 <br>
	 <input type=”checkbox” name=”software2” 

value=”msoffice”>Microsoft Office
	 <br>
	 <input type=”checkbox” name=”software3” 

value=”html”>Hyper Text Markup Language
	 <br>
	 <input type=”checkbox” name=”software4” 

value=”css”>Cascaded Style Sheet
	 <br>
	 <br>
	 <input type=”submit”>
	 </form>
	 </body>
	 </html>

Output

Program

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <p>You can preselect an option with the selected 
attribute.</p>

	 <form action=”/action_page.php”>

	 <select name=”semester”>

	 <option value=”s1”>Semester 1</option>

	 <option value=”s2”>Semester 2</option>

	 <option value=”s3” selected>Semester 3</ option>

	 <option value=”s4”>Semester 4</option>

	 </select>

	 <br><br><br><br><br><br>

	 <input type=”submit”>

	 </form>

	 </body>

	 </html>

Output
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TASK 9 : Insert Submit and Reset buttons in Web page.

1	 Type the following program in Notepad file and save 
it as RESET.HTML

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <form action=”/action_page.php” 
method=”get”> User Name: <input type=”text” 
name=”userid”><br><br>

	 Password : <input type=”password” 
name=”psw”><br><br>

	 <button type=”submit” value=”Submit”>Submit</ 
button>

	 <button type=”reset” value=”Reset”>Reset</ 
button>

	 </form>

	 </body>

	 </html>

Output

TASK 10 : Insert Radio button in Web page.

1	 Type the following program in Notepad file and save 
it as RADIOBTN.HTML

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <form action=”/action_page.php”>

	 <input type=”radio” name=”gender” value=”male”

	 > Male<br>

	 <input type=”radio” name=”gender” value=”female” 
checked> Female<br>

	 <input type=”radio” name=”gender” value=”other”> 
Other<br><br>

	 <input type=”submit”>

	 </form>

	 </body>

	 </html>
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Output

TASK 11:  Design a webpage adding flash file, audio and video files 

1	 Type the following program in Notepad file and save 
it as FLASH.HTML

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <object width=”300” height=”300” data=”panda.
swf”>

	 </object>

	 </body>

	 </html>

Note: As SWF file is an animation created 
with Adobe Flash that can be played by Flash 
Player or with a web browser that has the 
Flash plug in installed. It may contain text, 
vector and raster graphics and interactive 
content written in Ac- tion Script.

Output

Program

1	 Type the following program in Notepad file and save 
it as AUDIO.HTML

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <audio controls>

	 <source src=”horse.ogg” type=”audio/ogg”>

	 <source src=”horse.mp3” type=”audio/mpeg”> 
Your browser does not support the audio element.

	 </audio>

	 </body>

	 </html>

Output
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Output

TASK 12:  Design webpage with forms and form controls using HTML Tags 

Program

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <video width=”320” height=”240” controls>

	 <source src=”C:\Users\mdc5\Downloads\Beautiful 
Nature.mp4” type=”video/mp4”>

	 <source src=”movie.ogg” type=”video/ogg”> Your 
browser does not support the video tag.

	 </video>

	 </body>

	 </html>

Note: Currently, there are 3 supported video

formats for the <video> element: MP4, WebM, 
and Ogg:

•	 MP4 = MPEG 4 files with H264 video codec 
and AAC audio codec

•	 WebM = WebM files with VP8 video codec 
and Vorbis audio codec

•	 Ogg = Ogg files with Theora video codec 
and Vorbis audio codec

	 Element	 Chrome	 IE	 Firefox	 Safari	 Opera

	 <video>	 4.0	 9.0	 10.5	 4.0	 10.5

Program

	 <!DOCTYPE html>

	 <html>

	 <body>

	 <form action=”/action_page.php”>

	 <h1> STUDENT INFORMATION SYSTEM</H1>

	 <br><br>

	 <b>Name:</b> &emsp; &emsp; &emsp; <input 
type=”text” name=”name”><br><br>

	 <b>Father’s name :</b> <input type=”text” 
name=”fname”><br><br>

	 <b>Mother’s name :</b> <input type=”text” 
name=”mname”><br><br>

	 <b>Date of Birth:</b>

	 <input type=”date” name=”bday”><br><br>

	 <b>Gender:</b> <br>

	 &emsp; &emsp; <input type=”radio” name=”gender” 
value=”male” > Male <br> &emsp; &emsp; <input 
type=”radio” name=”gender” value=”female” 
checked> Female<br>

	 &emsp; &emsp; <input type=”radio” name=”gender” 
value=”other”> Other<br><br>

	 <b>Communication Address:<br>

	 <textarea rows=”6” cols=”50”>

	 </textarea><br><br>

	 <b>TRADE :</b> &emsp;

	 <select name=”trade”>

	 <option value=”t1”>COPA</option>

	 <option value=”t2” selected>Information 
Technology</option>

	 <option value=”t3”>Informtion Communication 
Technology & System Maintenance</option>

	 <option value=”t4”>Computer Hardware & Network 
Maintenance</option>

	 </select>

	 <br><br><br><br><br><br>

	 <b>Languages you know:</b><BR><br>&emsp; 
&emsp; &emsp;

	 <SELECT NAME=”language” MULTIPLE>

	 <OPTION VALUE=”tamil”SELECTED>Tamil

	 <OPTION VALUE=”hindi”>Hindi

	 <OPTION VALUE=”english” SELECTED>English

	 <OPTION VALUE=”malayalam”>Malayalam

	 <OPTION VALUE=”kannada”>Kannada

	 </SELECT>
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	 <br><br>

	 <b>Computer Knowledge:</b><br><br> &emsp; 
&emsp; &emsp; &emsp;

	 <input type=”checkbox” name=”software1” 
value=”windows”>Windows OS

	 <br>

	 &emsp; &emsp; &emsp; &emsp;

	 <input type=”checkbox” name=”software2” 
value=”msoffice”>Microsoft Office

	 <br>

	 &emsp; &emsp; &emsp; &emsp;

	 <input type=”checkbox” name=”software3” 
value=”html”>Hyper Text Markup Language

	 <br>

	 &emsp; &emsp; &emsp; &emsp;

	 <input type=”checkbox” name=”software4” 
value=”css”>Cascaded Style Sheet

	 <br>

	 <br>

	 <input type=”submit” value=”Submit”>

	 <input type=”reset”>

	 </form>

	 </body>

	 </html>

	 Note: &nbsp; - adds a single space &ensp; - adds 
two spaces &emsp; - adds four spaces

Output
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IT & ITES	 	 Exercise 1.31.114	
COPA - Create Simple Static Web Pages using HTML Tags	

Create simple static web pages using CSS
Objectives: At the end of this exercise you shall be able to
•	 display a text message using HTML program
• 	display a paragraph using HTML program.

Requirements

Tools/Equipment/Machines

•	 A Working PC with windows 				  
OS	 - 1 No.

PROCEDURE

TASK 1:  CSS syntax, Adding colors, fonts, backgrounds, images borders, text alignment, text transformation, 
Lists etc 

Program:

<!DOCTYPE html>

<html>

<head>

	 <!-- Style of h1 selector for color, text-align, 
background and border -->

	 <!-- Style of p selector for Paragraph -->

	 <!-- Style of body selector for body -->

	 <!-- Style of bordering selector for border image 
-->

	 <!-- Style of div selector for text-transform -->

    <style> 

    	h1 	 {color: Orange;			    

        	 text-align: center;		   

		  background-color:DodgerBlue;

		  border: 2px solid Tomato;}

	 p {background-color:Violet} 

   	 body{  background-color: lightblue;}

	 #borderimg1 {

  	 border: 10px solid transparent;

  		  padding: 15px;

  	 border-image: url(border.png) 50 round;}

	 #borderimg2 {

  		  border: 10px solid transparent;

  		  padding: 15px;

  	 border-image: url(border.png) 20% round;}

	 #borderimg3 {

  		  border: 10px solid transparent;

  		  padding: 15px;

  		  border-image: url(border.png) 30% round; }

	 div.a {  text-transform: uppercase;}

	 div.b {  text-transform: lowercase;}

	 div.c {  text-transform: capitalize;}

    </style>

</head>

<body>

   	 <h1>Welcome to National Instructional Media 
Institute</h1>

	 <p id=”borderimg1”> National Instructional Media 
Institute (NIMI) was set up in the name of Central 
Instructional Media Institute (CIMI) in Chennai in 
December 1986 by the Government of India.</p>

	 <p id=”borderimg2”> It as a Subordinate Office 
under Directorate General of 		 Employment 
and Training (DGE&T) with the assistance from 
Government of 		  Germany through 
GTZ (German Agency for Technical Co-operation) 
as the 	 executing agency. </p>

	 <img id=”borderimg3” src=”1.jpg”  alt=”Mountains” 
width=”300” height=”200”> 

	 <div class=”a”>Thank You </div>

	 <div class=”b”>Thank You </div>

	 <div class=”c”>Thank You </div>

</body>

</html>
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Output:

TASK 2: 3 types of CSS

Inline CSS

Inline CSS contains the CSS property in the body 
section attached with element is known as inline CSS

 <!DOCTYPE html>

 <html>

    <head>

        <title>Inline CSS</title>

    </head>

    <body>

        <p style = “color:#009900; font-size:50px;

                font-style:italic; text-align:center;”>

            Welcome to NIMI

        </p>

    </body>

 </html>  

 Output:

<!DOCTYPE html>

<html>

	 <head>

		  <title>Internal CSS</title>

		  <style>

			   .a {

				    text-align:center;

			      }

			   .b{

				    color:#009900;

				    font-size:50px;

				    font-weight:bold;

			      }

			   .c {

				    font-style:bold;

				    font-size:20px;

			      }

		  </style>

	 </head>

	 <body>

		  <div class = “a”>

<div class =”b”>National Instructional Media Institute 
(NIMI) </div>

			   <div class =”c”>

				    a NIMI portal for Online Books

			   </div>

		  </div>

	 </body>

</html>			

Internal or Embedded CSS

This can be used when a single HTML document must 
be styled uniquely. The CSS rule set should be within 
the HTML file in the head section.
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External CSS

External CSS contains separate CSS file which contains 
only style property with the help of tag attributes. CSS 
property written in a separate file with .css extension 
and should be linked to the HTML document using link 
tag. This means that for each element, style can be set 
only once and that will be applied across web pages.

Example: The file given below contains CSS property. 
This file save with .css extension. For Ex: sty.css  
body {  background-color:powderblue;}

.a {    text-align:center;   }

.b {

    color:#009900;

    font-size:50px;

    font-weight:bold;}

#c {

    font-style:bold;

    font-size:20px;}

•	 link tag is used to link the external style sheet with 
the html webpage.

•	 href attribute is used to specify the location of the 
external style sheet file.

Main Program

 <!DOCTYPE html>

 <html>

	 <head>

		  <link rel=”stylesheet” href=”sty.css”/>

	 </head>

	 <body>

		  <div class = “a”>

			   <div class =”b”>National Instructional 
Media Institute (NIMI)</div>

			   <div id =”c”>

				    a NIMI portal for Online Books

			   </div>

		  </div>

	 </body>

</html>

Output:

TASK 3: Adding a Navigation Bars(vertical/horizontal bars)

Vertical Bar Menu:

	 <!DOCTYPE html>

	 <html>

	 <head>

	 <style>

	 body {

	 margin: 0;

	 }

	 ul {

	 list-style-type: none;

 	 margin: 0;

  	 padding: 0;

  	 width: 25%;

  	 background-color: #f1f1f1;

  	 position: fixed;
  	 height: 100%;

  overflow: auto;
}

li a {

  display: block;

  color: #000;

  padding: 8px 16px;

  text-decoration: none;

}

li a.active {

  background-color: #04AA6D;

  color: white;

}

li a:hover:not(.active) {

  background-color: #555;

  color: white;

}
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 </style>

 </head>

 <body>

 <ul>

  <li><a class=”active” href=”#home”>Home</a></li>

  <li><a href=”#news”>News</a></li>

  <li><a href=”#contact”>Contact</a></li>

  <li><a href=”#about”>About</a></li>

 </ul>

	 <div style=”margin-left:25%;padding:1px 
16px;height:1000px;”>

  <h2>National Instructional Media Institute (NIMI)</
h2>

  <h3>Objective</h3>

  <p>NIMI has been functioning as a Nodal Agency to 
develop Instructional Materials, 	 e - c o n t e n t , 
Question Banks, Train media developers and 
trainers, enable 	 translation of books into Hindi 
and other regional languages, network with 	 other 
vocational stakeholders, create resource centers for 
vocational 	 courses, promote research in the field 
of development of instructional 	 materials and 
offer consultancy services.</p>

  <h3>Vision</h3>

  <p>Nimi envisages to scale global benchmarks in 
vocational education as a Nodal 	
  	 Organization for curricula, instructional media 
packages and Test Item 		  development 
for vocational courses in the country.</p>

  <h3>Mission</h3>

  <p>Nimi proposes to accelerate vocational training in 
the country through systemic 		
curriculum development, production, dissemination 
of instructional media 		  packages and 
training on instructional media by closely interacting 
with the 		  State / UT Governments., 
Industries, ITIs and Organizations involved in 	
Vocational Training.</p>

 </div>

 </body>

 </html>

Output:

horizontal bar Menu:

	 <!DOCTYPE html>

	 <html>

	 <head>

	 <style>

	 ul {

	  list-style-type: none;

	  margin: 0;

 	 padding: 0;

  	 overflow: hidden;
  	 background-color: #333;

	 }

	 li {

  float: left;
	   border-right:1px solid #bbb;

	 }

	 li:last-child {

  		  border-right: none;

	 }

	 li a {

  	 display: block;

  	 color: white;

  	 text-align: center;

  	 padding: 14px 16px;

  	 text-decoration: none;

	 }	

	 li a:hover:not(.active) {

  	 background-color: #111;

	 }

	 .active {

  	 background-color: #04AA6D;

	 }

	 </style>

	 </head>

	 <body>

	 <ul>

  <li><a class=”active” href=”#home”>Home</a></li>

  <li><a href=”#news”>News</a></li>

  <li><a href=”#contact”>Contact</a></li>

   <li style=”float:right”><a href=”#about”>About</a></
li>

	 </ul>

<div style=”margin-left:0%;padding:1px 
16px;height:1000px;”>

  <h2>National Instructional Media Institute (NIMI)</
h2>

  <h3>Objective</h3>

  <p>NIMI has been functioning as a Nodal Agency to 
develop Instructional Materials, 	 e - c o n t e n t , 
Question Banks, Train media developers and 
trainers, enable 	 translation of books into Hindi 
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and other regional languages, network with 	 other 
vocational stakeholders, create resource centers for 
vocational 	 courses, promote research in the field 
of development of instructional 	 materials and 
offer consultancy services.</p>

  <h3>Vision</h3>

  <p>Nimi envisages to scale global benchmarks in 
vocational education as a Nodal 	
  	 Organization for curricula, instructional media 
packages and Test Item 		  development 
for vocational courses in the country.</p>

  <h3>Mission</h3>

  <p>Nimi proposes to accelerate vocational training in 
the country through systemic 		
curriculum development, production, dissemination 
of instructional media 		  packages and 
training on instructional media by closely interacting 
with the 		  State / UT Governments., 
Industries, ITIs and Organizations involved in 	
	 Vocational Training.</p>

</div>

</body>

</html>

Output: 

TASK 4: CSS drop downs & Forms

From the Task3 adding drop Downs 

Program:

	 <!DOCTYPE html>

	 <html>

	 <head>

	 <style>

	 ul {

  list-style-type: none;

  margin: 0;

  padding: 0;

  overflow: hidden;
  background-color: #333;

	 }

	 li {

  float: left;
  border-right:1px solid #bbb;

	 }

	 li:last-child {

  border-right: none;

	 }

	 li a {

  display: block;

  color: white;

  text-align: center;

  padding: 14px 16px;

  text-decoration: none;

}

	 li a:hover:not(.active) {

  background-color: #111;

	 }

	 .active {

  background-color: #04AA6D;

	 }

	 li a:hover, .dropdown:hover .dropbtn {

  background-color: green;

	 }

	 li.dropdown {

  display: inline-block;

	 }

	 .dropdown-content {

  	 display: none;

  	 position: absolute;

  	 background-color: #f9f9f9;

  	 min-width: 160px;

  	 box-shadow: 0px 8px 16px 0px rgba(0,0,0,0.2);

  	 z-index: 1;

	 }

	 .dropdown-content a {

  	 color: green;

  	 padding: 12px 16px;

  	 text-decoration: none;

  	 display: black;

  	 text-align: left;

	 }
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 .dropdown-content a:hover {background-color: #f1f1f1;

 }

 .dropdown:hover .dropdown-content {

  display: block;

 }

 </style>

 </head>

 <body>

 <ul>

  <li><a class=”active” href=”#home”>Home</a></li>

  <li><a href=”#news”>News</a></li>

  <li><a href=”#contact”>Contact</a></li>

   <li style=”float:right”><a href=”#about”>About</a></
li>

  <li class=”dropdown”>

    <a href=”javascript:void(0)” 
class=”dropbtn”>Admission</a>

    <div class=”dropdown-content”>

      <a href=”#”>Details</a>

      <a href=”#”>List of Trades</a>

      <a href=”#”>Facility</a>

 </ul>

	 < d i v s t y l e = ” m a r g i n - l e f t : 0 % ; p a d d i n g : 1 p x 
16px;height:1000px;”>

  <h2>National Instructional Media Institute (NIMI)</
h2>

 </div>

 </body>

 </html>

Output:

input[type=text], select, textarea {

  width: 100%;

  padding: 12px;

  border: 1px solid #ccc;

  border-radius: 4px;

  resize: vertical;

}

label {

  padding: 12px 12px 12px 0;

  display: inline-block;

}

input[type=submit] {

  background-color: #04AA6D;

  color: white;

  padding: 12px 20px;

  border: none;

  border-radius: 4px;

  cursor: pointer;

  float: right;
}

input[type=submit]:hover {

  background-color: #45a049;

}

.container {

  border-radius: 5px;

  background-color: #f2f2f2;

  padding: 20px;

}

.col-25 {

  float: left;
  width: 25%;

  margin-top: 6px;

}

.col-75 {

  float: left;
  width: 75%;

  margin-top: 6px;

}

/* Clear floats after the columns */
.row:after {

  content: “”;

  display: table;

  clear: both;

}

/* Responsive layout - when the screen is less than 
600px wide, make the two columns stack on top of 
each other instead of next to each other */

@media screen and (max-width: 600px) {

  .col-25, .col-75, input[type=submit] {

    width: 100%;

CSS Form:

Program:

<!DOCTYPE html>

<html>

<head>

<style>

* {

  box-sizing: border-box;

}

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.31.114

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



57

    margin-top: 0;

  }

 }

 </style>

 </head>

 <body>

 <h2>Responsive Form</h2>

	 <p>Resize the browser window to see the effect. 
When the screen is less than 600px wide, make the 
two columns stack on top of each other instead of 
next to each other.</p>

<div class=”container”>

  <form action=”/action_page.php”>

  <div class=”row”>

    <div class=”col-25”>

      <label for=”fname”>First Name</label>

    </div>

    <div class=”col-75”>

           <input type=”text” id=”fname” name=”firstname” 
placeholder=”Your name..”>

    </div>

  </div>

  <div class=”row”>

    <div class=”col-25”>

      <label for=”lname”>Last Name</label>

    </div>

    <div class=”col-75”>

      <input type=”text” id=”lname” name=”lastname” 
placeholder=”Your last name..”>

    </div>

  </div>

  <div class=”row”>

    <div class=”col-25”>

      <label for=”country”>Country</label>

    </div>

    <div class=”col-75”>

      <select id=”country” name=”country”>

        <option value=”australia”>Australia</option>

        <option value=”canada”>Canada</option>

        <option value=”usa”>USA</option>

      </select>

    </div>

  </div>

  <div class=”row”>

    <div class=”col-25”>

      <label for=”subject”>Subject</label>

    </div>

    <div class=”col-75”>

      <textarea id=”subject” name=”subject” 
placeholder=”Write something..” 
style=”height:100px”></textarea>

    </div>

  </div>

  <br>

  <div class=”row”>

    <input type=”submit” value=”Submit”>

  </div>

  </form>

 </div>

 </body>

 </html>

Output:

TASK 5: CSS counters and website layout, Multiple backgrounds & Putting the stylesheet in a separate file

CSS counters

 <!DOCTYPE html>

 <html>

 <head>

 <style>

 body {

  counter-reset: section;

 }

 h1 {

  counter-reset: subsection;

 }

 h1::before {

  counter-increment: section;

  content: “Section “ counter(section) “. “;
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	 }	

	 h2::before {

  counter-increment: subsection;

  content: counter(section) “.” counter(subsection) “ “;

	 }

	 </style>

	 </head>

	 <body>

	 <h1>HTML/CSS Tutorials</h1>

	 <h2>HTML</h2>

	 <h2>CSS</h2>

	 <h2>Bootstrap</h2>

	 <h2>W3.CSS</h2>

	 <h1>Scripting Tutorials</h1>

	 <h2>JavaScript</h2>

	 <h2>jQuery</h2>

	 <h2>React</h2>

	 <h1>Programming Tutorials</h1>

	 <h2>Python</h2>

	 <h2>Java</h2>

	 <h2>C++</h2>

	 </body>

	 </html>

Output:

•	 3-Column Layout: This website layout is mostly used 
for desktops. 

CSS website layout

A website is often divided into headers, menus, content 
and a footer:

Content Section: The content section is the main body 
of the website. The user can divide content section in 
n-column layout. 

The most common layouts are: 

•	 1-Column Layout: It is mostly used for mobile layout. 

•	 2-Column Layout: This website layout is mostly used 
for tablets or laptops. 
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			   h2 {

				    color:green;

				    text-align:center;

			   }

			   /* Media query to set website layout

			   according to screen size */

			   @media screen and (max-width:600px) 
{

				    .columnA, .columnB, .columnC 
{

					     width: 50%;

				    }

			   }

		  @media screen and (max-width:400px) {

			   .columnA, .columnB, .columnC {

					     width: 100%;

				    }

			   }

		  </style>

	 </head>

	 <body>

		  <!-- header of website layout -->

		  <div class = “header”>

			   <h2 style = “color:white;font-
size:100%”>

				    National Instructional Media 
Institute (NIMI)

			   </h2>

		  </div>

		  <!-- navigation menu of website layout -->

		  <div class = “nav_menu”>

			   <a href = “#”>Home</a>

			   <a href = “#”>About</a>

			   <a href = “#”>Contact</a>

		  </div>

		  <!-- Content section of website layout -->

		  <div class = “row”>

			 

			   <div class = “columnA”>

				    <h2>Column A - Objective</
h2>

	 <p>NIMI has been functioning as a Nodal Agency 
to develop Instructional Materials, e-content, 
Question Banks, Train media developers and 
trainers, enable translation of books into Hindi 
and other regional languages, network with other 
vocational stakeholders, create resource centers 
for vocational courses, promote research in the field 
of development of instructional materials and offer 
consultancy services.</p>

			   </div>

			   <div class = “columnB”>

The user can also create a responsive layout where the 
layout will get changed as per screen size. Consider the 
below example where if width of screen is more than 
600px then there will be 3-column layout and if width 
of screen is between 400px to 600px then there will be 
2-column layout and if screen size less than 400px then 
1-column layout will display.

Program:

 <!DOCTYPE html>

 <html>

	 <head>

		  <title>

			   Website Layout

		  </title>

		  <style>

			   * {

				    box-sizing: border-box;

			   }

			 

			   /* CSS property for header section */

			   .header {

				    background-color: green;

				    padding: 15px;

				    text-align: center;

			   }

			 

			   /* CSS property for navigation menu */

			   .nav_menu {

	 	 	 	 overflow: hidden;
				    background-color: #333;

			   }

			   .nav_menu a {

	 	 	 	 float: left;
				    display: block;

				    color: white;

				    text-align: center;

				    padding: 14px 16px;

				    text-decoration: none;

			   }

			   .nav_menu a:hover {

				    background-color: white;

				    color: green;

			   }

			   /* CSS property for content section */

			   .columnA, .columnB, .columnC {

	 	 	 	 float: left;
				    width: 31%;

				    padding: 15px;

				    text-align:justify;

			   }
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				    <h2>Column B - Vision</h2>

				    <p>Nimi envisages to scale 
global benchmarks in vocational education as a 
Nodal Organization for curricula, instructional media 
packages and Test Item development for vocational 
courses in the country.</p>

			   </div>

			   <div class = “columnC”>

				    <h2>Column C - Mission</h2>

	 <p>Nimi proposes to accelerate vocational 
training in the country through systemic curriculum 
development, production, dissemination of 
instructional media packages and training on 
instructional media by closely interacting with the 
State / UT Governments., Industries, ITIs and 
Organizations involved in Vocational Training.</p>

			   </div>

		  </div>

	 </body>

</html>				 

Output:

		  }

		  #GFG {

			   background-image:

			   url(3.jpg),

			   url(2.jpg);

			   background-position: center, center;

			   background-repeat: no-repeat, no-
repeat;

		  background-size: 400px 300px, 500px 400px;

			   padding:25px;

			   height:400px;

		  }

Main Program: 

<!DOCTYPE html>

<html>

<head>

	 <link rel=”stylesheet” href=”stys.css”/>

</head>

<body>

	 <div id = “GFG”>

		  <h1>Welcome to NIMI</h1>

		  <h2>Set Multiple Backgrounds</h2>

		  <p>

		  Element contains two background images

		  </p>

	 </div>

 </body>

 </html>			 

Output: 

Multiple backgrounds & Putting the stylesheet in a 
separate file
Multiple Background CSS properties created  as 
separate file:   Save the file as stys.css
 body {

			   text-align:center;

		  }

		  h1 {

			   color: green;
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TASK 6: CSS Animations & CSS Buttons

CSS Animations

Example1: 

 <!DOCTYPE html>

 <html>

 <head>

	 <style>

	 #a {

		  animation-name: color;

		  animation-duration: 10s;

		  padding-top: 30px;

		  padding-bottom: 30px;

		  font-family: Times New Roman;

		  }

	 #a1{

		  animation-name: text;

        	 animation-duration: 5s;

        	 animation-iteration-count: infinite;
	 }

	 #b {

		  font-size: 40px;

		  text-align: center;

		  font-weight: bold;

		  color: #090;

		  padding-bottom: 5px;

	 }

	 #c {

		  font-size: 17px;

		  font-weight: bold;

		  text-align: center;

	 }

	 @keyframes color {

		  0% {

			   background-color: red;

		  }

		  50% {

			   background-color: orange;

		  }

		  100% {

			   background-color: green;

		  }

	 }

	 @keyframes text {

        	 from {

            	margin-top: 400px;

        	 }

        	 to {

            	margin-top: 0px;

        	 }

	 </style>

</head>

<body>

	 <div id=”a1”>

		  <div id=”a”>

		  <div id=”b”>Welcome to NIMI</div>

		  <div id=”c”>a NIMI portal for Online Books</
div>

		  </div>

	 </div>

</body>

</html>

Output:

Example 2

 <!DOCTYPE html>

 <html>

 <head>

	 <style>

	 .a {

		  font-size: 40px;

		  text-align: center;

		  font-weight: bold;

		  color: #090;

		  padding-bottom: 5px;

		  font-family: Times New Roman;

	 }

	 .b {

		  font-size: 17px;

		  font-weight: bold;

		  text-align: center;

		  font-family: Times New Roman;

	 }

	 h2 {

		  width: 550px;

		  animation-name: text;

		  animation-duration: 4s;

	 	 animation-iteration-count: infinite;
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		  background-color: rgb(255, 210, 85);

	 }

	 #one {

		  animation-timing-function: ease;

	 }

	 #two {

		  animation-name: color;

        	 animation-duration: 10s;

	 }

	 #three {

		  animation-name: color;

        	 animation-duration: 2s;

        	 animation-iteration-count: infinite;
	 }

	 #four {

		  animation-direction: reverse;

	 }

	 #five {
		    animation-direction: alternate-reverse;

	 }

	 @keyframes text {

		  from {

			   margin-left: 100%;

		  }

		  to {

			   margin-left: 0%;

		  }

	 }

	 @keyframes color {

        	 from {

           	  background-color: red;

        	 }

        	 to {

            	background-color: green;

        	 }

	 </style>

 </head>

 <body>

	 <div class=”a”>Welcome to NIMI</div>

	 <div class=”b”>a NIMI portal for Online Books</div>

	 <h2 id=”one”>This text for ease animation-timing-
function</h2>

	 <h2 id=”two”>This text for animation-delay</h2>

	 <h2 id=”three”>This text for animation delay infinite</
h2>

	 <h2 id=”four”>This text for animation reverse</h2>

	 <h2 id=”five”>This text for animation alternate-
reverse</h2>

 </body>

 </html>

Output:

CSS Buttons

Example1:

 <!DOCTYPE html>

 <html>

 <head>

	 <title> button background Color </title>

	 <style>

	 .button {

		  background-color: red;

		  color: white;

		  text-align: center;

		  font-size: 20px;

	 }

	 .b1 {

		  /* Set border property */

		  border: none;

	 }

	 .b2 {

		  /* Set border property */

		  border: 2px black solid;

	 }

	 .b3 {

		  /* Set border property */

		  border: 2px black dashed;

	 }

	 .b4 {

		  /* Set border property */

		  border: 2px black double;

	 }

	 .b5 {

		  /* Set border property */

		  border: 2px black groove;

	 }

	 </style>

 </head>

 <body>

	 <button class=”button b1”>None</button>

	 <button class=”button b2”>Solid</button>

	 <button class=”button b3”>Dashed</button>
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	 <button class=”button b4”>Double</button>

	 <button class=”button b5”>Groove</button>

 </body>

 </html>

Output:

	

	 .b3 {

		  background-color: green;

		  border-radius: 10px;

	 }

	

	 .b4 {

		  background-color: yellow;

		  border-radius: 20px;

	 }

	

	 .b5 {

		  background-color: orange;

		  border-radius: 50%;

	 }

	 </style>

 </head>

 <body>

	 <button class=”b b1”>3px </button>

	 <button class=”b b2”>6px</button>

	 <button class=”b b3”>10px</button>

	 <button class=”b b4”>20px</button>

	 <button class=”b b5”>50%</button>

 </body>

 </html>

 Output:

Example 2:

 <!DOCTYPE html>

 <html>

 <head>

	 <title> button border-radius property </title>

	 <style>

	 .b {

		  padding: 15px 32px;

		  border: none;

		  font-size: 16px;

	 }

	

	 .b1 {

		  background-color: red;

		  border-radius: 3px;

	 }

	

	 .b2 {

		  background-color: blue;

		  border-radius: 6px;

	 }
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IT & ITES                                                                                          Exercise 1.32.115
COPA - JavaScript Embed JavaScript in HTML Pages

Practicing the JavaScript in creating dynamic HTML pages
Objectives: At the end of this exercise you shall be able to
• create javascript code in the <Head > section of HTML page
• create javascript code in the <Body > section of HTML page
• create javascript code in the <Head > and <Body> section of HTML page
• create and run sample JavaScript code.

PROCEDURE

TASK 1 : Create Javasscript code in the <Head > section of HTML page

Note to instructor : To run JavaScript, any modern browser should be installed as all modern browser
can run JavaScript by default.

1 Open Notepad.

2 Type the following code.

<html>

<head>

<script>

function myFunction() {

document.write("hello");

document.write(" world");

}

</script>

</head>

<body>

<h1>My Web Page</h1>

<button type="button" onclick="myFunction()">Try
it</button>

</body>

</html>

3  Click Save.

4  Type filename as page1.html.

5  Select file type as All Files.

6  Select destination in Desktop or any other location.
Click Save.

7   Close Notepad.

8   Now go to the file destination.

9   Double Click it to run.

10  Browser can show you a warning. (Fig 1)

11  If warning is shown, click yellow warning bar.

12  Select Allow Blocked Content.

13  A security warning can be shown (Fig 2).

14  Click yes.

15 Now click "Try it" to run the javascript code in the
page.

16 Hello World would be shown as output. (Fig 3).

Fig 1 

Fig 2

Fig 3
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TASK 2 : Create Javasscript code in the <Body > section of HTML page

1 Write and save following code and save with
access.html.

<html>

<body>

<p id="p1">Hello World!</p>

<script>

TASK 3: Create JavaScript code in the <Head>  and <Body> section of an HTML page.

document.getElementById("p1").innerHTML = "New
text!";

</script>

</body>

</html>

2 Run it by double clicking this file name.

3 It will show the following output.

New text!

1 Create and run the following JavaScript code.

<!DOCTYPE html>

<head>

<title> Script in head and body section </title>

<script type = “text/javascript”>

document.writeln(“Good Morning”);

</script>

</head>

<body>

<script type = “text/javascript”>

alert(“Good Evening”);

</script>

</body>

</html>

2 Run the code and check the output.

TASK 4: Create and run sample JavaScript code.

1 Create and run the following JavaScript code.

<!DOCTYPE html>

<html>

<body>

<h1 id="header">Old Header</h1>

<script>

var element = document.getElementById("header");

element.innerHTML = "New Header";

</script>

</body>

</html>

2 Create and run the following JavaScript code.

<!DOCTYPE html>

<html>

<body>

<img id="myImage" src="smiley.gif">

<script>

document.getElementById("myImage").src=
"landscape.jpg";

</script>

</body>

</html>

3 Change the Value of an Attribute

To change the value of an HTML attribute, use this
syntax:

document.getElementById(id).attribute=new value
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IT & ITES                                                                                          Exercise 1.32.116
COPA - JavaScript Embed JavaScript in HTML Pages

Embed JavaScript in HTML to Display Information in Web pages
Objectives: At the end of this exercise you shall be able to
• use external javascript files in HTML
• display information with javascript.

PROCEDURE

TASK 1 : Using external JavaScript files in HTML

1 Open Notepad.

2 Type the following code.

function myFunction() {

document.write("hello");

document.write(" world");

}

3 Click Save.

4 Type filename as myscript.js.

5 Select file type as All Files.

6 Select destination in Desktop or any other location.
Click Save.

7 Close Notepad.

8 Open Notepad again.

9 Type the following code. (Fig 2)

<html>

<head>

<script type="text/javascript" src=" myscript.js"> </
script>

</head>

<body>

<h1>My Web Page</h1>

<button type="button" onclick="myFunction()">Try
it</button>

</body>

</html>

10 Click Save.

11 Type filename as js2102.html

12 Select file type as All Files.

13 Select destination in Desktop or any other location.
Click Save.

14 Close Notepad.

15 Now go to the file destination.

16 Double Click it to run.

17 See the output as shown in Fig 1 & Fig 2.

Fig 1

Fig 2
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TASK 2 : Display information with JavaScript

1 Write the code and save it with jc21021.html.

<html>

<head>

<title>A Web page</title>

<script type="text/javascript">

function anotherAlert(textAlert) {

alert(textAlert);

}

anotherAlert("This is a alert");

</script>

<body>

<h1>Web Page with Alert</h1>

</body>

</html>

2 Run the code and see the output.(Fig 3)

Fig 3
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IT & ITES                                                                                          Exercise 1.32.117
COPA - JavaScript Embed JavaScript in HTML Pages

Use error handling techniques in JavaScript
Objectives: At the end of this exercise you shall be able to
• use try-catch in JavaScript
• use finally in JavaScript
• use throw in JavaScript
• use onerror() method  in JavaScript.

1 Open Notepad

2 Type the following code

<html>

<head>

<script type=”text/javascript”>

 function myFunc()

{

var a = 100;

try {

alert(“Value of variable a is : “ + a );

 }

catch ( e ) {

alert(“Error: “ + e.description );

}

}

</script>

</head>

<body>

<p>Click the following to see the result:</p>

<form>

<input type=”button” value=”Click Me”
onclick=”myFunc();” />

</form>

</body>

</html>

3 Click Save

4 Type filename as ErrorHandling1.html

5 Select file type as All Files.

6 Select desktop or any other location. Click Save

7 Close Notepad

8 Now run the html file to see the result(fig-1)

9 Click the Click Me button( fig-2)

 Fig 1

PROCEDURE

TASK 1: Use try-catch in javascript
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TASK 2: Use finally in javascript

1 Open Notepad

2 Type the following code

<html>

<head>

<script type=”text/javascript”>

function myFunc()

{

var a = 100;

try {

alert(“Value of variable a is : “ + a );

}

 catch ( e ) {

alert(“Error: “ + e.description );

}

finally {

alert(“Finally block will always execute!” );

}

}

</script>

</head>

<body>

<p>Click the following to see the result:</p>

<form>

<input type=”button” value=”Click Me”
onclick=”myFunc();” />

</form>

</body>

 </html>

3 Click Save

4 Type filename as ErrorHandling2.html

5 Select file type as All Files.

6 Select desktop or any other location. Click Save

7 Close Notepad

8 Now run the html file to see the result (Fig-3)

9 Click on Click Me button (Fig-4)

TASK 3: Use throw in javascript

1 Open Notepad 2 Type the following code

Fig 3

Fig 4
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</script>

</head>

<body>

<p>Click the following to see the result:</p>

<form>

<input type=”button” value=”Click Me”
onclick=”myFunc();” />

</form>

</body>

</html>

3  Click Save

4 Type filename as ErrorHandling3.html

5 Select file type as All Files.

6 Select desktop or any other location. Click Save

7 Close Notepad

8 Now run the html file to see the result (Fig-5)

9 Click the Click Me button (Fig-6)

<html>

<head>

<script type=”text/javascript”>

  function myFunc()

{

var a = 100;

var b = 0;

try{

if ( b == 0 )

{

throw( “Divide by zero error.” );

}

else

{

 var c = a / b;

}

}

catch ( e ) {

alert(“Error: “ + e );

}

}

Fig 5

Fig 6
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TASK 4: Use onerror() Method  in javascript

1 Open Notepad

2 Type the following code

<html>

 <head>

 <script type=”text/javascript”>

  window.onerror = function () {

alert(“An error occurred.”);

}

</script>

</head>

 <body>

<p>Click the following to see the result:</p>

<form>

<input type=”button” value=”Click Me”
onclick=”myFunc();” />

</form>

</body>

</html>

3 Click Save

4 Type filename as ErrorHandling4.html

5 Select file type as All Files.

6 Select desktop or any other location. Click Save

7 Close Notepad

8 Now run the html file to see the result (Fig-7)

9 Click the Click Me button (Fig-8)

Fig 8

Fig 7
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IT & ITES                                                                                          Exercise 1.32.118
COPA - JavaScript Embed JavaScript in HTML Pages

Use objects and classes in JavaScript
Objectives: At the end of this exercise you shall be able to
• display add two numbers using function
• take input using prompt function
• take confirmation using confirm method
• using global variable.

PROCEDURE

TASK 1 : Display add two numbers using function

1 Open Notepad.

2 Type the following code.

<html>

<head>

<title>Adder</title>

<script>

var a=4;

var b=6;

var c=add(a,b);

alert(c);

function add(a,b) {

return a+b;

}

</script>

</head>

<body>

</body>

</html>

3 Click Save.

4 Type filename as add1.html

5 Select file type as All Files.

6 Select destination in Desktop or any other location.
Click Save.

7 Close Notepad.

8 Now run the html file to see the result. (See Fig 1)

Fig 1

TASK 2:  Take input using prompt function

1 Open Notepad.

2 Type the following code.

<html>

<head>

<title>Prompt</title>

<script>

var a=prompt("Enter a Number:");

var b=prompt("Enter another Number:");

var ch=+prompt("1->Add  2->Sub  3->Mul  4->Div
Enter Choice:");

var r=0,fl=0;

switch(ch) {

case 1:

r=add(a,b);

break;

case 2:

r=sub(a,b);

break;

case 3:

r=mul(a,b);

break;

case 4:

r=div(a,b);

break;
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default:

fl=1;

}

if(fl)

document.write("Invalid choice");

else

document.write("Result is "+r);

function add(a,b) {

return a+b;

}

function sub(a,b) {

return a-b;

}

function mul(a,b) {

return a*b;

}

function div(a,b) {

return a/b;

}

</script>

</head>

<body>

</body>

</html>

3 Click Save.

4 Type filename as calcul1.html

5 Select file type as All Files.

6 Select destination in Desktop or any other location.
Click Save.

7 Close Notepad.

8 Now run the html file to see the result. (Fig 2 to Fig 5)

Fig 2

Fig 3

Fig 4

Fig 5

TASK 3 :  Take confirmation using confirm method

1 Open Notepad.

2 Type the following code.

<html>

<head>

<title>Confirm</title>

<script>

var a=confirm("Want to play a game?");

if(a)

document.write("We will play a game now!");

else

document.write("May be next time");

</script>

</head>

<body>

</body>

</html>

3 Click Save.

4 Type filename as conf1.html

5 Select file type as All Files.

6 Select destination in Desktop or any other location.
Click Save.

7 Close Notepad.

8 Now run the html file to see the result. (Fig 6  to Fig 8)

If Ok is selected.

If cancel is selected
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Fig 6

 

Fig 7

Fig 8

TASK 4 : Using global variable

1 Open Notepad.

2 Type the following code.

<html>

<body>

<script>

function m()

{

window.value=100;//declaring global variable by
window object

}

function n(){

alert(value);//accessing global variable from other
function

}

m();

n();

</script>

</body>

</html>

3 Click Save.

4 Type filename as vari1.html

5 Select file type as All Files.

6 Select destination in Desktop or any other location.
Click Save.

7 Close Notepad.

8 Now run the html file to see the result. (Fig 9 )

Fig 9
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IT & ITES                                                                                          Exercise 1.32.119
COPA - JavaScript Embed JavaScript in HTML Pages

Describe Animation and Multimedia using JavaScript
Objectives: At the end of this exercise you shall be able to
• manual Animation
• automated Animation
• rollover with a Mouse Event.

PROCEDURE

TASK 1 : Manual Animation

1 Open notepad.

2 Type the following code
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3 Click save

4 Type filename as animation1.html

5 Select file type as all files

6 Select destination in desktop or other location. Click
save

7 Close Notepad

8 Now run the html file to see the result (see Fig 1)

Output
Fig 1

TASK 2: Automated Animation

1 Open notepad. 2 Type the following code
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3 Click save

4 Type filename as animation2.html

5 Select file type as all files

6 Select destination in desktop or other location. Click
save

7 Close Notepad

8 Now run the html file to see the result (see Fig 2)

Output

Fig 2

TASK 3: Rollover with a Mouse Event

1 Open notepad. 2 Type the following code

3 Click save

4 Type filename as animation3.html

5 Select file type as all files

6 Select destination in desktop or other location. Click
save

7 Close Notepad

8 Now run the html file to see the result (see Fig:3)

Output

Fig 3
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IT & ITES                                                                                          Exercise 1.32.120
COPA - JavaScript Embed JavaScript in HTML Pages

Develop dynamic HTML pages using JavaScript
Objectives: At the end of this exercise you shall be able to
• learn how to develop dynamic HTML Pages using JavaScript.

Requirements

Tools/Equipment/Machines

• A working PC with Windows

O.S., Text Editor (Notepad) &

Browser - 1 No./batch.

PROCEDURE

TASK 1: HTML Java script

1 Open Notepad.

2 Type the following code.

<HTML>

<head>

<title>

Method of a JavaScript

</title>

</head>

<body>

<script type="text/javascript">

document.write("JavaTpoint");

</script>

</body>

</html>

3 Click Save.

4 Type filename as page1.html.

5 Select file type as All Files.

6 Select destination in Desktop or any other location.
Click Save.

7 Close Notepad.

8   Now go to the file destination.

9 Double Click it to run.

10 Browser can show you a warning.

11 If warning is shown, click yellow warning bar.

12 Select Allow Blocked Content.

13 A security warning can be shown.

14 Click yes.

15 Now click "Try it" to run the javascript code in the
page.

16 Hello World would be shown as output.

Output:

TASK 2: JavaScript and HTML event

Ref Steps 1 to 16 - Task 1

<html>

<head>

<title>

DHTML with JavaScript

</title>

<script type="text/javascript">

function dateandtime()

{
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alert(Date());

}

</script>

</head>

<body bgcolor="orange">

<font size="4" color="blue">

<center> <p>

Click here # <a href="#" onClick="dateandtime();">
Date and Time </a>

# to check the today's date and time.

</p> </center>

</font>

</body>

</html>

Output:

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.32.120

TASK 3: JavaScript and HTML DOM

Ref Steps 1 to 16 - Task 1

<html>

<head>

<title> Check Student Grade

</title>

</head>

<body>

<p>Enter the percentage of a Student:</p>

<input type="text" id="percentage">

<button type="button" onclick="checkGrade()">

Find Grade

</button>

<p id="demo"></p>

<script type="text/javascript">

function checkGrade() {

var x,p, text;

p = document.getElementById("percentage").value;

x=parseInt(p);

 if (x>90 && x <= 100) {

document.getElementById("demo").innerHTML =
"A1";

} else if (x>80 && x <= 90) {

document.getElementById("demo").innerHTML =
"A2";

} else if (x>70 && x <= 80) {

document.getElementById("demo").innerHTML =
"A3";

}

            }

</script>

</body>

</html>

Output:
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TASK 4: CSS with JavaScript in DHTML

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.32.120

Ref Steps 1 to 16 - Task 1

<html>

<head>

<title>

getElementById.style.property example

</title>

</head>

<body>

<p id="demo"> This text changes color when click
on the following different buttons. </p>

<button onclick="change_Color('green');"> Green </
button>

<button onclick="change_Color('blue');"> Blue </
button>

<script type="text/javascript">

function change_Color(newColor) {

var element = document.get ElementById
('demo').style.color = newColor;

}

</script>

</body>

</html>

Output:

TASK 5: DHTML CSS

Ref Steps 1 to 16 - Task 1

<html>

<head>

<title>

Changes current HTML element

</title>

</head>

<body>

<center>

<h1 onclick="this.style.color='blue'"> This is a
JavaTpoint Site </h1>

<center>

</body>

</html>

Output:

TASK 6: DHTML Events

Ref Steps 1 to 16 - Task 1

<html>

<head>

<title>

Example of onclick event

</title>

<script type="text/javascript">

function ChangeText(ctext)

{

ctext.innerHTML=" Hi JavaTpoint! ";

}
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</script>

</head>

<body>

<font color="red"> Click on the Given text for
changing it: <br>

</font>

<font color="blue">

<h1 onclick="ChangeText(this)"> Hello World! </h1>

</font>

</body>

</html>

Output:
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<html>

<head>

<title>

Example of onsubmit event

</title>

</head>

<body>

<form onsubmit="Submit_Form()">

<label> Enter your name: </label>

<input type="text">

<label> Enter your Roll no: </label>

<input type="Number">

<input type="submit" value="submit">

</form>

<script type="text/javascript">

function Submit_Form()

{

alert(" Your form is submitted");

}

</script>

</body>

</html>

Output:

TASK 7: DHTML DOM

Ref Steps 1 to 16 - Task 1

<html>

<head>

<title>

Example of DHTML DOM

</title>

</head>

<body>

<font color = "blue">

<p id="demo"> This text changes color when the
page loaded. </p>

</font>

<script type="text/javascript">

document.getElementById('demo').style.color =
"red";

</script>

</body>

</html>

Output:
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IT & ITES                                                                                          Exercise 1.32.121
COPA - JavaScript Embed JavaScript in HTML Pages

Deploy web project using IIS
Objectives: At the end of this exercise you shall be able to
• configure IIS in Windows 10 Operating System
•  publish website on IIS locally
•  publish Web site in IIS.

PROCEDURE

TASK 1 : Configure IIS in Windows 10 Operating System

Fig 1

1 Click Programs (Fig 2)

Fig 2
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2 Click Turn Window features on or off (Fig 3)

 Fig 3

3 Check the Internet Information Services and its related
features in the New popup window( Fig 4)

Fig 4
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Under Internet Information Services check the following
folders:(Fig 5)

- FTP Server

- Web Management Tools

- World wide web services

- Application development features

- Common HTTP Feature

- Health and Diagnostics

- Perfomance Feature

- Security

Fig 5

4 Then click OK to complete the installation of new
features.

Fig 6
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5 Click Close to complete the IIS feature installation.

Fig 7

6 Open the browser, type url http://localhost 7 Internet Information Services (IIS) successfully
configured (Fig 8)

Fig 8
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TASK 2 :  Publish website on IIS web server locally

1 Create a home page for the website using any web
page design tool

2 Copy the home page in to inetpub/wwwroot the Web
publishing directory of IIS

3 Type the user ’s computer name or the
computer’snumerical IP address followed by the home
page    name in the browser’s address bar to reach
user’s site.

Fig 9

TASK 3 : Publish a new Web site in IIS

1 Type IIS Manger in Cortana search 2 Open IIS Manager by clicking on Internet Information
Services(IIS) Manager. (Fig,10)

Fig 10
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3 Right click on Sites and click on Add Website. (Fig11)

Fig 11

4 Opens Add website dialog. (Fig 12)

Fig 12
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5 Fill in required details and select folder where   compiled
code is located. (Fig 13)

     Eg: C:\Nigel\Publish

6 Select required port .(Fig 13)

7 Enter host name details

(Do not enter host name details if you are testing or
using on LAN).

Fig 13

8 Click ok, website gets created and it will show under
Sites(Fig 14)

 Fig 14
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9 Right click on website name then Manage websiteand
then click browse. (Fig 15)

Fig 15

10 Type firewall In Cortana search for change in Firewall
Rules.(Fig16)

Fig 16
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11 Click on Windows firewall (Fig 17)

Fig 17

12 Click advanced settings.(Fig 18)

Fig 18

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.32.121

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



91

13 Click on Inbound rules on the left. (Fig 19)

 Fig 19

14 Click new Rule in the right side menu.(Fig 20)

Fig 20
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15 Select Port in the New inbound rule wizard and click
Next .(Fig 21)

Fig 21

16 Enter port number in specific local ports textbox, Then
click Next (Fig 22)

Fig 22
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17 Select Allow the connection in the opened Action form
and click Next .(Fig 23)

    Fig 23

18 Select required ones in the profile form and Click  Next.
(Fig 24)

       Fig 24
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19 Give firewall rule Name and Description, Then click
finish. (Fig 25)

Fig 25

TASK 3:  Publish Content on IIS web server locally

1 Create a home page for the website using any web
page design tool

2 Copy the home page in to inetpub/wwwroot the Web
publishing directory of IIS

3 Type the user’s computer name or the computer’s
numerical IP address followed by the home pagename
in the browser’s address bar to reach user’s site.
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IT & ITES	 	 Exercise 1.33.122	
COPA - Data Visualization or Analysis using Excel	

Create and modify simple macros
Objectives: At the end of this exercise you shall be able to
•	 state create macro
•	 state modify a macro

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

TASK 1: Create a macro

Record a macro    

1	 In the Code group on the Developer tab, click Record 
Macro.

2	 Optionally, enter a name for the macro in the Macro 
name box, enter a shortcut key in the Shortcut key 
box, and a description in the Description box, and 
then click OK to start recording.

3	 Perform the actions you want to automate, such as 
entering boilerplate text or filling down a column of 
data.

4	 On the Developer tab, click Stop Recording. 

Before you record a macro    

Macros and VBA tools can be found on the Developer 
tab, which is hidden by default, so the first step is to 
enable it. For more information, see Show the Developer 
tab.

Take a closer look at the macro    

You can learn a little about the Visual Basic programming 
language by editing a macro.

To edit a macro, in the Code group on the Developer 
tab, click Macros, select the name of the macro, and 
click Edit. This starts the Visual Basic Editor.

See how the actions that you recorded appear as code. 
Some of the code will probably be clear to you, and 
some of it may be a little mysterious.

Experiment with the code, close the Visual Basic Editor, 
and run your macro again. This time, see if anything 
different happens!

TASK 2: Modify a macro

1	 On the Developer tab, in the Code group, click 
Macros.

2	 In the Macro name box, click the macro that you 
want to edit.

3	 Click Edit. The Visual Basic Editor appears.

Tip: To get help while you are working in the Visual 
Basic Editor, on the Help menu, click Microsoft Visual 
Basic Help, or press F1.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



96

IT & ITES	 	 Exercise 1.33.123	
COPA - Data Visualization or Analysis using Excel	

Perform form controls and create simple data entry form with macros
Objectives: At the end of this exercise you shall be able to
•	 details form controls
•	 create simple data entry form.

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

TASK 1: Form Controls

In a new worksheet, type the following items in the 
range H1:H20:

	 H1 : Roller Skates	 H2 : VCR	 H3 : Desk

	 H4 : Mug	 H5 : Car	 H6 : Washing 	
			   Machine

	 H7 : Rocket	 H8 : Bike	 H9 : Phone	
	 Launcher

	 H10: Candle	 H11: Candy	 H12: Speakers

	 H13: Dress	 H14: Blanket	 H15: Dryer

	 H16: Guitar	 H17: Dryer	 H18: Tool Set

	 H19: VCR	 H20: Hard Disk

1	 In cell A1, type the following formula: 

	 =INDEX(H1:H20,G1,0)

List box example

1	 To add a list box in Excel 2007 and later versions, 
click the Developer tab, click Insert in the Controls 
group, and then click List Box Form (Control) under 
Form Controls.

3	 Click the worksheet location where you want the 
upper-left corner of the list box to appear, and then 
drag the list box to where you want the lower-right 
corner of the list box to be. In this example, create a 
list box that covers cells B2:E10.

2	 To add a list box in Excel 2003 and in earlier versions 
of Excel, click the List Box button on the Forms 
toolbar. If the Forms toolbar is not visible, point to 
Toolbars on the View menu, and then click Forms.

4	 In the Controls group, click Properties.

5	 In the Format Object window, type the following 
information, and then click OK.

a	 To specify the range for the list, type H1:H20 in 
the Input range box.

b	 To put a number value in cell G1 (depending on 
which item is selected in the list), type G1 in the 
Cell link box.

Note: The INDEX() formula uses the value in 
G1 to return the correct list item.

c	 Under Selection type, make sure that the Single 
option is selected.

Note:  The Multi and Extend options are only 
useful when you are using a Microsoft Visual 
Basic for Applications procedure to return 
the values of the list. Note also that the 3-D 
shading check box adds a three-dimensional 
look to the list box.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



97IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.33.123

3	 Click the worksheet location where you want the 
upper-left corner of the combo box to appear, and 
then drag the combo box to where you want the 
lower-right corner of the list box to be. In this example, 
create a combo box that covers cells B2:E2.

6	 The list box should display the list of items. To use 
the list box, click any cell so that the list box is not 
selected. If you click an item in the list, cell G1 is 
updated to a number that indicates the position of the 
item that is selected in the list. The INDEX formula in 
cell A1 uses this number to display the item’s name.

Combo box example

1	 To add a combo box in Excel 2007 and later versions, 
click the Developer tab, click Insert, and then click 
Combo Box under Form Controls.

2	 To add a combo box in Excel 2003 and in earlier 
versions of Excel, click the Combo Box button on the 
Forms toolbar.

4	 Right-click the combo box, and then click Format 
Control.

5	 Type the following information, and then click OK:

a	 To specify the range for the list, type H1:H20 in 
the Input range box.

b	 To put a number value in cell G1 (depending on 
which item is selected in the list), type G1 in the 
Cell link box.

Note: The INDEX formula uses the value in G1 
to return the correct list item.

c	 In the Drop down lines box, type 10. This entry 
determines how many items will be displayed 
before you have to use a scroll bar to view the 
other items.

Note: The 3-D shading check box is optional. 
It adds a three-dimensional look to the drop-
down or combo box.
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6	 The drop-down box or combo box should display the 
list of items. To use the drop-down box or combo 
box, click any cell so that the object is not selected. 
When you click an item in the drop-down box or 
combo box, cell G1 is updated to a number that 
indicates the position in the list of the item selected. 
The INDEX formula in cell A1 uses this number to 
display the item’s name.

Spin button example

1	 To add a spin button in Excel 2007 and later versions, 
click the Developer tab, click Insert, and then click 
Spin Button under Form Controls.

c	 In the Maximum value box, type 20.

	 This number specifies the maximum number of 
entries in the list.

d	 In the Incremental change box, type 1.

	 This value controls how much the spin button 
control increments the current value.

e	 To put a number value in cell G1 (depending on 
which item is selected in the list), type G1 in the 
Cell link box.

	 To add a spinner in Excel 2003 and in earlier 
versions of Excel, click the Spinner button on the 
Forms toolbar.

2	 Click the worksheet location where you want the 
upper-left corner of the spin button to appear, and 
then drag the spin button to where you want the 
lower-right corner of the spin button to be. In this 
example, create a spin button that covers cells B2: 
B3.

3	 Right-click the spin button, and then click Format 
Control.

4	 Type the following information, and then click OK:

a	 In the Current value box, type 1.

	 This value initializes the spin button so that the 
INDEX formula will point to the first item in the 
list.

b	 In the Minimum value box, type 1.

	 This value restricts the top of the spin button to 
the first item in the list.

5	 Click any cell so that the spin button is not selected. 
When you click the up control or down control on 
the spin button, cell G1 is updated to a number that 
indicates the current value of the spin button plus 
or minus the incremental change of the spin button. 
This number then updates the INDEX formula in cell 
A1 to show the next or previous item.

The spin button value will not change if the current value 
is 1 and you click the down control, or if the current value 
is 20 and you click the up control.

Scroll bar example

1	 To add a scroll bar in Excel 2007 and later versions, 
click the Developer tab, click Insert, and then click 
Scroll Bar under Form Controls.

	 To add a scroll bar in Excel 2003 and in earlier 
versions of Excel, click the Scroll Bar button on the 
Forms toolbar.

2	 Click the worksheet location where you want the 
upper-left corner of the scroll bar to appear, and then 
drag the scroll bar to where you want the lower-right 
corner of the scroll bar to be. In this example, create 
a scroll bar that covers cells B2:B6 in height and is 
about one-fourth of the width of the column.
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d	 In the Incremental change box, type 1.

	 This value controls how many numbers the scroll 
bar control increments the current value.

e	 In the Page change box, type 5. This value 
controls how much the current value will be 
incremented if you click inside the scroll bar on 
either side of the scroll box).

f	 To put a number value in cell G1 (depending on 
which item is selected in the list), type G1 in the 
Cell link box.

3	 Right-click the scroll bar, and then click Format 
Control.

4	 Type the following information, and then click OK:

a	 In the Current value box, type 1.

	 This value initializes the scroll bar so that the 
INDEX formula will point to the first item in the 
list.

b	 In the Minimum value box, type 1.

	 This value restricts the top of the scroll bar to the 
first item in the list.

c	 In the Maximum value box, type 20. This number 
specifies the maximum number of entries in the 
list.

Note: The 3-D shading check box is optional. 
It adds a three-dimensional look to the scroll 
bar.

5	 Click any cell so that the scroll bar is not selected. 
When you click the up or down control on the scroll 
bar, cell G1 is updated to a number that indicates 
the current value of the scroll bar plus or minus the 
incremental change of the scroll bar. This number 
is used in the INDEX formula in cell A1 to show the 
item next to or before the current item. You can also 
drag the scroll box to change the value or click in the 
scroll bar on either side of the scroll box to increment 
it by 5 (the Page change value). The scroll bar will 
not change if the current value is 1 and you click the 
down control, or if the current value is 20 and you 
click the up control.
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TASK 2: Create simple Data entry form with Macros

1	 Click the small down arrow at the far-right of the 
QAT, and then choose More Commands in the pop-
up menu. 

2	 In the Excel Options dialog box that opens, under 
Choose commands from, select All Commands or 
Commands Not in the Ribbon.

3	 Scroll down the list of command on the left until you 
see Form… and click on it.

4	 Click the Add button in the middle to move the Form 
to the list of QAT commands on the right.

5	 Click OK to save the changes and close the dialog.

The Form icon will immediately appear in your 
Quick Access Tollbar and will be available in all your 
workbooks. 

Tip: In a similar fashion, you can place the Form tool 
on the ribbon. For the detailed instructions, please see 
How to add a button to Excel ribbon.

How to make data entry form in Excel

A data entry form is only available for a fully functional 
Excel table. To get the form, you just need to put your 
data in a table and the click the Form button. The 
detailed steps follow below:

1	 In your worksheet, type the column headings in the 
topmost row as usual. If you want an input form for 
an existing data set, skip this step.

2	 Select any cell in your dataset and click the Ctrl + T 
keys simultaneously. This will select all the data and 
convert it to a table.

3	 Place the cursor anywhere within the table and click 
the Form button. Done!Believe it or not, you’ve successfully coped with the main 

challenge. Once the Form tool is in your Excel, creating 
a data entry form for any table (a new or existing one) 
takes just a single button click.
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To keep things simple, let’s make this small table as an 
example:

Clicking the Form button automatically creates a data 
entry form for your table with fields corresponding to the 
column headings: 
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As you can see, the Excel input form has a handful 
of different buttons. Here’s a brief explanation of what 
each button does:

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.33.123

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



103

Aside from the buttons, you can use the following keys 
for navigation:

•	 Tab - get to the next field.

•	 Shift + Tab - get to the previous field.

•	 Enter - save the current record and start a new one.

How to add a new record

To add a new record to your table using the data entry 
form, perform these steps:

1	 Select any cell in your table.

2	 Click on the Form button on the Quick Access 
Toolbar or on the ribbon.

3	 In the input form, click the New button.

4	 Type the information in the appropriate fields.

5	 When done, hit the Enter key or click the New button 
again. This will add the record to the table and get a 
blank form for the next record. 

Tip: To quickly enter specific information, you can use 
the same shortcuts that you use in your worksheets. For 
example:

•	 Press Ctrl + ; to insert today’s date.

•	 Press Ctrl + Shift + ; to enter the current time.

How to search for records

To go through the records one by one, you can use the 
Find Prev and Find Next buttons or the vertical scroll 
bar. To find records that meet certain conditions, use the 
Criteria button.

For example, to locate all the projects assigned to the 
Design dept., type Design in the Department field, and 
press Find Next:  
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The wildcard characters can help you broaden the 
search. For instance, to discover the projects that 
contain “skill” anywhere in the project name, type *skill* 
in the Project field. 

When dealing with numbers and dates, the logical 
operators such as greater than (>), less than (<), equal 
to (=), not equal to (<>) and others come in handy. For 
example, to view the records where the start date is 
prior to 1-Mar-2021, use “<1-Mar-2021” or “<3/1/2021” 
for the criteria: 

Note: Criteria on a data form are not case 
sensitive. Say, when searching for the Design 
dept., “DESIGN” and “design” will also be 
found.

How to update and restore records

If some entry is outdated or contains wrong information, 
you can use the Criteria or navigation buttons to get to 
the record, update the incorrect field, and press Enter to 
commit the updated data to the table.

If you made some accidental changes but have not 
pressed the Enter key yet, you can revert to the original 
record by clicking the Restore button. If you’ve already 
hit Enter and the changes were passed over to the 
table, press Ctrl + Z to undo. 
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How to use Data Validation with data entry form

To restrict user input to a specific data type, you can 
set up a data validation rule for one or more columns in 
your table, and your rules will be automatically carried 
over to the data entry form.

For example, to limit the Budget to numbers in a given 
range, we create this rule: 

If someone tries to enter a value that does not conform 
to the rule you’ve set, an error alert will be displayed 
(either the standard or your custom one): 

Limitation: drop down lists are unavailable on a 
form

The use of data validation with input forms has one 
limitation - drop down lists do not appear in data entry 
fields. But even though a drop-down list does not show 
up inside the form, its restrictions are still in effect. If you 
enter a value that is not in the list, the form will reject it 
just as Data Validation normally would. 
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Formulas in data entry forms

In case one or more columns in your table are calculated 
by formulas, you won’t be able to alter those formulas 
using the form because the formula result appears as 
text, not as an editable field. Although that may sound 
like another limitation, in fact it is done for a reason. 
When you change a table formula in one cell, the 
formulas in all other cells in the same column change 
automatically. To avoid messing up your data, formula 
editing on the input form is blocked.

For example, you could use the following formula to find 
out if the actual cost is under, over or within the budget 
based on the 5% threshold:

=IF(ABS([@[Actual cost]]/ [@Budget] - 1)<=5%, “Within 
budget”, IF([@[Actual cost]]/ [@Budget]- 1>5%, “Over 
budget”, IF([@[Actual cost]]/ [@Budget]- 1<5%, “Under 
budget”, “”)))

If you are using a Microsoft 365 subscription and signed 
up for Beta Channel (Office Insider), then you could 
wrap the above formula in the LET function like shown 
below. This will make your formula more compact, 
easier-to-understand and faster-to-calculate:

=LET(dif, E2/D2-1, IF(ABS(dif)<=5%, “Within budget”, 
IF(dif>5%, “Over budget”, IF(dif<5%, “Under budget”, 
“”)))) 

On the data entry form, you will only see a non-editable 
calculated result, not the formula: 
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IT & ITES	 	 Exercise 1.33.124	
COPA - Data Visualization or Analysis using Excel	

Look up data by using functions
Objectives: At the end of this exercise you shall be able to
•	 state look up data.

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

Look up data

Use LOOKUP, one of the lookup and reference 
functions, when you need to look in a single row or 
column and find a value from the same position in a 
second row or column.

For example, let’s say you know the part number for an 
auto part, but you don’t know the price. You can use the 
LOOKUP function to return the price in cell H2 when 
you enter the auto part number in cell H1.

Use the LOOKUP function to search one row or one 
column. In the above example, we’re searching prices 
in column D.

Tips: Consider one of the newer lookup functions, 
depending on which version you are using.

•	 Use VLOOKUP to search one row or column, or to 
search multiple rows and columns (like a table). It’s 
a much improved version of LOOKUP. Watch this 
video about how to use VLOOKUP.

•	 If you are using Microsoft 365, use XLOOKUP - it’s 
not only faster, it also lets you search in any direction 
(up, down, left, right).

There are two ways to use LOOKUP: Vector form and 
Array form

•	 Vector form: Use this form of LOOKUP to search one 
row or one column for a value. Use the vector form 
when you want to specify the range that contains the 
values that you want to match. For example, if you 
want to search for a value in column A, down to row 
6.

•	 Array form: We strongly recommend using 
VLOOKUP or HLOOKUP instead of the array 
form. Watch this video about using VLOOKUP. The 
array form is provided for compatibility with other 
spreadsheet programs, but it’s functionality is limited.

An array is a collection of values in rows and columns 
(like a table) that you want to search. For example, if 
you want to search columns A and B, down to row 6. 
LOOKUP will return the nearest match. To use the array 
form, your data must be sorted.

Vector form

The vector form of LOOKUP looks in a one-row or 
one-column range (known as a vector) for a value and 
returns a value from the same position in a second one-
row or one-column range.
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Syntax

LOOKUP(lookup_value, lookup_vector, [result_vector])

The LOOKUP function vector form syntax has the 
following arguments:

•	 lookup_value    Required. A value that LOOKUP 
searches for in the first vector. Lookup_value can 
be a number, text, a logical value, or a name or 
reference that refers to a value.

•	 lookup_vector    Required. A range that contains only 
one row or one column. The values in lookup_vector 
can be text, numbers, or logical values.

	 Important: The values in lookup_vector must be 
placed in ascending order: ..., -2, -1, 0, 1, 2, ..., A-Z, 
FALSE, TRUE; otherwise, LOOKUP might not return 
the correct value. Uppercase and lowercase text are 
equivalent.

•	 result_vector    Optional. A range that contains only 
one row or column. The result_vector argument 
must be the same size as lookup_vector. It has to be 
the same size.

Remarks

•	 If the LOOKUP function can’t find the lookup_value, 
the function matches the largest value in lookup_
vector that is less than or equal to lookup_value.

•	 If lookup_value is smaller than the smallest value 
in lookup_vector, LOOKUP returns the #N/A error 
value.

Vector examples

You can try out these examples in your own Excel 
worksheet to learn how the LOOKUP function works. 
In the first example, you’re going to end up with a 
spreadsheet that looks similar to this one:

Array form

Tip: We strongly recommend using VLOOKUP or 
HLOOKUP instead of the array form. See this video 
about VLOOKUP; it provides examples. The array form 
of LOOKUP is provided for compatibility with other 
spreadsheet programs, but its functionality is limited.

The array form of LOOKUP looks in the first row or 
column of an array for the specified value and returns a 
value from the same position in the last row or column 
of the array. Use this form of LOOKUP when the values 
that you want to match are in the first row or column of 
the array.

Syntax

LOOKUP(lookup_value, array)

The LOOKUP function array form syntax has these 
arguments:

•	 lookup_value Required. A value that LOOKUP 
searches for in an array. The lookup_value argument 
can be a number, text, a logical value, or a name or 
reference that refers to a value.

•	 If LOOKUP can’t find the value of lookup_value, it 
uses the largest value in the array that is less than or 
equal to lookup_value.

•	 If the value of lookup_value is smaller than the 
smallest value in the first row or column (depending 

on the array dimensions), LOOKUP returns the #N/A 
error value.

•	 array    Required. A range of cells that contains text, 
numbers, or logical values that you want to compare 
with lookup_value.

	 The array form of LOOKUP is very similar to the 
HLOOKUP and VLOOKUP functions. The difference 
is that HLOOKUP searches for the value of lookup_
value in the first row, VLOOKUP searches in the first 
column, and LOOKUP searches according to the 
dimensions of array.

•	 If array covers an area that is wider than it is tall 
(more columns than rows), LOOKUP searches for 
the value of lookup_value in the first row.

•	 If an array is square or is taller than it is wide (more 
rows than columns), LOOKUP searches in the first 
column.

•	 With the HLOOKUP and VLOOKUP functions, you 
can index down or across, but LOOKUP always 
selects the last value in the row or column.

	 Important: The values in array must be placed in 
ascending order: ..., -2, -1, 0, 1, 2, ..., A-Z, FALSE, 
TRUE; otherwise, LOOKUP might not return the 
correct value. Uppercase and lowercase text are 
equivalent.

 

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.33.124

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



109

IT & ITES	 	 Exercise 1.33.125	
COPA - Data Visualization or Analysis using Excel	

Use advanced date functions
Objectives: At the end of this exercise you shall be able to
•	 DATE,DATEIF, DATEVALUE, DAY, DAYS, DAYS360
•	 EDATE , EOMONTH, HOUR,ISOWEEKNUM, MINUTE, MONTH, NETWORKDAYS, NETWORKDAYS.INTL, 

NOW,SECOND, TIME,TIMEVALUE
•	 TODAY, WEEKDAY, WEEKNUM,WORKDAY, WORKDAY.INTL, YEAR, YEARFRAC.

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

DATE

The DATE function returns the serial number of a 
particular date.

Syntax

DATE (year, month, day)

Arguments

	 Argument	 Description	 Required/ Optional

	 year	 The value of the year argument can include one to four 					   
		  digits. Excel interprets the year argument according to 					   
		  the date system your computer is using.	 Required

		  By default, Microsoft Excel for Windows uses the 1900 					   
		  date system.

		  See Notes below.	

	 month	 A positive or negative integer representing the month 					   
		  of the year from 1 to 12 (January to December).	 Required

		  See Notes below.	

	 day	 A positive or negative integer representing the day of 					   
		  the month from 1 to 31.	 Required

		  See Notes below.	

Example
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DATEIF

The DATEDIF function calculates the number of days, 
months, or years between two dates. This function is 
provided for compatibility with Lotus 1-2-3.

Syntax

DATEDIF (start_date,end_date,unit)

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 A date that represents the first, or starting, date of the period.

		  Dates may be entered as text strings within quotation marks 	 Required			 
		  (E.g. “2001/1/30”), as serial numbers (E.g. 36921, which 					   
		  represents January 30, 2001, if you are using the 1900 date 					   
		  system), or as the results of other formulas or functions 					   
		  (E.g. DATEVALUE (“2001/1/30”)).	

	 End_date	 A date that represents the last, or ending, date of the period.	 Required

	 Unit	 The type of information that you want returned.

		  Look at the Unit Table given below.	 Required

Unit Table

	 Unit	 Returns

	 “Y”	 The number of complete years in the period.

	 “M”	 The number of complete months in the period.

	 “D”	 The number of days in the period.

	 “MD”	 The difference between the days in start_date and end_date. The months and 		
		  years of the dates are ignored.

	 “YM”	 The difference between the months in start_date and end_date. The days and 		
		  years of the dates are ignored

	 “YD”	 The difference between the days of start_date and end_date. The years of the 		
		  dates are ignored.

Notes

•	 Excel stores dates as sequential serial numbers 
so that they can be used in calculations. January 
1, 1900 is serial number 1, and January 1, 2008 is 
serial number 39448 because it is 39,447 days after 
January 1, 1900

•	 The DATEDIF function is useful in formulas where 
you need to calculate age.

Example
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DATEVALUE

The DATEVALUE function converts a date in the form of 
text to a serial number (Excel’s date-time code).

The DATEVALUE function converts a date that is stored 
as text to a serial number that Excel recognizes as a 
date. For example,

=DATEVALUE (“1/1/2008”)

returns 39448, the serial number of the date 1/1/2008.

Syntax

DATEVALUE (date_text)

Arguments

	 Argument	 Description	 Required/ Optional

	 date_text	 Text that represents a date in an Excel date format, or a 					   
		  reference to a cell that contains text that represents a date	 Required 			 
		  in an Excel date format. For example, “1/30/2008” or 					   
		  “30-Jan-2008” are text strings within quotation marks that 					   
		  represent dates.

		  See Notes below.	

Example

DAY

The DAY function returns the day of a date, represented 
by a serial number. The day is given as an integer 
ranging from 1 to 31.

Syntax

DAY (serial number)

Arguments

	 Argument	 Description	 Required/ Optional

	 serial number	 The date of the day you are trying to find. Dates 					   
		  should be entered by using the DATE function, or 					   
		  as results of other formulas or functions.	 Required

		  For example, use DATE (2008,5,23) for the 					   
		  23rd day of May 2008. Problems can occur if 					   
		  dates are entered as text.	

Example
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DAYS

The DAYS function returns the number of days between 
two dates.

Syntax

DAYS (end_date, start_date)

Arguments

	 Argument	 Description	 Required/ Optional

	 End_date	 Start_date and End_date are the two dates between which 					   
		  you want to know the number of days.	 Required

	 Start_date	 Start_date and End_date are the two dates between which 					   
		  you want to know the number of days.	 Required

Example

DAYS360

The function DAYS360 returns the number of days 
between two dates based on a 360-day year (twelve 30-
day months), which is used in accounting calculations.

Syntax

DAYS360 (start_date,end_date,[method])

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 The two dates between which you want to know	 Required			 
		  the number of days.

	 end_date	 If start_date occurs after end_date, the DAYS360 					   
		  Function returns a negative number.

		  Dates should be entered by using the DATE Function,	 Required 			 
		  or derived from the results of other formulas or functions.

		  Problems can occur if dates are entered as text.		

	 Method	 A logical value that specifies whether to use the U.S. or 					   
		  European method in the calculation.	 Optional

		  Look at the Method Table below.	

Method Table

	 Method	 Defined
	 FALSE or omitted	 U.S. (NASD) method. If the starting date is the last day of a month, it becomes 		
		  equal to the 30th day of the same month. If the ending date is the last day of a month 		
		  and the starting date is earlier than the 30th day of a month, the ending date 			 
		  becomes equal to the 1st day of the next month; otherwise, the ending date 			 
		  becomes equal to the 30th day of the same month.

	 TRUE	 European method. Starting dates and ending dates that occur on the 31st day 		
		  of a month become equal to the 30th day of the same month.
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Example

EDATE

The EDATE function returns the serial number that 
represents the date that is the indicated number of 
months before or after a specified date (the start_date).

Use EDATE to calculate maturity dates or due dates 
that fall on the same day of the month as the date of 
issue.

Syntax

EDATE (start_date, months)

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 A date that represents the start date. 

		  Dates should be entered by using the DATE function, 	 Required			 
		  or as results of other formulas or functions.

		  Problems can occur if dates are entered as text.		

	 Months	 The number of months before or after start_date.

		  A positive value for months yields a future date; 	 Required			 
		  a negative value yields a past date.	

Example

EMONTH

The EOMONTH function returns the serial number for 
the last day of the month that is the indicated number of 
months before or after start_date.

Syntax

EOMONTH (start_date, months)
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Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 A date that represents the starting date.

		  Dates should be entered by using the DATE function, 	 Required			 
		  or as results of other formulas or functions.

		  Problems can occur if dates are entered as text.	

	 Months	 The number of months before or after start_date.

		  A positive value for months yields a future date.

		  A negative value yields a past date.	 Required

Example

HOUR

The HOUR function returns the hour of a time value. 
The hour is given as an integer, ranging from 0 (12:00 
A.M.) to 23 (11:00 P.M.).

Syntax

HOUR (serial_number)

Arguments

	 Argument	 Description	 Required/ Optional

	 Serial_number	 The time that contains the hour, you want to find.

		  Times can be entered

		  •	 as text strings within quotation marks (E.g. “6:45 PM”)

		  •  as decimal numbers (E.g. 0.78125, which 					   
			   represents 6:45 PM)	 Required

		  •  as results of other formulas or functions (E.g. TIME					   
			   VALUE(“6:45 PM”))	

Example
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ISOWEEKNUM

The ISOWEEKNUM function returns number of the ISO 
week number of the year for a given date.

Syntax

ISOWEEKNUM (date)

Arguments

	 Argument	 Description	 Required/ Optional

	 Date	 Date is the date-time code used by Excel for date and 					   
		  time calculation.	 Required

Example

MINUTE

The MINUTE function returns the minutes of a time 
value. The minute is given as an integer, ranging from 
0 to 59.

Syntax

MINUTE (serial_number)

Arguments

	 Argument	 Description	 Required/ Optional

	 Serial_number	 The time that contains the minute, you want to find.

		  Times can be entered

		  •	 as text strings within quotation marks (E.g. “6:45 PM”)	 Required

		  •	 as decimal numbers (E.g. 0.78125, which represents 					   
			   6:45 PM)

		  •	 as results of other formulas or functions (E.g. TIMEVALUE					   
			   (“6:45 PM”))	

Example
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MONTH

The MONTH function returns the month of a date 
represented by a serial number. The month is given as 
an integer, ranging from 1 (January) to 12 (December).

Syntax

MONTH (serial_number)

Arguments

	 Argument	 Description	 Required/ Optional

	 Serial_number	 The date of the month you are trying to find.

		  Dates should be entered by using the DATE Function, 					   
		  or as results of other formulas or functions.	 Required

		  Problems can occur if dates are entered as text.	

Example

NETWORKDAYS

The NETWORKDAYS function returns the number 
of whole working days between start_date and end_
date. Working days exclude weekends and any dates 
identified in holidays.

Syntax

NETWORKDAYS (start_date, end_date, [holidays])

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 A date that represents the start date.	 Required

	 End_date	 A date that represents the end date.	 Required

	 Holidays	 An optional range of one or more dates to exclude from 					   
			  the working calendar, such as state and federal holidays 					   
			  and floating holidays.	 Optional

			  The list can be either a range of cells that contains the 					   
			  dates or an array constant of the serial numbers that 					   
			  represent the dates.	

Example
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NETWORKDAY.INTL

The NETWORKDAY.INTL function returns the number 
of whole workdays between two dates using parameters 
to indicate which and how many days are weekend 
days. Weekend days and any days that are specified as 
holidays are not considered as workdays.

Syntax

NETWORKDAYS.INTL (start_date, end_date, 
[weekend], [holidays])

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 The dates for which the difference is to be computed.	 Required

	 End_date	 The start_date can be earlier than, the same as, or later 					   
		  than the end_date.	 Required

	 Weekend	 Indicates the days of the week that are weekend days 					   
		  and are not included in the number of whole working days 					   
		  between start_date and end_date.

		  Weekend is a weekend number or string that specifies 	 Optional			 
		  when weekends occur. Look at Weekend Number - 					   
		  Weekend Days Table given below.	

	 Holidays	 An optional set of one or more dates that are to be 					   
		  excluded from the working day calendar.

		  Holidays shall be

		  •	 a range of cells that contain the dates

		  •	 an array constant of the serial values that represent	 Optional 			 
			   those dates

		  The ordering of dates or serial values in holidays can 					   
		  be arbitrary.	

Weekend Number - Weekend Days Table

	 Weekend Number	 Weekend Days

	 1 or omitted	 Saturday, Sunday

	 2	 Sunday, Monday

	 3	 Monday, Tuesday

	 4	 Tuesday, Wednesday

	 5	 Wednesday, Thursday

	 6	 Thursday, Friday

	 7	 Friday, Saturday

	 11	 Sunday only

	 12	 Monday only

	 13	 Tuesday only

	 14	 Wednesday only

	 15	 Thursday only

	 16	 Friday only

	 17	 Saturday only
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Weekend string values are seven characters long and 
each character in the string represents a day of the 
week, starting with Monday. 1 represents a non-workday 

and 0 represents a workday. Only the characters 1 and 
0 are permitted in the string. Using 1111111 will always 
return 0.

Example

NOW

The NOW function returns the serial number of the 
current date and time.

Syntax

NOW ()

Arguments

The NOW function syntax has no arguments.

Example

SECOND 

The SECOND function returns the seconds of a time 
value. The second is given as an integer in the range 0 
(zero) to 59.

Syntax

SECOND (serial_number)

Arguments

	 Argument	 Description	 Required/ Optional

	 Serial_number	 The time that contains the seconds, you want to find.
		  Times can be entered as −
		  •	 Text strings within quotation marks (E.g. “6:45 PM”)

		  •	 Decimal numbers (E.g. 0.78125, which represents 	 Required			 
			   6:45 PM)

		  •	 Results of other formulas or functions (E.g. TIMEVALUE					   
			   “6:45 PM”))	
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Example

TIME 

The TIME function returns the decimal number for a 
particular time. If the cell format was General before the 
Function was entered, the result is formatted as a date.

The decimal number returned by TIME is a value 
ranging from 0 (zero) to 0.99988426, representing the 
times from 0:00:00 (12:00:00 AM) to 23:59:59 (11:59:59 
P.M.)

Syntax

TIME (hour, minute, second)

Arguments

	 Argument	 Description	 Required/ Optional

	 Hour	 A number from 0 (zero) to 32767 representing the hour.	 Required

		  Any value greater than 23 will be divided by 24 and the					   
		  remainder will be treated as the hour value.	

	 Minute	 A number from 0 to 32767 representing the minute.	 Required

		  Any value greater than 59 will be converted to hours 					   
		  and minutes.	

	 Second	 A number from 0 to 32767 representing the second.	 Required

		  Any value greater than 59 will be converted to hours, 					   
		  minutes, and seconds.	

Example

TIMEVALUE

The TIMEVALUE function returns the decimal number 
of the time represented by a text string.

The decimal number is a value ranging from 0 (zero) 
to 0.99988426, representing the times from 0:00:00 
(12:00:00 AM) to 23:59:59 (11:59:59 P.M.).

Syntax

TIMEVALUE (time_text)
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Arguments

	 Argument	 Description	 Required/ Optional

	 Time_text	 A text string that represents a time in any one 					   
		  of the Microsoft Excel time formats.	 Required

Example

TODAY 

The TODAY function returns the serial number of the 
current date. The serial number is the date-time code 
used by Excel for date and time calculations. If the cell 
format was General before the function was entered, 
Excel changes the cell format to Date. If you want to 
view the serial number, you must change the cell format 
to General or Number.

Syntax

TODAY ()

Arguments

The TODAY Function syntax has no arguments.

Example

WEEKDAY 

The WEEKDAY function returns the day of the week 
corresponding to a date. The day is given as an integer, 
ranging from 1 (Sunday) to 7 (Saturday), by default

Syntax

WEEKDAY (serial_number, [return_type])

Arguments

	 Argument	 Description	 Required/ Optional

	 Serial_number	 A sequential number that represents the date of the day 					   
		  you are trying to find.	 Required

		  Dates should be entered by using the DATE function, 					   
		  or as results of other formulas or functions.	

	 Return_type	 A number that determines the type of return value.	 Optional

		  Look at the Return Type Table given below.	
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Return Type Table

	 Return_type	 Number Returned

	 1 or omitted	 Numbers 1 (Sunday) through 7 (Saturday). Behaves like previous versions of Microsoft Excel.

	 2	 Numbers 1 (Monday) through 7 (Sunday).

	 3	 Numbers 0 (Monday) through 6 (Sunday).

	 11	 Numbers 1 (Monday) through 7 (Sunday).

	 12	 Numbers 1 (Tuesday) through 7 (Monday).

	 13	 Numbers 1 (Wednesday) through 7 (Tuesday).

	 14	 Numbers 1 (Thursday) through 7 (Wednesday).

	 15	 Numbers 1 (Friday) through 7 (Thursday).

	 16	 Numbers 1 (Saturday) through 7 (Friday).

	 17	 Numbers 1 (Sunday) through 7 (Saturday).

Example

WEEKNUM 

The WEEKNUM function returns the week number of a 
specific date. The number represents where the week 
falls numerically within a year.

There are two systems used for this Function −

•	 System 1 − The week containing January 1 is the 
first week of the year, and is numbered week 1.

•	 System 2 − The week containing the first Thursday of 
the year is the first week of the year, and is numbered 
as week 1. This system is the methodology specified 
in ISO 8601, which is commonly known as the 
European week numbering system.

Syntax

WEEKNUM (serial_number, [return_type])

Arguments

	 Argument	 Description	 Required/ Optional

	 Serial_number	 A date within the week.

		  Dates should be entered by using the DATE function, 	 Required			 
		  or as results of other formulas or functions.

		  Problems can occur if dates are entered as text.	

	 Return_type	 A number that determines on which day the week begins.

		  The default is 1.	 Optional

		  Look at the Week_beginning Day Table given below.	
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Week_beginning Day Table

	 Return_type	 Week begins on	 System

	 1 or omitted	 Sunday	 1

	 2	 Monday	 1

	 11	 Monday	 1

	 12	 Tuesday	 1

	 13	 Wednesday	 1

	 14	 Thursday	 1

	 15	 Friday	 1

	 16	 Saturday	 1

	 17	 Sunday	 1

	 21	 Monday	 2

Example

WORKDAY  

The WORKDAY function returns a number that 
represents a date that is the indicated number of working 
days before or after a date (the starting date). Working 
days exclude weekends and any dates identified as 
holidays.

Use WORKDAY to exclude weekends or holidays when 
you calculate invoice due dates, expected delivery 
times, or the number of days of work performed.

Syntax

WORKDAY (start_date, days, [holidays])

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 A date that represents the start date.	 Required

	 Days	 The number of nonweekend and nonholiday days 					   
		  before or after start_date.

		  A positive value for days yields a future date.	 Required

		  A negative value yields a past date.	

	 Holidays	 An optional list of one or more dates to exclude from 					   
		  the working calendar, such as state and federal holidays 					   
		  and floating holidays.	 Optional

		  The list can be either a range of cells that contain the 					   
		  dates or an array constant of the serial numbers that 					   
		  represent the dates.	
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Example

WORKDAY.INTL 

The WORKDAY.INTL function returns the serial number 
of the date before or after a specified number of 
workdays with custom weekend parameters. Weekend 
parameters indicate which and how many days are 
weekend days. Weekend days and any days that are 
specified as holidays are not considered as workdays.

Syntax

WORKDAY.INTL (start_date, days, [weekend], 
[holidays])

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 The start date, truncated to integer.	 Required

	 Days	 The number of workdays before or after the start_date.

		  •	 A positive value yields a future date

		  •	 A negative value yields a past date	 Required

		  •	 A zero value yields the start_date

		  Day-offset is truncated to an integer.	

	 Weekend	 Indicates the days of the week that are weekend days 					   
		  and are not considered working days.

		  Weekend is a weekend number or string that specifies 					   
		  when weekends occur.

		  Look at Weekend-Number-Days Table given below.	 Optional

		  Weekend string values are seven characters long and 					   
		  each character in the string represents a day of the 					   
		  week, starting with Monday.

		  1 represents a non-workday and 0 represents a workday.

		  Only the characters 1 and 0 are permitted in the string.	

	 Holidays	 An optional set of one or more dates that are to be	 Optional			 
		  excluded from the working day calendar. Holidays 					   
		  shall be a range of cells that contain the dates, or an 					   
		  array constant of the serial values that represent those 					   
		  dates. The ordering of dates or serial values in holidays 					   
		  can be arbitrary.	
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Example

YEAR 

The YEAR function returns the year corresponding to 
a date. The year is returned as an integer in the range 
1900-9999.

Syntax

YEAR (serial_number)

Arguments

	 Argument	 Description	 Required/ Optional

	 Serial_number	 The date of the year you want to find. Dates should 					   
		  be entered by using the DATE function, or as results 					   
		  of other formulas or functions.	 Required

		  Problems can occur if dates are entered as text.	

Example

YEARFRAC 

The YEARFRAC function calculates the fraction of the 
year represented by the number of whole days between 
two dates (the start_date and the end_date).

Use the YEARFRAC worksheet function to identify the 
proportion of a whole year’s benefits or obligations to 
assign to a specific term.

Syntax

YEARFRAC (start_date, end_date, [basis])

Arguments

	 Argument	 Description	 Required/ Optional

	 Start_date	 A date that represents the start date.	 Required

	 End_date	 A date that represents the end date.	 Required

	 Basis	 The type of day count basis to use.

		  Look at the Day Count Basis Table given below.	 Optional
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Day Count Basis Table

	 Basis	 Day Count Basis

	 0 or omitted	 US (NASD) 30/360

	 1	 Actual/actual

	 2	 Actual/360

	 3	 Actual/365

	 4	 European 30/360

Example
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IT & ITES	 	 Exercise 1.33.126	
COPA - Data Visualization or Analysis using Excel	

Create and modify advanced charts
Objectives: At the end of this exercise you shall be able to
•	 state create a chart
•	 state modify a chart.

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

TASK 1: Create a new chart in Excel

•	 Enter the data shown below Fig 1.

•	 Create a basic column chart as shown below. If you 
do not know how to create a basic chart, then read 
the article on charts.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



127

Step 2: Now, it’s time for our charts and complex graphs 
in Excel to take beyond the basics. Select the orange 
bars representing traffic.

TASK 2: Modify a chart

Step 1: Click on change chart type as shown below
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•	 You will get the following dialog window

Step 2: Select Combo and,

1	 Click on the clustered column

2	 Select Line chart

3	 Click on OK button
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Congratulations, you just created a creative Excel chart 
with two types of charts in it.

Let’s now add a secondary axis to our chart to make it 
look more presentable.

•	 Select the chart

•	 Click on Design under chart tools and select 
change chart type

1	 Click on Secondary Axis check box under Site 
Visitors

2	 Click on OK button

Let’s now edit the chart, primary and secondary axis 
titles as shown below.
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1	 Go to Add chart elements

2	 Click on Axis titles

3	 Select primary verticals

4	 Double click on the chart title and edit the title

Write Monthly Published Articles vs Site Traffic. Your 
complete chart should now look as follows

As you can see from the above complete chart, we have 
consolidated two data sets and visualized them in such 
a way that it easily shows the effect of one data set onto 
the other using Excel graphs.
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IT & ITES	 	 Exercise 1.33.127	
COPA - Data Visualization or Analysis using Excel	

Create and modify PivotTables
Objectives: At the end of this exercise you shall be able to
•	 create and modify pivot table.

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

TASK 1: Create a pivot table 

1	 Select the cells you want to create a PivotTable from.

Note:  Your data should be organized in 
columns with a single header row.

2	 Select Insert > PivotTable.

3	 This will create a PivotTable based on an existing 
table or range.

Note: Selecting Add this data to the Data 
Model will add the table or range being used 
for this PivotTable into the workbook’s Data 
Model. Learn more.

4	 Choose where you want the PivotTable report 
to be placed. Select New Worksheet to place 
the PivotTable in a new worksheet or Existing 
Worksheet and select where you want the new 
PivotTable to appear. 

5	 Click OK.

TASK 2: PivotTables from other sources 

By clicking the down arrow on the button, you can select 
from other possible sources for your PivotTable.  In 
addition to using an existing table or range, there are 
three other sources you can select from to populate 
your PivotTable.

Note: Depending on your organization’s IT 
settings you might see your organization’s 
name included  in the button. For example, 
“From Power BI (Microsoft)”

Get from External Data Source
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Get from Data Model

Use this option if your workbook contains a Data Model, 
and you want to create a PivotTable from multiple 
Tables, enhance the PivotTable with custom measures, 
or are working with very large datasets. 

Get from Power BI

Use this option if your organization uses Power BI and 
you want to discover and connect to endorsed cloud 
datasets you have access to. 

Building out your PivotTable

1	 To add a field to your PivotTable, select the field 
name checkbox in the PivotTables Fields pane.

Note: Selected fields are added to their 
default areas: non-numeric fields are added 
to Rows, date and time hierarchies are added 
to Columns, and numeric fields are added to 
Values.

2	 To move a field from one area to another, drag the 
field to the target area.

Refreshing PivotTables

If you add new data to your PivotTable data source, any 
PivotTables that were built on that data source need to 
be refreshed. To refresh just one PivotTable you can 
right-click anywhere in the PivotTable range, then select 
Refresh. If you have multiple PivotTables, first select 
any cell in any PivotTable, then on the Ribbon go to 
PivotTable Analyze > click the arrow under the Refresh 
button and select Refresh All.

Working with PivotTable Values

Summarize Values By

By default, PivotTable fields that are placed in the Values 
area will be displayed as a SUM. If Excel interprets your 
data as text, it will be displayed as a COUNT. This is why 
it’s so important to make sure you don’t mix data types 
for value fields. You can change the default calculation 
by first clicking on the arrow to the right of the field 
name, then select the Value Field Settings option.

Next, change the calculation in the Summarize Values 
By section. Note that when you change the calculation 
method, Excel will automatically append it in the Custom 
Name section, like “Sum of FieldName”, but you can 
change it. If you click the Number Format button, you 
can change the number format for the entire field.

Tip: Since the changing the calculation in the Summarize 
Values By section will change the PivotTable field name, 
it’s best not to rename your PivotTable fields until you’re 
done setting up your PivotTable. One trick is to use Find 
& Replace (Ctrl+H) >Find what > “Sum of”, then Replace 
with > leave blank to replace everything at once instead 
of manually retyping.
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Show Values As

Instead of using a calculation to summarize the data, 
you can also display it as a percentage of a field. In the 
following example, we changed our household expense 
amounts to display as a % of Grand Total instead of the 
sum of the values.

Once you’ve opened the Value Field Setting dialog, you 
can make your selections from the Show Values As tab.

Display a value as both a calculation and percentage

Simply drag the item into the Values section twice, then 
set the Summarize Values By and Show Values As 
options for each one.
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IT & ITES	 	 Exercise 1.33.128	
COPA - Data Visualization or Analysis using Excel	

Create a Power Query, Power Query Function. Invoking the Power Query 
function and combining queries. Organize the workbook queries
Objectives: At the end of this exercise you shall be able to
•	 learn Create a Power Query, Power Query Function. Invoking the Power Query function and combining 

queries. Organize the workbook queries
•	 use Power BI for simple data visualizations.

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

The Complete Guide to Power Query

What is Power Query?

Power Query is a business intelligence tool available in 
Excel that allows you to import data from many different 
sources and then clean, transform and reshape your 
data as needed.

It allows you to set up a query once and then reuse it 
with a simple refresh. It’s also pretty powerful. Power 
Query can import and clean millions of rows into the 
data model for analysis after. The user interface is 
intuitive and well laid out so it’s really easy to pick up. 
It’s an incredibly short learning curve when compared to 
other Excel tools like formulas or VBA.

The best part about it, is you don’t need to learn or use 
any code to do any of it. The power query editor records 
all your transformations step by step and converts 
them into the M code for you, similar to how the Macro 
recorder with VBA.

If you want to edit or write your own M code, you certainly 
can, but you definitely don’t need to.

Get the data used in this post to follow along.

What Can Power Query Do?

Imagine you get a sales report in a text file from your 
system on a monthly basis that looks like this.

Every month you need to go to the folder where the file 
is uploaded and open the file and copy the contents into 
Excel.

You then use the text to column feature to split out the 
data into new columns.

The system only outputs the sales person’s ID, so 
you need to add a new column to the data and use 
a VLOOKUP to get the salesperson associated with 
each ID. Then you need to summarize the sales by 
salesperson and calculate the commission to pay out.

You also need to link the product ID to the product 
category but only the first 4 digits of the product code 
relate to the product category. You create another 
column using the LEFT function to get the first 4 digits 
of the product code, then use a VLOOKUP on this to get 
the product category. Now you can summarize the data 
by category.

Maybe it only takes an hour a month to do, but it’s pretty 
mindless work that’s not enjoyable and takes away from 
time you can actually spend analyzing the data and 
producing meaningful insight.

With Power Query, this can all be automated down to 
a click of the refresh button on a monthly basis. All you 
need to do is build the query once and reuse it, saving 
an hour of work each and every month!

Where is Power Query?

Power Query is available as an add-in to download and 
install for Excel 2010 and 2013 and will appear as a new 
tab in the ribbon labelled Power Query. In 2016 it was 
renamed to Get & Transform and appears in the Data 
tab without the need to install any add-in.
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Importing Your Data with Power Query

Importing your data with Power Query is simple. Excel 
provides many common data connections that are 
accessible from the Data tab and can be found from the 
Get Data command.

•	 Get data from a single file such as an Excel workbook, 
Text or CSV file, XML and JSON files. You can also 
import multiple files from within a given folder.

•	 Get data from various databases such as SQL 
Server, Microsoft Access, Analysis Services, SQL 
Server Analysis Server, Oracle, IBM DB2, MySQL, 
PostgreSQL, Sybase, Teradata and SAP HANA 
databases.

•	 Get data from Microsoft Azure

•	 Get data from online services like Sharepoint, 
Microsoft Exchange, Dynamics 365, Facebook and 
Salesforce.

•	 Get data from other sources like a table or range 
inside the current workbook, from the web, a 
Microsoft Query, Hadoop, OData feed, ODBC and 
OLEDB.

•	 We can merge two queries together similar to joining 
two queries in SQL.

•	 We can append a query to another query similar to a 
union of two queries in SQL.

Note: The available data connection options 
will depend on your version of Excel.

There are a couple of the more common query types 
available in the top level of the ribbon commands 
found in the Get & Transform section of the Data tab. 
From here we can easily access the From Text/CSV, 
From Web and From Table/Range queries. These are 
just duplicated outside of the Get Data command for 
convenience of use, since you’ll likely be using these 
more frequently.
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Depending on which type of data connection you 
choose, Excel will guide you through the connection set 
up and there might be several options to select during 
the process.

At the end of the setup process, you will come to the 
data preview window. You can view a preview of the 
data here to make sure it’s what you’re expecting. You 
can then load the data as is by pressing the Load button, 
or you can proceed to the query editor to apply any data 
transformation steps by pressing the Edit button.

A Simple Example of Importing Data in an Excel File

Let’s take a look at importing some data from an Excel 
workbook in action. We’re going to import an Excel file 
called Office Supply Sales Data.xlsx. It contains sales 

data on one sheet called Sales Data and customer data 
on another sheet called Customer Data. Both sheets of 
data start in cell A1 and the first row of the data contains 
column headers.
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Go to the Data tab and select the Get Data command in 
the Get & Transform Data section. Then go to From File 
and choose From Workbook.

This will open a file picker menu where you can navigate 
to the file you want to import. Select the file and press 
the Import button.

After selecting the file you want to import, the data 
preview Navigator window will open. This will give 
you a list of all the objects available to import from the 
workbook. Check the box to Select multiple items since 
we will be importing data from two different sheets. Now 
we can check both the Customer Data and Sales Data.

When you click on either of the objects in the workbook, 
you can see a preview of the data for it on the right hand 
side of the navigator window. This is great for a sense 
check to make sure you’ve got the correct file.

When you’re satisfied that you’ve got everything you 
need from the workbook, you can either press the Edit 
or Load buttons. The edit button will take you to the 
query editor where you can transform your data before 
loading it. Pressing the load button will load the data 
into tables in new sheets in the workbook.

In this simple example, we will bypass the editor and go 
straight to loading the data into Excel. Press the small 
arrow next to the Load button to access the Load To 
options. This will give you a few more loading options.

We will choose to load the data into a table in a new 
sheet, but there are several other options. You can also 
load the data directly into a pivot table or pivot chart, 
or you can avoid loading the data and just create a 
connection to the data.

Now the tables are loaded into new sheets in Excel 
and we also have two queries which can quickly be 
refreshed if the data in the original workbook is ever 
updated.
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The Query Editor

After going through the guide to connecting your data 
and selecting the Edit option, you will be presented with 
the query editor. This is where any data transformation 
steps will be created or edited. There are 6 main area in 
the editor to become familiar with.

1	 The Ribbon – The user interface for the editor is 
quite similar to Excel and uses a visual ribbon style 
command center. It organizes data transformation 
commands and other power query options into 5 
main tabs.

2	 Query List – This area lists all the queries in the 
current workbook. You can navigate to any query 
from this area to begin editing it.

3	 Data Preview – This area is where you will see a 
preview of the data with all the transformation steps 
currently applied. You can also access a lot of the 
transformation commands here either from the filter 
icons in the column headings or with a right click on 
the column heading.

4	 Formula Bar – This is where you can see and edit 
the M code of the current transformation step. Each 
transformation you make on your data is recorded 
and appears as a step in the applied steps area.

5	 Properties – This is where you can name your 
query. When you close and load the query to an 
Excel table, power query will create a table with the 
same name as its source query if the table name 
isn’t already taken. The query name is also how the 
M code will reference this query if we need to query 
it in another query.

6	 Applied Steps – This area is a chronological list of 
all the transformation steps that have been applied 
to the data. You can move through the steps here 
and view the changes in the data preview area. You 
can also delete, modify or reorder any steps in the 
query here.

The Query List

The Query List has other abilities other than just listing 
out all the current workbook’s queries.

One of the primary functions of the query list is 
navigation. There’s no need to exit the query editor to 
switch which query you’re working on. You can left click 
on any query to switch. The query you’re currently on 
will be highlighted in a light green colour.

When you do eventually exit the editor with the close 
and load button, changes in all the queries you edited 
will be saved.

You can hide the query list to create more room for the 
data preview. Left click on the small arrow in the upper 
right corner to toggle the list between hidden and visible.
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If you right click on any query in the list, there are a 
variety of options available.

•	 Copy and Paste – Copy and paste a query to make 
another copy of it.

•	 Delete – Delete the query. If you accidentally delete 
a query, there’s no undo button, but you can exit the 
query editor without saving via close and load to 
restore your query.

•	 Rename – Rename your query. This is the same as 
renaming it from the properties section on the left 
hand side of the editor.

•	 Duplicate – Make another copy of the query. This is 
the same as copy and paste but turns the process 
into one step.

•	 Move To Group – Place your queries into a folder 
like structure to keep them organised when the list 
gets large.

•	 Move Up and Move Down – Rearrange the order 
your queries appear in the list or within the folder 
groups to add to your organisational efforts. This can 
also be done by dragging and dropping the query to 
a new location.

•	 Create Function – Turn your query into a query 
function. They allow you to pass a parameter to the 
query and return results based on the parameter 
passed.

•	 Convert To Parameter – Allows you to convert 
parameters to queries or queries to parameters.

•	 Advanced Editor – Open the advanced editor to 
edit the M code for the query.

•	 Properties – Allows you to change the query name, 
add a description text and enable Fast Data Load 
option for the query.

If you right click any empty area in the query list, you 
can create a new query.

The Data Preview

The main job of the data preview area is to apply 
transformation steps to your data and show a preview 
of these steps you’re applying.

In the data preview area, you can select columns with a 
few different methods. A column will be highlighted in a 
light green colour when it’s selected.

•	 Select a single column with a left click on the column 
heading.

•	 Select multiple adjacent columns with a left click on 
the first column heading, then hold Shift and left click 
on the last column heading.

•	 Select multiple non-adjacent columns by holding Ctrl 
then left click on any column headings you want to 
select.

You can then apply any relevant data transformation 
steps on selected columns from the ribbon or certain 
steps can be accessed with a right click on the column 
heading. Commands that are not available to your 
selected column or columns will appear grayed out in 
the ribbon.
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Each column has a data type icon on the left hand of the 
column heading. You can left click on it to change the 
data type of the column.

You can choose from decimal numbers, currency, whole 
numbers, percentages, date and time, dates, times, 
timezone, duration, text, Boolean, and binary.

Using the Locale option allows you to set the data type 
format using the convention from different locations. 
For example, if you wanted to display the date in the 
American m/d/yyyy format instead of the usual dd/mm/
yyyy then you could select United States as the locale.

There’s a small table icon in the top left hand corner of 
the data preview, you can right click or left click this to 
access various actions that affect the whole table.

Renaming any column heading is really easy. Double 
left click on any column heading then type your new 
name and press Enter when you’re done.

You can change around the order of any of the columns 
with a left click and drag action. The green border 
between two columns will become the new location of 
the dragged column when you release the left click.

Each column also has a filter toggle on right hand side. 
Left click on this to sort and filter your data. This filter 
menu is very similar to the filters found in a regular 
spreadsheet and will work the same way.

The list of items shown is based on a sample of the data 
so may not contain all available items in the data. You 
can load more by clicking on the Load more text in blue.

Many transformations found in the ribbon menu are 
also accessible from the data preview area using a right 
click on the column heading. Some of the action you 
select from this right click menu will replace the current 
column. If you want to create a new column based, use 
a command from the Add Column tab instead.

The Applied Steps

Any transformation you make to your data will appear 
as a step in the Applied Steps area. It also allows you to 
navigate through your query. Left click on any step and 
the data preview will update to show all transformations 
up to and including that step.
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You can insert new steps into the query at any point 
by selecting the previous step and then creating the 
transformation in the data preview. Power Query will 
then ask if you want to insert this new step. Careful 
though, as this may break the following steps that refer 
to something you changed.

You can delete any steps that were applied using the 
X on the left hand side of the step name in the Applied 
Steps area. Caution is needed though, as if any of the 
following steps depend on the step you’re trying delete, 
you will break your query. This is where Delete Until End 
from the right click menu can be handy.

A lot of transformation steps available in power query 
will have various user input parameters and other 
setting associated with them. If you apply a filter on the 
product column to show all items not starting with Pen, 
you might later decide you need to change this filter 
step to show all items not equal to Pen. You can make 
these edits from the Applied Step area.

Some of the steps will have a small gear icon on the 
right hand side. This allows you to edit the inputs and 
settings of that step.

You can rearrange the order the steps are performed 
in your query. Just left click on any step and drag it to 
a new location. A green line between steps will indicate 
the new location. This is another one you’ll need to be 
careful with as a lot of steps will depend on previous 
steps, and changing ordering can create errors because 
of this.

Right click on any step to access a menu of options.

•	 Edit Settings – This allows you to edit the settings 
of the step similar to using the gear icon on the right 
hand side of the step.

•	 Rename – This allows you to rename the steps 
label. Instead of the displaying the generic name 
like “Filtered Rows“, you could have this display 
something like “Filtered Product Rows on Pens” so 
you can easily identify what the step is doing.

•	 Delete – This deletes the current step similar to the 
X on the left hand side of the step.

•	 Delete Until End – This allows you to delete the 
current step plus all steps up until the end. Since 
steps can depend on previous steps, deleting all 
steps after a step is a good way to avoid any errors.
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•	 Insert Step After – This allows you to insert a new 
step after the current step.

•	 Move Up and Move Down – This allows you to 
rearrange the query steps similar to the dragging 
and dropping method.

•	 Extract Previous – This can be a really useful option. 
It allows you to create a new copy of the query up to 
the selected step.

The Formula Bar

When you click on different steps of the transformation 
process in the Applied Steps area, the formula bar 
updates to show the M code that was created for that 

step. If the M code generated is longer than the formula 
bar, you can expand the formula bar using the arrow 
toggle on the right hand side.

You can edit the M code for a step directly from the 
formula bar without the need to open the advanced 
editor. In this example, we’ve changed our filter from 
“Pen” to “Chair” by typing in the formula bar and then 
pressing Enter or using the check mark on the left to 
confirm the change. Press Esc or use the X on the left 
to discard any changes.

The File Tab

The File tab contains various options for saving any 
changes made to your queries as well as power query 
options and settings.

•	 Close & Load – This will save your queries and 
load your current query into an Excel table in the 
workbook.

•	 Close & Load To – This will open the Import Data 
menu with various data loading options to choose 
from.

•	 Discard & Close – This will discard any changes 
you made to the queries during your session in the 
editor and close the editor.

Note, you will still need to save the workbook 
in the regular way to keep any changes to 
queries if you close the workbook.

Close & Load and Close & Load To commands are also 
available from the Home tab.

Data Loading Options

When you use the Close & Load To option to exit the 
editor, this will open the Import Data menu.
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You can choose to load the query to a table, pivot table, 
pivot chart or only create a connection for the query. 
The connection only option will mean there is no data 
output to the workbook, but you can still use this query 
in other queries. This is a good option if the query is an 
intermediate step in a data transformation process.

You’ll also be able to select the location to load to in 
your workbook if you selected either a table, pivot table 
or pivot chart in the previous section. You can choose 
a cell in an existing worksheet or load it to a new sheet 
that Excel will create for you automatically.

The other option you get is the Add this data to the 
Data Model. This will allow you to use the data output in 
Power Pivot and use other Data Model functionality like 
building relationships between tables. The Data Model 
Excel’s new efficient way of storing and using large 
amounts of data.

The Queries & Connections Window

When you’re working outside of the power query editor, 
you can see and interact with all the queries in the 
workbook through the Queries & Connections window. 
To open this, go to the Data tab in the regular Excel 
ribbon, then press the Queries & Connections command 
button found in the Queries & Connections section.

When opened it will be docked to the right hand side of 
the workbook. You can undock it by left clicking on the 
title and dragging it. You can drag it to the left hand side 
and dock it there or leave it floating. You can also resize 
the window by left clicking and dragging the edges.

This is very similar to the query list in the editor and you 
can perform a lot of the same actions with a right click 
on any query.

One option worth noting that’s not in the query list right 
click menu, is the Load To option. This will allow you 
to change the loading option for any query, so you can 
change any Connection only queries to load to an Excel 
table in the workbook.
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Another thing worth noting is when you hover over a 
query with the mouse cursor, Excel will generate a Peek 
Data Preview. This will show you some basic information 
about the query.

•	 Data Preview – This is a live preview of the data 
similar to when first setting up a query.

•	 Columns – This will give you a list of all the columns 
contained in the final results of the query along with 
a count of how many columns there are. Clicking 
on any of them will highlight the column in the data 
preview.

•	 Last Refreshed – This will tell you when the data 
was last refreshed.

•	 Load Status – This displays whether the data 
is loaded to a table, pivot table, pivot chart or is a 
connection only.

•	 Data Sources – This will show you the source of 
the data along with a count of the number of files if 
you’re it’s a from folder query.

•	 View in Worksheet – Clicking on this will take you to 
the output table if the query is loaded to a table, pivot 
table or pivot chart.

You can also access this Peek view by right clicking on 
the query and selecting Show the peek.
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There are also some useful messages displayed in the 
Queries & Connections window for each query. It will 
show you if the query is a connection only, if there were 
any errors when the query last ran, or how many rows 
loaded.

The Home Tab

The Home tab contains all the actions, transformations, 
and settings that will affect the whole table.

1	 Close – You can access the Close & Load and 
Close & Load To options from here. These are also 
available in the File tab menu.

2	 Query – You can refresh the data preview for the 
current query or all query connections. You can also 
open the properties settings and the advanced editor 
for the current query and there are options under the 
Manage button to delete, duplicate or reference the 
current query.

3	 Manage Columns – You can navigate to specific 
columns and choose to keep or remove columns.

4	 Reduce Rows – You can manage the rows of data 
from this section. There are lots of options to either 
keep certain rows or remove certain rows. Keep 
or remove the top N rows, the bottom N rows, a 
particular range of rows, alternating rows, duplicate 
rows or rows with errors. One option only available 
for removing rows is to remove blank rows.

5	 Sort – You can sort any column in either ascending 
or descending order.

6	 Transform – This section contains a mix of useful 
transformation options.

•	 Split Columns – This allows you to split the data 
in a column based on a delimiter or character 
length.

•	 Group By – This allows you to group and 
summarize your data similar to a Group By in 
SQL.

•	 Data Type – This allows you to change the data 
type of any column.

•	 Use First Row as Headers – This allows you to 
promote the first row of data to column headings 
or demote the column headings to a row of data.

•	 Replace Values – This allows you to find and 
replace any value from a column.

7	 Combine – This sections contains all the commands 
for joining your query to with other queries. You 
can merge, append queries or combine files when 
working with a from folder query.

8	 Parameters – Power Query allows you to create 
parameters for your queries. For example when 
setting up a from folder query, you may want the 
folder path to be a parameter as so you can easily 
change the location. You can create and manage 
existing parameters from this section.

9	 Data Sources – This section contains the data 
source settings including permissions management 
for any data sources that require passwords to 
access.

10	New Query – You can create new queries from new 
data sources or previously used data sources from 
this section.
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IT & ITES	 	 Exercise 1.33.129	
COPA - Data Visualization or Analysis using Excel	

Use Power BI for simple data visualizations
Objectives: At the end of this exercise you shall be able to
•	 details power BI for simple data visualizations.

Requirements

Tools/Equipment/Machines

•	 A working PC with MS-OFFICE	 - 1 No.

PROCEDURE

Use power BI for simple data visualizations

Visualizations are used to effectively present your 
data and are the basic building blocks of any Business 
Intelligence tool. Power BI contains various default 
data visualization components that include simple bar 

charts to pie charts to maps, and also complex models 
such as waterfalls, funnels, gauges, and many other 
components.

In Power BI, you can create visualization in two ways. 
First is by adding from the right side pane to Report 
Canvas. By default, it is the table type visualization, 
which is selected in Power BI. Another way is to drag 

the fields from right side bar to the axis and value axis 
under Visualization. You can add multiple fields to each 
axis as per the requirement.
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In Power BI, it is also possible to move your visualization 
on the reporting canvas by clicking and then dragging 
it. You can also switch between different type of charts 
and visualizations from the Visualization pane. Power 
BI attempts to convert your selected fields to the new 
visual type as closely as possible.

Creating Map Visualizations

In Power BI, we have two types of map visualization - 
bubble maps and shape maps. If you want to create a 
bubble map, select the map option from the visualization 
pane.

To use a bubble map, drag the map from Visualizations 
to the Report Canvas. To display values, you have to 
add any location object to the axis.
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In the value fields, you can see that it accepts values 
axis such as City and State and or you can also add 
longitude and latitude values. To change the bubble 
size, you need to add a field to the value axis.

You can also use a filled map in data visualization, just 
by dragging the filled map to the Report Canvas.

Note − If you see a warning symbol on top of your 
map visualization, it means that you need to add more 
locations to your map chart.

Using Combination Charts

In data visualization, it is also required to plot multiple 
measures in a single chart. Power BI supports various 
combination chart types to plot measure values. Let 

us say you want to plot revenue and unit_solds in one 
chart. Combination charts are the most suitable option 
for these kind of requirement.

One of the most common Combination chart in Power 
BI is Line and Stacked column charts. Let us say we 
have a revenue field and we have added a new data 
source that contains customer-wise unit quantity and 
we want to plot this in our visualization.

Once you add a data source, it will be added to the list of 
fields on the right side. You can add units to the column 
axis as shown in the following screenshot.

You have other type of combine chart that you can use 
in Power BI - Line and Clustered Column.
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Using Tables

In Power BI, when you add a dataset to your visualization, 
it adds a table chart to the Report canvas. You can drag 
the fields that you want to add to the report. You can 

also select the checkbox in front of each field to add 
those to the Report area.

With the numerical values in a table, you can see a sum 
of values at the bottom.
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You can also perform a sort in the table using an arrow 
key at the top of the column. To perform ascending/
descending sort, just click the arrow mark, and the 
values in the column will be sorted.

The order of the columns in a table is determined by the 
order in the value bucket on the right side. If you want to 
change the order, you can delete any column and add 
the other one.

You can also undo summarize or apply different 
aggregate function on numerical values in the table. 
To change the aggregation type, click the arrow in the 
value bucket in front of the measure and you will see a 
list of formulas that can be used.
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Another table type in Power BI is the matrix table that 
provides a lot of features such as auto sizing, column 
tables, and setting colors, etc.

Modify Colors in Charts

In Power BI, you can also modify the colors in the chart. 
When you select any visualization, it has an option to 
change the color. Following options are available under 
the Format tab −

•	 Legend

•	 Data Colors

•	 Detail Label

•	 Title

•	 Background

•	 Lock Aspect

•	 Border

•	 General

To open these options, go to the Format tab as shown 
in the following screenshot. Once you click, you can see 
all the options available.
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When you expand the Legend field, you have an option 
where you want to display the legend. You can select −

•	 Position

•	 Title

•	 Legend Name

•	 Color

•	 Text Size

•	 Font Family

Similarly, you have data colors. In case, you want to 
change the color of any data field, you can use this 

option. It shows all objects and their corresponding 
colors in the chart.
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You also have Analytics feature in the tool, where you 
can draw lines as per requirement in data visualization. 
You have the following line types in data visualization −

•	 Constant Line

•	 Min Line

•	 Max Line

•	 Average Line

•	 Median Line

•	 Percentile Line

You can opt for a dashed, dotted, or a solid line. You can 
select Transparency level, color, and position of the line. 
You can also switch on/off data label for this line.

Adding Shapes, Images and Text box

Sometimes it is required that you need to add static 
text, images, or shapes to your visualization. In case 
you want to add header/footer or any static signatures, 
messages to data visualization this option can be used.

You can also add URLs in the text box and Power BI 
uses those link to make it live.

To add shapes, images and text box, navigate to the 
Home tab and at the top you will find an option to add 
images.
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You can insert different shapes in data visualization. To 
see the available shapes, click the arrow next to the 
Shapes button.

When you click on the text box, it adds a text box in your 
Report canvas. You can enter any text in the text box 
and use the rich text editor to make formatting changes.

Similarly, images can be added to data visualization to 
add logos or other images to data visualization. When 
you click the Image option, it asks for a path to pass the 
image file.

You can add shapes by selecting any shape from the 
dropdown list. You can also resize it using different 
options.
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Styling Reports

In Power BI, you have flexible options to adjust the page 
layout and formatting such as orientation and page size 
of your report. Navigate to Page View menu from the 
Home tab and the following options are provided.

•	 Fit to Page

•	 Fit to Width

•	 Actual Size

By default, the page size in a report is 16:9; however, it 
is also possible to change the page size of the report. 
To change the page size, navigate to the Visualization 
pane and select Paint brush.

Note − To change page size, no visualization should 
be added to the Report canvas. You have the following 
options available under Page layout −

•	 Page Information

•	 Page Size

•	 Page Background

Under Page Information, you have Name and Q&A.

Under Page Size, you can select from the following 
options −

•	 Type

•	 Width

•	 Height

Under Page Background, you can select from the 
following options:

•	 Color

•	 Transparency

•	 Add Image
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Duplicating Reports

In some scenarios, you may want to use the same 
layout and visuals for different pages. Power BI provides 
an option to create a copy of the page. When you use 
Duplicate Page option, a new page is added with similar 
layout and visuals.

To duplicate a page, right-click the Page and select 
Duplicate Page option. This will create a copy of the 
same page with the name - Duplicate of Page1.

Now, if you want to rename an existing page or delete a 
page, you can use other options as shown in the above 
screenshot.

For those who are new to dashboards, it would be 
ideal to get an understanding of the dashboards first. 
In this chapter, you will get to know the definition of 
dashboard, how it got its name, how they became 
popular in IT, key metrics, benefits of dashboards, types 
of dashboards, dashboard data and formats and live 
data on dashboards.

In information technology, a dashboard is an easy 
to read, often single page, real-time user interface, 
showing a graphical presentation of the current status 
(snapshot) and historical trends of an organization’s 
or department’s key performance indicators to enable 
instantaneous and informed.

Decisions to be made at a glance

Dashboards take their name from automobile 
dashboards. Under the hood of your vehicle, there may 
be hundreds of processes that impact the performance 
of your vehicle. Your dashboard summarizes these 
events using visualizations so that you have the peace 
of mind to concentrate on safely operating your vehicle. 
In a similar way, business dashboards are used to view 
and/or monitor the organization’s performance with 
ease.
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The idea of digital dashboards emerged from the study 
of decision support systems in the 1970s. Business 
dashboards were first developed in the 1980s, but due 
to the problems with data refreshing and handling, they 
were put on the shelf. In the 1990s, the information 
age quickened pace and data warehousing, and online 
analytical processing (OLAP) allowed dashboards to 
function adequately. However, the use of dashboards 
did not become popular until the rise of key performance 
indicators (KPIs), and the introduction of Robert S. 

Kaplan and David P. Norton’s Balanced Scorecard. 
Today, the use of dashboards forms an important part 
of decision making.

In today’s business environment, the tendency is 
towards Big Data. Managing and extracting real value 
from all that data is the key for modern business 
success. A well-designed dashboard is a remarkable 
information management tool.
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IT & ITES                                                                                          Exercise 1.34.130
COPA - Browse E-Commerce Sites to Identify Products & Services

Demonstrate E-Commerce sites
Objectives: At the end of this exercise you shall be able to
• demonstrate the e-commerce sites.

PROCEDURE

6 Real Estate

https://www.99acres.com/

https://www.nobroker.in/

7 Job

https://www.naukri.com/

https://www.linkedin.com/

8 Banking

https://www.axisbank.com/

https://www.icicibank.com/

9 Pharmacy

https://www.1mg.com/

https://pharmeasy.in/

10 Local Information Search

https://www.justdial.com/

https://www.whitepages.com/

11 Education

https://byjus.com/

https://unacademy.com/

Browser the following e-Commerce sites to identify
products & services in different sectors

1 Product Buying & Selling

https://www.amazon.in/

https://www.flipkart.com/

https://www.olx.in/

https://www.cars24.com/

2 Transports

https://www.irctc.co.in/nget/train-search

https://www.uber.com/in/en/ride/

https://www.olacabs.com/

3 Entertainment

https://in.bookmyshow.com/

https://www.ticketnew.com/

4 Food

https://www.swiggy.com/

https://www.zomato.com/

5 Travel and Tourism

https://www.makemytrip.com/

https://www.cleartrip.com/

Sl.No. Name of the site Purpose of the site
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PROCEDURE

TASK 1 : Browse and observe  features of ebay

Items Placement On Click

Name of the Site / Logo

Products Catalogue

Offers

User Login

Seller Login

Terms & Conditions

Fig 1

IT & ITES                                                                                          Exercise 1.34.131
COPA - Browse E-Commerce Sites to Identify Products & Services

List features of e-commerce sites
Objectives : At the end of this exercise you shall be able to
• browse and observe features of ebay
• browse and observe Amazon website
• browse and listout the Flipkart
• browse and listout the OLX
• browse and listout QuickR
• compare websites and features on the following table basis by tick marks.

1 Open web browser for accessing web page.

2 Type in the address bar as “http://www.ebay.in” as in
Fig 1

3 Note down the features listed in the following table from
the main window.
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Items Placement On Click

Name of the Site / Logo

Products Catalogue

Offers

User Login

Seller Login

Terms & Conditions

TASK 3 : Browse features of Flipkart

1 Open web browser for accessing web page.

2 Type in the address bar as “http://www.flipkart.com”
as in Fig.3

3 Note down the features listed in the following table
from the main window.

Fig 2

Fig 3

TASK 2 : Browse features of Amazon

1 Open web browser for accessing web page.

2 Type in the address bar as “http://www.amazon.in”
as in Fig.2

3 Note down the features listed in the following table from
the main window.
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Items Placement On Click

Name of the Site / Logo

Products Catalogue

Offers

User Login

Seller Login

Terms & Conditions

TASK 4 : Browse features of OLX

1 Open web browser for accessing web page.

2 Type in the address bar as “http://www.olx.in” as in
Fig.4

3 Note down the features listed in the following table from
the main window.

Items Placement On Click

Name of the Site / Logo

Products Catalogue

Offers

User Login

Seller Login

Terms & Conditions

Fig 4
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Items Placement On Click

Name of the Site / Logo

Products Catalogue

Offers

User Login

Seller Login

Terms & Conditions

Sl.No. Site Name Buy Sell     Used     Return\    COD     Feedback         Offers    Update
          Goods    Refund          Email

1 Ebay

2 Amazon

3 Flipkart

4 OLX

5 QuickR

Fig 5

TASK 6 : Compare websites and features on the following table basis by tick marks

TASK 5 : Browse features of QuickR

1 Open web browser for accessing web page.

2 Type in the address bar as “http://www.quickr.com” as
in Fig.5

3 Note down the features listed in the following table from
the main window.

Note : This chart compares facilities available
for users in various E-Commerce websites,
which increases the usability of services of the
particular site.  More facilities, more visitors,
which makes continuous sale over E-
Commerce sites.
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IT & ITES                                                                                          Exercise 1.34.132
COPA - Browse E-Commerce Sites to Identify Products & Services

Use e-commerce sites to source an item
Objectives: At the end of this exercise you shall be able to
• buying a Desired Product on Amazon.

Process of Source an Items from E-Commerce Sites:

1 Sign in to your E-Commerce Sites account.

2 Hover over Departments and click on a category. When you find an item you want, click on it.

3 Review the item, and click Add to Cart.

4 Click Proceed to Checkout.

5 Enter a shipping address and click Continue.

6 Choose a payment method and click Continue.

7 Click Place Your Order

TASK 1: Buying a Desired Product on Amazon

1 Sign into your Amazon account.

Go to www.amazon.com in your web browser and log in.
To do this, move your mouse over "Hello, Sign In" and
click Sign In. Then click in the boxes highlighted in the

right screenshot below and type in your email address
and account password, respectively.  Finally, click Sign In
Using Our Secure Server.

2 Search through departments.

Let's you're looking for a new toaster.

Let's start by moving the mouse over Departments, then
Home, Garden, and Tools, and then clicking Kitchen and
Dining.

PROCEDURE
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3 Find a specific category.

Now, let's click on Ovens and Toasters, and then click
Toasters, just to narrow things down a bit more.
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4 View and select an item.

You'll now see a list of toasters available for sale.

Across the left-hand side of the screen, you'll see a series
of options that you can click to narrow down your search
even more.  For example, you can look for a product:

• in a certain colour

• from a certain company or brand

• based on how well it has been reviewed by Amazon
customers

• within a certain price range

• based on who is selling it

The product information itself will show you, among other
things:

• what the product looks like, and if there are any
variations that you can look at

• what the product is called

• its price when you buy it (and if you save anything off
retail price)

• when you can expect to get it, or how many are left in
stock

• what other customers are saying about the product

When you find a product that you like, click on its name.

5 Add the item to your cart.

If you've decided that it's what you want, click the drop-
down menu marked "QTY" to select how many of this
product you want. Then click Add to Cart.

6 Proceed to the Amazon checkout.

If this is the only thing you want to buy, click Proceed to
Checkout.
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7 Enter a shipping address.

You'll now have to pick an address to send your delivery
to. If you don't have one, you'll have to create a new one.

Click in each of the boxes or drop-down menus underneath
"Enter A New Shipping Address" and type in or select:

• your full name

• your street address

• your unit address (if you live in an apartment, condo,
etc.)

• the city in which you live

• the state, province, or region in which you live

• your mailing code (doesn't have to be a U.S. Z.I.P. code)

• the country in which you live

• your phone number

There are additional options underneath "Optional Delivery
Preferences", where you can:

• choose whether or not you're available on weekends to
receive delivered packages

• provide Amazon with the access code to your apartment
complex or gated community (if you're allowed) so a
delivery person can get in

• choose whether or not the address your items will be
shipped to is the same one that you want your bill to
come to

When you've entered all of your information, click Continue
to move on.

8 View and confirm your order summary.

On the left, you'll see your order summary.  On the right,
you'll be asked to select what kind of shipping you want (if
applicable).  Click the button next to the type you want.
Usually, the faster the shipping speed, the more it will
cost you. When you're done, click Continue.
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9 Choose a payment method.

You'll now have to select a method of paying for your
purchase.

Add Debit / Credit Card:
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For the purposes of this tutorial, we'll assume that you
want to pay by using a credit card.  To add a new credit
card:

• Scroll down to the section that says "Credit or Debit
Cards."

• Click in the box that says "Name on Card" and type in
your name as it appears on your credit card.

• Click in the box that says "Card Number" and type in
your credit card number (with no spaces).

• Click the two drop-down menus labelled "Expiration
Date" to select the month and year that your credit
card expires.

• Click Add Your Card to add this credit card as a payment
option.

When you're done, this credit card will automatically be
selected as a payment option, so you can just click
Continue.

10 Confirm and place your order.

On the next screen, you can review your order and make
any final changes, including the type of shipping you want.
If you're happy with what you have, click Place Your Order.

You'll receive a confirmation receipt via email.  Now all
that's left to do is to wait for your item to arrive!
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IT & ITES                                                                                          Exercise 1.34.133
COPA - Browse E-Commerce Sites to Identify Products & Services

Undertake transactions on an e-commerce site
Objectives: At the end of this exercise you shall be able to
• details the accepted payment methods.

PROCEDURE

Accepted Payment Methods

Payments on e-commerce site can be made using certain
types of credit and debit cards.

As per the new RBI guidelines, from 30th September 2022
onwards, only card networks (VISA/Mastercard etc.) and/
or issuing banks can store credit/debit card details. You
will not be able to see saved cards starting 1st October
2022 unless you provide consent to Amazon for card
tokenization.

The following payment methods are available for
you to make payment:

• Pay on delivery

• Credit/Debit card

• Net Banking

• Unified Payment Interface (UPI)

• Easy Monthly Installments (EMI).

The following cards issued in India can be used:

• Credit Cards: Visa, Mastercard, American Express,
Diners Club, and RuPay

• Debit Cards: Visa, Mastercard, RuPay, and Maestro

Refer : Ex.1.34.132 Step 9. Use e-commerce
sites to source an item  for payment method
and Option.
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IT & ITES                                                                                          Exercise 1.34.134
COPA - Browse E-Commerce Sites to Identify Products & Services

Add product to an e-commerce website
Objectives : At the end of this exercise you shall be able to
• sell a product in OLX.in website.

PROCEDURE

TASK 1 : Sell a product in OLX.in website

1 Open the website in a browser http://www.olx.in
(Fig 1)

Fig 1

2 Click on Submit a free Ad to post a classified
advertisement (Fig 2)

Fig 2

3 Add a title to the ad, say Laptop Headphone and select
category, say ‘Accessories-Mobile’ as in Fig 3.

5 Put price for the product.

Fig 3

Fig 4

6 Write a description to match the product like ‘Best
sound quality with rich bass compatible with laptop
and mobile’ as in Fig 4.
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Fig 5

7 Upload view of product photographs (5 views of photos
will attract more) (Fig 5).

8 Enter seller name, Phone number and City and press
Submit to complete. (Fig 6).

9 Re-enter OTP if required to activate the advertisement.

Fig 6

Note : Posted ad will be active upto a standard
time frame i.e. 15 days minimum, then renewal
may be required.
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IT & ITES                                                                                          Exercise 1.34.135&136
COPA - Browse E-Commerce Sites to Identify Products & Services

Practice order & payment processing
Objectives : At the end of this exercise you shall be able to
• login and buy a desired product.

PROCEDURE

TASK 1 : Login and buy a desired product

1 Login to the created account as in Fig 1.

Fig 1

2 View the deals in Today’s deals tab, it is matches to
buy.

3 Enter the item required to buy in the “search” tab at
the top of the site as in Fig 2.

Fig 2

4 Select on “ Sort by “ to get the order of the product list
as to price low to high or new & popular, etc.

5 Select the product that matches the requirement.
(Fig 3)

Fig 3

Fig 4

6 Click on the product desired to get detailed view of the
product as in Fig 4.

7 Click on “Buy now” to finish selection and purchase or
“Add to Cart” to continue for more items to buy. (Assume
here, it is Buy Now to complete the order) (Fig 5).

8 Enter the password if asked.
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Fig 5

9 Enter details of shipping address on the page. (Fig 6).

Fig 6

10 Select the payment method from available options.
(Fig 7)

Note : Use a Debit card which requires an OTP
to complete payment or COD if available which
allows to pay at the time of delivery

11 Complete the order and get a Track-order to know the
current status of order in future.

Fig 7
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IT & ITES                                                                                          Exercise 1.34.137
COPA - Browse E-Commerce Sites to Identify Products & Services

Identify common security issues
Objectives : At the end of this exercise you shall be able to
•  secure personal information sharing
• secure payment operations online.

PROCEDURE

TASK 1 : Secure personal information sharing

The following table ensures for a secure E-commerce
practice

a Never public internet / WiFi for online purchases

b Never forget to LOGOUT to secure the account associated

c Never save a Debit Card / Banking details with password or PIN in any
website as it can easily be hacked

d Never use a legible / assumable password

e Prefer Cash on Delivery option to avoid online payment threats

f Never share personal / confidential information to Login in any website

TASK 2 : Secure payments operation online

The following points make payments online to be
secure.

a Ensure the payment gateway is PCI compliant by clicking the Payment Gateway’s Terms and
Conditions page

b Confirm, the payment transactions are encrypted, as encrypted data is securedof transfer time from
hacking

c Use always a transaction that requires a PIN and / or OTP to be received in mobile as without this
authentication, the amount will not be transferred

d Use E-Wallets to pay as there is no need to disclose banking or card details always and the amount
in the wallet only is spent securely.

Sl.No. Security Uses Cause

Note: Discus with instructor an list the common
security uses.
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IT & ITES  Exercise 1.35.138
COPA - Protect  Information, Computers and Networks from Viruses,
Spyware and other Malicious Code

Provide firewall security for internet connection and network system
Objectives : At the end of this lesson you shall be able to
• enable or disable firewall settings of windows 10
• protect system using windows defender.

PROCEDURE

TASK 1 : Enable or disable firewall settings of windows 10

1 Access Windows firewall using Win Key → Settings
→ Network & Internet as in Fig 1.

2 Select Windows firewall in the available options to open
Windows - Defender security center as in Fig.2

Fig 2

3 Make sure the “Firewall” is ON state for Domain
Network, Private Network and Public Network as in
Fig.3

Note : The (active) state defines the current
available network.

4 Reset the firewall to default by clicking “Restore firewalls
to default” as in Fig 4.

Fig 1

Fig 4

5 Click on any network and in the next window, set
Windows Defender firewall status to OFF to disable
firewall.

Note : Don’t disable firewall unless it is
specifically required.

Fig 3

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



176

TASK 2 : Protect system using Windows Defender

1 Click on the Virus & Threat protection option in the left
panel as in Fig 5.

2 Click “Scan Now” on the Threat History to scan files.
Alternatively Run a new advanced scan runs for cleaning
latest threat types as in Fig 6.

3 Run any action that is pending (or) required by settings
or updates, to make the  protection system up to date
as in Fig 7.

Fig 6

Fig 5

Fig 7

Protect the Computer against various Internet Threats
Objectives : At the end of this lesson you shall be able to
• identify common internet threats
• secure risks protected internet systems.

TASK 1: Identify common internet threats

Threat Type Functions

Botnet Spam mails with virus attachments a robots in net

Hacking Unauthorized access and steal information from system

Malware Damage data from system and fake alert of infections

Pharming Misleading to cloned / illegitimate websites

Phishing Tricky gather of information from users about Credit Cards

Ransomware Lock system / drives demand money to remove

Spam Junk mail to get info directly from users

Spoofing Sends spam mail and clone a legal site information

Spyware Steal contact information, username and passwords with
Popups

Trojen Horses Delete files, hack system info and user operations

Worms Spread unwanted files and dump the memory as well as disk
space

Viruses Delays startup time and make unwanted hidden file execution,
hide files /folders
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Methods Protection System              Status

Passwords Complicated passwords reduce the method of Created  | Not Created
accessing to user info easily

Anti-Virus Software that protect system from threats Installed  |  Not Installed

Firewall Enabling this protects attacks from third party / Enabled  |  Not Enabled
external systems

Browser settings Updated browser with protected plug-ins Installed  | Not Installed
make safe browsing

OS Updates Updating the Operating System makes patches Updated  | Not updated
to existing less secured modules to be more safe

WiFi Security Protect personal WiFi with SSID and passwords Done  |  Not Done
and avoid public WiFi for safety based transactions

Download security Avoid unwanted downloads and ensure only the Enabled  |  Not Enabled
relevant files are downloaded.  Allow Anti- virus/
Defender to scan for threats  in downloaded files

TASK 2 : Checklist to safeguard systems from threats

1 Find the methods to protect systems and safe
operations from the following table and choose Yes/
No to determine whether the system is protected.

Note : Make all the above tasks completed to
protect the system from any type of threats.

Secure WiFi networks and access controls
Objectives : At the end of this lesson you shall be able to
• configure a secure WLAN
• filter access using MAC Address
• create user accounts with limited rights.

TASK 1 : Configure a secure WLAN

1 Connect the internet port of the router with the incoming
internet connector as in Figures 1.

Fig 1

Note : In case of leased line, it will be a RJ45
connector and in case of Broadband / DSL it
will be a phoneline.

2 Connect LAN cable with port 1 of the modem and the
other end to the LAN connection of the system.
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3 Run command prompt and type ‘ipconfig’ and press
Enter, which will bring a list of available options as in
Fig 2.

Fig 3

Fig 2

4 Find the default gateway (say eg. 192.168.0.1) and
access it using internet browser as in Fig 3.

5 Type the username and password provided with modem
to login to access the configuration settings of the
modem and enter into configuration settings.

6 Click Network tab and in WAN settings, select the IP
mode or PPPoE mode suitable to access network and
provide the given username and password for accessing
(internet) as in Fig 4.

7 Select the list of Bound Ports including wireless ports
and Apply.

8 Select WLAN / Wireless tab, set the following items
as in Fig 5.

Fig 4

Fig 5

a SSID : <Name of the WiFi network>

Enable it for others to access.

Broadcast is enabled as it should be detected by
other devices.

b In WLAN security option select the following :

Encryption Mode : WPA-PSK;
WPA2-PSK

Encryption Mode2 : TKIP-AES

WPA Preferred Key Format : Password

WPA Pre-shared key : <set here a
password to
access WiFi>

Note : The above settings make the WLAN to
be accessed using the SSID and upon
accessing, password to be provided to connect.
Screenshots may vary according to the modem
/ router using for connecting but settings will
be there.
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TASK 2 : Filter access using Mac address

1 Open the web browser and address in the address bar
(default is http://192.168.0.1 or http://192.168.1.1).
Press Enter as in Fig 6.

Fig 6

2 Go to IP & MAC Binding->ARP List page, find the MAC
address of the all the devices which are connected to
the router as in Fig 7.

Fig 7

3 Go to Wireless->Wireless MAC Filtering page, click
the Add New button as in Fig 8.

4 Type in the MAC address you want to allow or deny to
access the router, and give a description for this item
as in Fig 9.

5 Choose Enable and Allow/Deny the Wireless MAC
Filtering function about the Filtering Rules as in
Fig 10.

Note : Allow enables the accessing of Mac
address into this connection and Deny
disallows to connect into.

Fig 8

Fig 9

Fig 10
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TASK 3 : Create individual user accounts

1 Goto Control Panel and select User Accounts as in
Fig 11.

Fig 11

2 Click Manage another account option to enter into Users
list option as in Fig 12.

Fig 12

3 Click on Add a new user to create a new windows
user as in Fig 13.

Fig 13

4 Click on Add someone else to the PC to add a new
user as in Fig 14.

Fig 14

5 Skip the email option in the next window by click as in
Fig 15 and click NEXT.

Fig 15

6 Click Add user without Microsoft Account to proceed a
custom named user as in Fig 16.

Fig 16
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7 Type the username and password with three security
questions with answer for creating a new account as
in Fig 17.

Fig 17

8 Complete the user creation and the user will be
available for login as in Fig 18.

Fig 18

9 Click on the user name to change user type as Local
user / Administrator and for adding new users, repeat
same steps and get cleared with instructor.

Make backup copies of important file, data and information
Objectives : At the end of this lesson you shall be able to
• take backup of files using  External hard drive
• backup files using Google Drive
• make a local restoration point and restore on failure / malfunction.

TASK 1 : Backup of files using external hard drive

1 Insert USB connector to access the external hard drive
as in Fig.1

Fig 1

Note : Usually the plugged hard drive is shown
using a new drive letter, auto assigned.
Change the name of the drive to ‘Backup’ so
as the it can be easily identified as in Fig 2.

Fig 2

2 Select the files required to be back up, copy them all
and paste into the external hard drive as in  Fig 3.

Note : In case, the file size is too large, it may
take a long time to get pasted (Fig 4).  Its better
to use USB 3.0 to copy quickly.  Also take the
backup updated in regular intervals for safety
precautions.
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Fig 4Fig 3

TASK 2 : Backup files using Google Drive

1 Download and install Google Drive application from
“http://www.google.com/drive/download” as in Fig1.

Fig 1

Fig 2

2 Open the exe file downloaded to install the Google Drive
into the system (will take 5 minutes and needs internet
to download features) as in Fig 2.

3 Login into Google account which is associated with
backup as in Fig 3.

Fig 3

4 Fix the folders to be back up to the system before
entering into backup as in Fig 4.

Fig 4
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5 Add folders to drive from ‘My System/Laptop’ and press
NEXT to proceed.

6 Press START to start back up into Drive as in Fig 5.

7 Schedule timings like daily, weekly, etc. to set periodical
backup.

Fig 5

TASK 3 : Local restoration point for failure recovery

1 Type ‘Restore Point’ in Cortana to search for ‘Create
Restore Point’

2 Select the option to get ‘Create a restore point’  as in
Fig 6.

Fig 7

Fig 6

Fig 8

3 Choose ‘Create’ option to create a Restore Point manu-
ally as in Fig 7.

4 Add description to the points identification, say ‘Before
Installing Wordpress’

Note : The created restore point makes a
backup of applications as it is working and
related files ensuring the proper working.

5 Use system restore to restore the system to working
of files on the time of backup as in Fig.8
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IT & ITES  Exercise 1.35.139
COPA - Protect  information, computers and networks from viruses, spyware
and other malicious code

Explain compliance with IT Act
Objectives : At the end of this lesson you shall be able to
• identify steps for information privacy
• identify common cybercrimes and penalties applicable.

PROCEDURE

TASK 1 : Identify steps for information privacy

Sensitive personal data or information (SPDI) processing.
The Privacy Rules define SPDI to mean personal
information relating to a person's:

• Passwords.

• Financial information, including information relating to
bank accounts, credit cards, debit cards, and other
payment card information.

• Physical, physiological, or mental health.

• Sexual orientation.

• Medical records and history.

• Biometric information.

List and identifying which of the information is "Sensitive
Personal Information" or not.

Note: Discuss with Instructor and get the list of
Sensitive Personal information as per IT Act.

TASK 2: Identify common cybercrimes and penalties applicable

List of offences and the corresponding penalties as per
Information Technology Act, 2000

Section Offence Penalty

65 Tampering with computer source documents Imprisonment up to three years, or/and with fine
up to Rs. 200,000

66 Hacking with computer system Imprisonment up to three years, or/and with fine
up to Rs. 500,000

66B Receiving stolen computer or communication Imprisonment up to three years, or/and with fine
device up to Rs. 100,000

66C Using password of another person Imprisonment up to three years, or/and with fine
up to Rs. 100,000

66D Cheating using computer resource Imprisonment up to three years, or/and with fine
up to Rs. 100,000

66E Publishing private images of others Imprisonment up to three years, or/and with fine
up to Rs. 200,000

S.No Name of the Information Type of the Information Sensitive Status ( Yes / No)
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66F Acts of cyberterrorism Imprisonment up to life.

67 Publishing information which is obscene i Imprisonment up to five years, or/and with fine
n electronic form. up to Rs. 1,000,000

67A Publishing images containing sexual acts Imprisonment up to seven years, or/and with fine
up to Rs. 1,000,000

67C Failure to maintain records Imprisonment up to three years, or/and with fine.

68 Failure/refusal to comply with orders Imprisonment up to 2 years, or/and with fine
up to Rs. 100,000

69 Failure/refusal to decrypt data Imprisonment up to seven years and possible fine.

70 Securing access or attempting to secure Imprisonment up to ten years, or/and with fine.
access to a protected system

71 Misrepresentation Imprisonment up to 2 years, or/and with fine
up to Rs. 100,000

72 Breach of confidentiality and privacy Imprisonment up to 2 years, or/and with fine
up to Rs. 100,000

72A Disclosure of information in breach of lawful Imprisonment up to 3 years, or/and with fine
contract up to Rs. 500,000

73 Publishing electronic signature certificate Imprisonment up to 2 years, or/and with fine
false in certain particulars up to Rs. 100,000

74 Publication for fraudulent purpose Imprisonment up to 2 years, or/and with fine
up to Rs. 100,000

Note: Discuss with Instructor and get the list of
offences and the corresponding penalties as
per Information Technology Act, 2000.

Sl.No Section Offence Penalty
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IT & ITES	 	 Exercise 1.36.140	
COPA - Cloud computing	

Practice with laaS using free cloud services
Objectives: At the end of this exercise you shall be able to
•	 create Free cloud service account on microsoft azure
•	 state cancel your subscription
•	 creating azure virtual machines.

Requirements

Tools/Equipment/Machines

•	 Desktop / Laptop PC
•	 OS (Windows / Linux)

PROCEDURE

TASK 1:  How to create Free cloud service account on Microsoft Azure

1	 Go to the Azure Home Page. Use the below link on 
any latest browser.

	 https://azure.microsoft.com/en-in/

2	 Click on Free Azure Account on the top right corner.
(Fig 1) 

Fig 1

•	 High Speed Internet (Broadband / FTTH).

3	 Click on Start Free  (Fig 2)

• 	 Sign-in/Sign-up for a Microsoft account using an 
email address and password (Fig 3)

4 	 Choose Create OneNew Microsoft Account if you 
don’t have already

5   	Choose Create Account (Fig 4) 

6	 We have 3 options to create the Microsoft Account

a	 Use Existing Email ID like Gmail or any other Mail 
ID.

b	 Use Phone Number

c	 Create New Microsoft (Outlook / Hotmail) Email 
Address.

Fig 2

Fig 3

Fig 4
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Fig 5
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7	 Here we are creating Microsoft Account using 
Existing Gmail ID,  give your Gmail ID and select 
Next

8	 Create New Password for the account.

9	 Enter the verification code received on the email 
address and click next.

10	Confirm that you are not Robot and Type the captcha 
you see on your screen and click on next.  

	 Choose appropriate choice proposed.

11	You’ll be redirected to the Azure Sign-up page. Enter 
your Region, Name, Phone number, Email address.

Note: You should use the same email address 
for Azure sign-up and for the Microsoft 
account

12	Verify your phone number by clicking Text Me or Call 
Me and enter the verification code received.

13	Enter the payment details. Make sure you have a 
Master Card/American Express/ Visa Credit card 
and international payments should be enabled.

14 	Check the Terms and Conditions and click Sign-up.

15	You have successfully created a Microsoft Azure 
free account now have a lumpsum balance of $200 
is equal to Indian Rs.14500. 	

16 Click on Portal on the top right corner of the screen 
You’ll be redirected to the Azure portal.

17	If you have exhausted your free credit then you have 
to move to the Pay as you go subscription policy.

18	If you have crossed the limit or time limit then you 
will get “your subscription is disabled and cannot 
perform operations until its re-enabled”

19	You can not create multiple Microsoft azure free 
accounts or after one account expires to another 
account for free credit using a single Credit card.

TASK 2 : Cancel your Subscription

	 You will learn how to cancel your subscription if you 
run out of credit.

1 	 To View your subscription from the azure portal 
accountChoose View remaining credit to try any 
service, or browse free services included with your 
account. (Fig 5)

2	 Go to Cancel subscription and click on cancel your  
subscriptions any time. (Fig 6)		

3 Now, just confirm the subscription and click for 
cancellation. (Fig 7)
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Fig 6

Fig 7

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.36.140

TASK 3 :  Creating Azure Virtual Machines

1	 Login to https://portal.azure.com/#home with free 
Account. 

2	 Click The Browse free Service on your free Azure 
Portal (Fig 8) 
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3	 Select the Create option under the Windows Virtual 
Machine section in order to create a Windows VM. 
(Fig 9)

•	 Security Type: Standard

•	 Select the image of the Windows Machine you 
wish to use: Windows10 Pro, Version 21H2 – 
Gen 1 (Free Service Eligible)

•	 Select the available size: Standard_B1s-1vcpu, 
1GiB Memory (Rs.589/Month) (Free Service 
Eligible)

•	 Select the authentication type as per your 
convenience.

•	 Administrator Account:

		    Username: copaadmin

               Password:  Welcome@1234

Fig 8

Fig 9

Fig 10

Fig 11
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4	 Next add the following details as per your 
requirement: (Figs 10 & 11)

•	 Enter the name of the virtual machine in the 
Virtual Machine name text box:  VMWindows10

•	 Select the region: Asia Pacific Central India
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•	 Select the allowed ports (SSH {22}, HTTP {80}, 
HTTPS {443} , RDP {3389})

•	 Add tags as per your requirement

•	 Licensing:  Select Check Box to agree [I confirm I 
have an eligible Windows 10/11 license with multi-
tenant hosting rights.]

5	 Add Disk as required size of creating VM (Fig 12)

6	 Select Default setting for Networking (Fig 13)

7	 Management, Advanced and Tag are with default 
settings. (Fig 14)

8	 Click on the Review + create button, then click on 
create to start the deployment. (Fig 15)

9	 Deployment InProgress (Fig 16)

10	Deployment Completed (Fig 17)

11	After the deployment is complete, go to the virtual 
machine section in the newly created virtual machine 
in order to connect the virtual machine to your local 
machine. (Fig 18)

12	Note the Public IP Address: 20.207.200.239 ( Public 
IP will be unique for each Virtual Machine) (Fig 19)

13	Next, open the start menu and search “Remote 
Desktop Connection”, launch the “Remote Desktop 
Connection” application.

14	Enter the public IP address and username of your 
Windows Virtual Machine, and click connect.

Fig 12

Fig 13

Fig 14
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Fig 15

Fig 16

Fig 17

Fig 18

Fig 19
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15	Enter the password to access your Windows Virtual 
Machine (Fig 20)

16	Proceed to connect and use your Windows Free 
Virtual Machine.

17	Booting Virtual Machine (Fig 21)Fig 20

Fig 21
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IT & ITES	 	 Exercise 1.36.141	
COPA - Cloud computing	

Practice with PaaS using free cloud services
Objectives: At the end of this exercise you shall be able to
•	 practicing with PaaS using free cloud services.

Requirements

Tools/Equipment/Machines

•	 Desktop / Laptop PC
•	 OS (Windows / Linux)

•	 High Speed Internet (Broadband / FTTH).

PROCEDURE

TASK 1:  Create and configure an Azure Active Directory Domain Services managed domain

Sign in to the Azure portal

1	 Sign in to the Azure portal - create and configure the 
managed domain using the Azure portal. 

2	 To get started, first sign in to the Azure portal  and 
Login to https://portal.azure.com/#home with free 
Account. 

Create a managed domain

3	 Create a managed domain To launch the Enable 
Azure AD Domain Services wizard, complete the 
following steps: (Fig 1)

a	 On the Azure portal menu or from the Home 
page, select Create a resource.

b	 Enter Domain Services into the search bar, then 
choose Azure AD Domain Services from the 
search 	  suggestions.

c.	 On the Azure AD Domain Services page, select 
Create. The Enable Azure AD Domain Services 
wizard is launched.

d	 Select the Azure Subscription in which you 
would like to create the managed domain.

e	 Select the Resource group to which the managed 
domain should belong. Choose to Create new or 
select an 	existing resource group.

4	 Complete the fields in the Basics window of the 
Azure portal to create a managed domain:

5	 Enter a DNS domain name for your managed domain, 
taking into consideration the previous points.

6	 Choose the Azure Location in which the managed 
domain should be created. If you choose a region 
that supports Azure Availability Zones, the Azure 
AD DS resources are distributed across zones for 
additional redundancy.

7	 The SKU determines the performance and backup 
frequency. You can change the SKU after the 
managed domain has been created if your business 
demands or requirements change. For more 
information, see Azure AD DS SKU concepts.

8	 A forest is a logical construct used by Active Directory 
Domain Services to group one or more domains. By 
default, a managed domain is created as a User 
forest. This type of forest synchronizes all objects 
from Azure AD, including any user accounts created 
in an on-premises AD DS environment.

	 A Resource forest only synchronizes users and 
groups created directly in Azure AD. For more 
information on Resource forests, including why you 
may use one and how to create forest trusts with 
on-premises AD DS domains, see Azure AD DS 
resource forests overview.

Fig 1
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9	 To quickly create a managed domain, you can 
select Review + create to accept additional default 
configuration 	 	 options. The following 
defaults are configured when you choose this create 
option:

	 •	 Creates a virtual network named aadds-vnet that 
uses the IP address range of 10.0.2.0/24.

	 •	 Creates a subnet named aadds-subnet using the 
IP address range of 10.0.2.0/24.

	 •	 Synchronizes All users from Azure AD into the 	
	 managed domain.

10	Select Review + create to accept these default 	
configuration options.

Deploy the managed domain
11	To create the managed domain, select Create. A note 

is displayed that certain configuration options such 
as DNS name or virtual network can’t be changed 
once the Azure AD DS managed has been created. 
To continue, select OK.

12	The process of provisioning your managed domain 
can take up to an hour. A notification is displayed 
in the portal that shows the progress of your Azure 
AD DS deployment. Select the notification to see 
detailed progress for the deployment. (Fig 2)

13	The page will load with updates on the deployment 
process, including the creation of new resources in 
your directory.

14	Select your resource group, such as myResource-
Group, then choose your managed domain from the 
list of Azure resources, such as aaddscontoso.com. 
The Overview tab shows that the managed domain 
is currently Deploying. You can’t configure the man-
aged domain until it’s fully provisioned.

15	When the managed domain is fully provisioned, the 
Overview tab shows the domain status as Running. 

Fig 2

Fig 3
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17	The addresses listed are the domain controllers for 
use in the virtual network. In this example, those 
addresses are 10.0.2.4 and 10.0.2.5. You can later 
find these IP addresses on the Properties tab.

18	To update the DNS server settings for the virtual 
network, select the Configure button. The DNS 
settings are automatically configured for your virtual 
network.

Update DNS settings for the Azure virtual network
16	The Overview tab for your managed domain shows 

some Required configuration steps. The first 
configuration step is to update DNS server settings 
for your virtual network. Once the DNS settings are 
correctly configured, this step is no longer shown. 
(Fig 3)
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IT & ITES	 	 Exercise 1.36.142	
COPA - Cloud computing	

Practice with SaaS using free cloud services
Objectives: At the end of this exercise you shall be able to
•	 create a free office 365 account & switch users (sign out).

Requirements

Tools/Equipment/Machines

•	 Desktop / Laptop PC
•	 OS (Windows / Linux)

•	 High Speed Internet (Broadband / FTTH).

PROCEDURE

TASK 1:  Create a Free Office 365 Account & Switch Users (Sign Out)

Step 1: 

• 	 Go to account.microsoft.com, select Sign in, and 
then choose Create one!

• 	 If you’d rather create a new email address, choose 
Create a Microsoft account, choose Next, and then 
follow the instructions. (Fig 1)

Create a microsoft account:

Step 2: Click Create one

Step 3: Enter an email address you want to create and 	
click Next

Step 4: Enter a password of your choosing and click 
Next.

step:1-4

Refer Ex-No:01.44.140

This will create your Office365 account. Save the user 
name and password to sign into Office 365.

To Switch to Another User Account: 

Step 1: Click on the user icon in the top right corne.

Step 2: Click on Sign in with a different account (Fig 2).

Step 3: Enter the email address and click Next. (Fig 3)

Step 4: Enter the password and click Sign in. (Fig 4)

Support and Accessing Office 365 
Once you’ve created your account you can access 
Office 365 by going to https://support.office.com/ and 
entering your email and password. 

Fig 1

Fig 2

Fig 3
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There are various links on the website for support in 
using Office 365. 

1	 Click on the Training link for training on the 
applications. (Fig 5)

2	 Click on one of the Office apps links to open that 
program.

Fig 4

Fig 5
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IT & ITES	 	 Exercise 1.36.143	
COPA - Cloud computing	

Host a website in a free cloud
Objectives: At the end of this exercise you shall be able to
•	 details the host a static website in google cloud with cloud storage.

Requirements

Tools/Equipment/Machines

•	 Desktop / Laptop PC
•	 OS (Windows / Linux)

•	 High Speed Internet (Broadband / FTTH).

PROCEDURE

TASK 1:  Host a Static Website in Google Cloud with Cloud Storage

1	 Introduction : Every small-business owner should 
have a domain name and website—they are the 
foundation of your brand and your method to 
communicate with potential customers.

2	 Your domain name and website are one of the 
primary ways that people find your business, 
discover what products and services you offer, find 
your contact details, and even transact business 
with you (e-commerce transactions).

3	 If you’re only starting your business now, then you’re 
not expecting very much traffic, so you want to host 
a simple website. You can do that in Google Cloud, 
which makes the process very quick, easy, and 
inexpensive.

What you’ll learn

•	 How to Create a CNAME record

•	 How to point that CNAME record to Cloud Storage

•	 How to create a Cloud Storage bucket named like 
your domain

•	 How to upload and set permissions on the static files 
for your website

•	 How to test your website

Prerequisites

•	 You need to be the owner/administrator of your 
domain.

•	 You need a Google Account.

Complete following steps one by one:

2	 Setup

Google Account and new project

1	 If you don’t already have a Google Account, then 
you must create one. Sign into Cloud Console and 

	 create a new project. (Fig 1)

You can also edit the Project ID.

Domain ownership or admin rights
As mentioned in the prerequisites, you’ll need a domain 
that you own or manage.

If you don’t have an existing domain, then there are 
many services through which you can register a new 
domain, such as Google Domains.

The following tutorial uses the domain www.
cookingincloudhipster.com, which is managed through 
Google Domains and admin.google.com

1	 Verify that you own or manage the domain that you 
will use. Make sure that you are verifying the top-level 
domain, such as cookingincloudhipster.com, and not 
a subdomain, such as www.cookingincloudhipster.
com.

Fig 1
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Note: If you own the domain that you are 
associating to a bucket, then you might have 
already performed this step in the past. If 
you purchased your domain through Google 
Domains, verification is automatic.

2	 Go to Google Search Console. Enter your domain 
name and press continue. (Fig 2)

3	 If you used Google Domains to purchase your 
domain name, then it will allow for automatic 
ownership verification. However, if you’re using 
another registrar, then you could have a few more 
steps. (Fig 3)

3	 Create a CNAME record : On the web, there are 
numerous systems that are used to make sure that you 
can get where you need to go. One of those critical 
systems is Domain Name Services (DNS), which helps 
with translating human-readable names like www.
cookingincloudhipster.com into the numeric IP Address 
number of the server that is hosting that website.

Within DNS, there is the ability to add RECORDs to the 
DNS entry to help other services with being correctly 
configured. Some of the the common ones are MX or 
Mail eXhange RECORDs, which help email systems 
work.

In this section, you’ll create a CNAME, which is a 
Canonical Name Record or Alias Record record, so 
that when someone only enters cookingincloudhipster.
com—without the “www”—it will still lead to the right 
server.

Follow these steps:

1	 Go to Google Domains. Click on the “My domains” 
task. If you need to Sign-in or if you are a first-time 
user, then use your email address to log in. Find your 
domain— www.cookingincloudhipster.com. (Fig 4)

2	 Click on “Manage,” then click “DNS.”

3	 DNS Settings screen.

Toward the bottom, look for the “Custom resource 
records” panel.

4	 Add a CNAME record. A CNAME record is a type 
of DNS record. It directs traffic that requests a URL 
from your domain to the re sources that you want to 
serve. In this case, those are objects in your Cloud 
Storage buckets. For more information, see CNAME 
redirects.

NAME TYPE DATA

www.cookingincloudhipster.com CNAME c.storage.googleapis.com

Fig 2

Fig 3
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Fig 4
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When you’re done, it should look like this

4	 Create a Cloud Storage Bucket
Next, you’ll create a Cloud Storage bucket to hold your 
static site files.

Follow these steps:

1	 Go to the Cloud Console. In the left-hand menu, 
scroll down to the STORAGE category and click on 
the Storage task. 

2	 Click on Create Bucket.

3	 With your site name, which is www.
cookingincloudhipster.com.

•	 Choose where to store your data: Select Multi-
region so that the content is available from more 
than one cloud region.

•	 Choose a default storage class for your data: 
Select Standard. For more information, see 
Storage classes.

•	 Choose how to control access to objects: 
Set the bucket permissions for the whole bucket 
and its contents the same. For information, see 
Access control lists (ACLs).

•	 Click Create.

So far in this codelab, you have been using the Cloud 
Console graphical user interface. However, you can also 
control Google Cloud with Cloud Shell, which provides 
you with command-line access to your cloud resources 
directly from your browser.

This Debian-based virtual machine is loaded with all 
the development tools you’ll need. It offers a persistent 
5GB home directory and runs in Google Cloud, greatly 
enhancing network performance and authentication. 
This means that all you will need for this codelab is a 
browser (yes, it works on a Chromebook)

1	 To activate Cloud Shell from the Cloud Console, 
simply click Activate Cloud Shell   (it should only 
take a few moments to provision and connect to the 
environment). (Fig 5) 

Fig 5

Once connected to Cloud Shell, you should see that 
you are already authenticated and that the project is 
already set to your PROJECT_ID.

gcloud auth list

Command output

Credentialed accounts:

 - <myaccount>@<mydomain>.com (active)

Note: The gcloud command-line tool comes 
preinstalled in Cloud Shell and you’ll surely 
enjoy its support for tab completion. For 
more information, see gcloud command-line 
tool overview.

gcloud config list project

Command output
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[core]

project = <PROJECT_ID>

If, for some reason, the project is not set, simply issue 
the following command:

gcloud config set project <PROJECT_ID>

Looking for your PROJECT_ID? Check out what ID 
you used in the setup steps or look it up in the Cloud 
Console dashboard: (Fig 6)

Fig 6

Cloud Shell also sets some environment variables 
by default, which may be useful as you run future 
commands.

echo $GOOGLE_CLOUD_PROJECT

Command output

<PROJECT_ID>

2	 Finally, set the default zone and project 

	 configuration.

gcloud config set compute/zone us-central1-f

You can choose a variety of different zones. For more 
information, see Regions & Zones.

Note: When you run gcloud on your own 
machine, the config settings would’ve been 
persisted across sessions. But in Cloud Shell, 
you will need to set this for every new session 
or reconnection.

Here’s the command-line version of “create bucket.”

gsutil mb gs://www.cookingincloudhipster.com

5 	 Upload your website’s files and images
Now, obtain the static files from your website developer 
or marketing team. If you’re doing it yourself, then there 
are plenty of great tutorials on HTML and CSS. Then, 
upload the static files into the bucket that you created in 
one of three ways.

Upload files with the Cloud Console
1	 Go to the Cloud Console. In the left-hand menu, click 

on the STORAGE category, then click Storage. 

2	 Click on the bucket name, which is www.
cookingincloudhipster.com.

3	 Under Bucket details, click Upload folder.

4	 Upload your website’s folders and files.

Upload files by dragging and dropping them
You can also upload files by dragging and dropping 
them. 

Upload files using the gsutil rsync

You can also the gsutil rsync command to copy large 
numbers of files from your local machine to Cloud 
Storage. You can use the -R option to recursively 
copy directory trees. For example, to synchronize a 
local directory named local-dir with a bucket, use the 
following:

gsutil rsync -R local-dir gs://www.cookingincloudhipster.
com

6	 Set access permissions

1	 You can either make all files in your bucket publicly 
accessible or set individual objects to be accessible 
through your website. Generally, making all files in 
your bucket accessible is easier and faster.

2	 If you choose to control the accessibility of individual 
files, then you can set the default object ACL for your 
bucket so that subsequent files uploaded to your 
bucket are shared by default.

Note: Visitors receive an HTTP 403 response 
code when requesting the URL for a nonpublic 
or nonexistent file. See the next section for 
information about how to add an error page 
that uses an HTTP 404 response code.

Bucket-level access permissions
1	 Apply access permission to the entire bucket as 

a whole. That is safer and, given that it is a static 
website, all of the contents likely need to be readable 
for the site to properly load. 

2	 If you have some design metadata (or hidden files 
like .DS_Store, which is used on Macintosh,is a file 
that stores custom attributes of its containing folder, 
such as the position of icons or the choice of a 
background image.) They can be individually hidden 
or deleted.
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1	 Click Bucket details, then click Permissions. (Fig 7)

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.36.143

Fig 7

2	 Click Add members. (Fig 8)

Fig 8

3	 Add allUsers with Storage Object Viewer rights  
(Fig 9)

Fig 9

4	  Verify that you see the following: (Fig 10)

The files are now visible to the general public. Hooray!

Fig 10
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7	 Edit website configuration
1	 The last step is to assign an index page suffix, 

which is controlled by the MainPageSuffix property, 
and a custom error page, which is controlled by the 
NotFoundPage property. 

2	 Assigning either is optional, but without an index page, 
nothing is served when users access your top-level 
site, in this case— http://www.cookingincloudhipster.
com/.

Index pages

1	 An index page (also called a webserver directory 
index) is a file served to visitors when they request a 
URL that doesn’t have an associated file. 

2	 When you assign a MainPageSuffix, Cloud Storage 
looks for a file with that name and a prefix that 
matches the URL that the visitor requested.

3	 For example, say you set the MainPageSuffix of your 
static website to index.html. Additionally, say you 
have no file named directory in your bucket www.
cookingincloudhipster.com. 

4	 In this situation, if a user requests the URL http://www.
cookingincloudhipster.com/directory, Cloud Storage 
attempts to serve the file www.cookingincloudhipster.
com/directory/index.html. 

5	 If that file also doesn’t exist, Cloud Storage returns 
an error page.

6	 The MainPageSuffix also controls the file served 
when users request the top-level site. 

7	 Continuing the above example, if a user 
requests http://www.cookingincloudhipster.com, 
Cloud Storage attempts to serve the file www.
cookingincloudhipster.com/index.html.

For more information on the cases in which the index 
page is served, see Website configuration examples.

Error page

1	 The error page is the file returned to visitors of 
your static site who request a URL that does not 
correspond to an existing file. 

2	 If you have assigned a MainPageSuffix, then Cloud 
Storage only returns the error page if there is neither 
a file with the requested name nor an applicable 
index page. (Fig 11)

Fig 24

3	 When returning an error page, the HTTP response 
code is 404. The property that controls which file acts 
as the error page is NotFoundPage. If you don’t set 
NotFoundPage, then users receive a generic error 
page. (Fig 25)

4	 In the following sample, the MainPageSuffix is set 
to index.html and NotFoundPage is set to 404.html: 
gsutil web set -m index.html -e 404-Page.html gs://
www.example.com

8	 Test your website

1	 Now, open a browser and go to your website— www.
cookingincloudhipster.com. (Fig 26)

2	 Confirm that you see the following page and 
individual product pages: 

Fig 25
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Delete the following Google Cloud resources:
•	 The Cloud Storage bucket

•	 The CNAME record

Fig 26

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.36.143

9	 Congratulations!

You created a static website and hosted it in Google 
Cloud!
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IT & ITES	 	 Exercise 1.37.144	
COPA - Devolop an application and perform the Application Development life 
Cycle	

Identify Phases of the Application Development life Cycle
Objectives: At the end of this exercise you shall be able to
•	 identify phases pf the application development life cycle.

Requirements

Tools/Equipment/Machines

	 •	 Desktop / Laptop PC		             - 1 No.

PROCEDURE

TASK 1:   Identify Phases of the Application Development Life Cycle

1	 Identify Phases of the Application Development Life 
Cycle (Fig 1)

• 	 OS (Windows / Linux)		  - 1 No.

2	 Identify Each Phases and Write Down (Fig 2)	

Fig 1

Fig 2
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IT & ITES	 	 Exercise 1.37.145	
COPA - Devolop an application and perform the Application Development life 
Cycle	

Describe Role in each of the phases of Application Development life Cycle
Objectives: At the end of this exercise you shall be able to
•	 descibe roles in each of the phases of application development life cycle.

Requirements

Tools/Equipment/Machines

	 •	 Desktop / Laptop PC		             - 1 No. • 	 OS (Windows / Linux)		  - 1 No.

PROCEDURE

TASK 1:   Describe Roles in each of the phases of Application Development Life Cycle

1	 Describe each role and Write on the process chart.

ANALYSIS (Fig 1 )

PRODUCT DESIGN  (Fig 2 )

SOFTWARE DEVELOPMENT (Fig 3 )

PRODUCT TESTING (Fig 4 )

Fig 1

Fig 2

Fig 3

Fig 4
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DEPLOYMENT (Fig 5)

MAINTENANCE (Fig 6)

Fig 5

Fig 6
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IT & ITES	 	 Exercise 1.38.01	
COPA - Elective Module 1 - Programming in Python	

Install, set up the environment & run Python
Objectives: At the end of this exercise you shall be able to
•	 install Python
•	 setup or verify environment path 
•	 run Python.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

The version 3.10.5 or Latest of Python IDLE (Integrated Development Learning Environment) is 
used to develop and run Python code. It can be downloaded from the web resource www.python. 
org     Downloads

PROCEDURE

TASK 1:  Install Python

•	 Python Ver 3.10.5 or latest		  - 1 No.

1	 Run the Python Installer once downloaded (python-
3.10.5-amd64.exe) to start the installation.

2	 Make sure you select the Install launcher for all users 
and Add Python 3.10 to PATH checkboxes. (Fig 1)

Note: older versions of Python that do not 
support the Add Python to Path checkbox.

3	 Choose Install Now with default installation location. 

Fig 1

Note: For all recent versions of Python, the 
recommended installation options include 
Pip and IDLE. Older versions might not 
include such additional features.

4	 Installation in progress… 

5	 The next dialog will prompt you to select whether to 
Disable path length limit. 

	 Choosing this option will allow Python to bypass the 
260-character MAX_PATH limit. Effectively, it will 
enable Python to use long path names.

6	 Click Close to Complete the Setup. 
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TASK 2:  Setup or Verify environment path 

1	 Add Python Path to Environment Variables 

2	 We recommend you go through this step if your 
version of the Python installer does not include the 
Add Python to PATH checkbox or if you have not 
selected that option.

3	 Setting up the Python path to system variables 
alleviates the need for using full paths. It instructs 
Windows to look through all the PATH folders for 
“python” and find the install folder that contains the 
python.exe file.

i 	 Open the Start menu and start the Run app. 
(Fig 2)

Fig 2

ii Type sysdm.cpl and click OK. This opens the 
System Properties window.

iii Navigate to the Advanced tab and select 
Environment Variables.

iv Under User Variables, find and select the Path 
variable.

v 	 Click Edit.

vi 	Verify the path of Python installed location are 
added here, if not Select the New to add the 
Variable value field path that where python.exe 
file installed on your computer preceded with a 
semicolon (;). 

	 For example, in the image below, we have added 
“;C:\Python34.” (Fig 3)

vii Click OK and close all windows.

	 By setting this up, you can execute Python scripts 
like this: Python script.py

Instead of this: C:/Python34/Python script.py

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.38.01

Fig 3

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



209

TASK 3:  Run Python

1	 Invoking Python IDLE

2	 The following command can be used to invoke 
Python IDLE from Window OS.

	 Start → All Programs → Python 3.x → IDLE (Python 
3.x)  (Or)

3	 Click python Icon on the Desktop if available.

4	 Now Python IDLE window appears as shown in the 
Figure (Fig 4).

Menu Bar Tilte Bar

Python prompt (>>>)

Python IDLE Window : The prompt (>>>) indicates that 
Interpreter is ready to accept instructions. Therefore, the 
prompt on screen means IDLE is working in interactive 
mode.

Fig 4
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IT & ITES	 	 Exercise 1.38.02	
COPA - Elective Module 1 - Programming in Python	

Use Command Line and IDE to create and execute a python program 
Objectives: At the end of this exercise you shall be able to
•	 IDE Interactive mode execution 
•	 command line script mode execution.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

In Python, programs can be written in two ways namely Interactive mode and Script mode. The 
Interactive mode allows us to write codes in Python command prompt (>>>) whereas in script mode 
programs can be written and stored as separate file with the extension .py and executed. Script mode 
is used to create and edit python source file.

PROCEDURE

TASK 1:  IDE Interactive mode Execution

1	 Interactive mode Programming

	 In interactive mode Python code can be directly 
typed and the interpreter displays the result(s) 
immediately. The interactive mode can also be used 
as a simple calculator.

	 The following command can be used to invoke 
Python IDLE from Window OS.

	 Start → All Programs → Python 3.x → IDLE (Python 
3.x) (Or)

2	 Click python Icon on the Desktop if available.

3	 Now Python IDLE window appears as shown in the 
Fig 1.

Menu Bar Tilte Bar

Python prompt (>>>)

Python IDLE Window

	 The prompt (>>>) indicates that Interpreter is ready 
to accept instructions.

Example 1:

>>>print (“Python Programming Language”)

Python Programming Language

>>>x=5

>>>y=10

>>>z=x + y

>>>print (“The Sum”, z)

The Sum = 15

Fig 1
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TASK 2:  Command Line Script mode Execution

Basically, a script is a text file containing the Python 
statements. Python Scripts are reusable code. Once 
the script is created, it can be executed again and again 
without retyping. The Scripts are editable.

Creating Scripts in Python

1	 Choose File → New File or press Ctrl + N in Python 
shell window

2	 An untitled blank script text editor will be displayed 
on screen as shown in Fig 2.

	 Figure xx. Untitled, blank Python script editor

3	 Type the following code in Script editor

	 a =100

	 b = 350

	 c = a+b

	 print (“The Sum=”, c) (Fig 3)

Figure xx– Python Sample code

4	 Choose File → Save or Press Ctrl + S

5	 Now, Save As dialog box appears on the screen as 
shown in the Figure xx (Fig 4)

Figure xx – Save As Dialog Box

6	 In the Save As dialog box, select the location where 
you want to save your Python code, and type the file 
name in File Name box. Python files are by default 
saved with extension .py. Thus, while creating 
Python scripts using Python Script editor, no need to 
specify the file extension.

7	 Finally, click Save button to save your Python script.

Executing Python Script

1	 Choose Run → Run Module or Press F5

2	 If your code has any error, it will be shown in red 
color in the IDLE window, and Python describes the 
type of error occurred. To correct the errors, go back 
to Script editor, make corrections, save the file using 
Ctrl + S or File → Save and execute it again.

3	 For all error free code, the output will appear in the 
IDLE window of Python as shown in Figure xx (Fig 5)

Figure xx – Python Script Output Window

Executing Python Script by Command Prompt

1	 Start Run → using Windows Key + R (Fig 6) 

2	 Type CMD and Enter 

3	 Command Prompt will appear then navigate the 
location where python program saved 

4	 Execute the Python program using command by 
“python <filename.py>” then output will appear on 
the next line as shown in figure. (Fig 7) 

Figure xx –Python Script CMD prompt Output Window

Fig 2

Fig 3

Fig 4
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Fig 5

Fig 6

Fig 7
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IT & ITES	                                                                                      Exercise 1.39.03 	
	COPA - Elective Module 1 - Programming in Python	

Write and test a python program to demonstrate print statement, comments, 
different types of variables 
Objectives: At the end of this exercise you shall be able to
•	 state print statement 
•	 state comments
•	 different types of variables.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  Print statement

1	 Print statement will appear as shown in Fig 1

2	 Output (Fig 2)

TASK 2:  Comment statement

1	 Exampe1: Single line Comment  (Fig 3)

2	 Output 60 (Fig 4)

3	 Exampe 2: Multi line Comment  (Fig 5)

4	 Output 60 (Fig 6)

Fig 1

Fig 2

Fig 3

Fig 4
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TASK 3:  Different type of Variables

1	 Different types of variables (Figs 7 & 8)

Fig 5

Fig 6

Fig 7

Fig 8
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IT & ITES	                                                                                      Exercise 1.39.04 	
	COPA - Elective Module 1 - Programming in Python	

Write and test a python program to perform data and data type operations, 
string operations, date, input and output, output formatting and operators 
Objectives: At the end of this exercise you shall be able to
•	 state data type operations 
•	 state string operations
•	 state date operations
•	 state input and output
•	 state output formatting
•	 state opeartors in output formatting.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  Data type operations

1	 Data type operations is shown in Fig 1&2.

Fig 1

Fig 2
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TASK 2:  String operations

1	 Example 1: Creation of string (Fig 3) 2	 Output (Fig 4)

Example2: Accessing characters in Python String

# Python Program to Access

# characters of String  

String1 = “WelcometoNIMI”

print(“Initial String: “)

print(String1)  

# Printing First character

print(“\nFirst character of String is: “)

print(String1[0])  

# Printing Last character

print(“\nLast character of String is: “)

print(String1[-1])

Output:

Initial String: 

WelcometoNIMI 

First character of String is: 

W

Last character of String is: 

I

Example3: Reversing a String

#Program to reverse a string

gfg = “welcometoNIMI”

print(gfg[::-1])

Output:

IMINotemoclew 

Example4: Formatting of Strings

Python Program for

# Formatting of Strings  

# Default order

String1 = “{} {} {}”.format(‘Welcome’, ‘to’, ‘NIMI’)

Fig 3

Fig 4
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print(“Print String in default order: “)

print(String1)  

# Positional Formatting

String1 = “{1} {0} {2}”.format(‘Welcome’, ‘to’, ‘NIMI’)

print(“\nPrint String in Positional order: “)

print(String1)  

# Keyword Formatting

String1 = “{l} {f} {g}”.format(g=’NIMI’, f=’to’, l=’Welcome’)

print(“\nPrint String in order of Keywords: “)

print(String1)

Output:

Print String in default order: 

Welcome to NIMI

Print String in Positional order: 

to Welcome NIMI

Print String in order of Keywords: 

Welcome to NIMI

TASK 3:  Date operations

Example1:

import datetime

x = datetime.datetime.now()

print(x)

Output:

2022-07-09 16:05:52.588848

Example 2:

import datetime

x = datetime.datetime.now()

print(x.year)

print(x.strftime(“%A”))

Output:

2022

Saturday

Example3:

import datetime

x = datetime.datetime(2020, 5, 17)

print(x)

Output:

	 2020-05-17 00:00:00

TASK 4:  Input and output operations

Example for Input:

x = int (input(“Enter Number 1: “))

y = int (input(“Enter Number 2: “))

print (“The sum = “, x+y)

Output:

Enter Number 1: 5

Enter Number 2: 10

The sum =  15

Example for Output:

print (“Welcome to Python Programming”)

x = 5

y = 6

z = x + y

print (z)

print (“The sum = “, z)

print (“The sum of “, x, “ and “, y, “ is “, z)

Output:

Welcome to Python Programming

11

The sum =  11

The sum of  5  and  6  is  11

Example for Input and Output:

# Python program showing how to multiple input and 
output using split

# taking two inputs at a time

x, y = input(“Enter two values: “).split()

print(“Number of boys: “, x)

print(“Number of girls: “, y)

print()  

# taking three inputs at a time

x, y, z = input(“Enter three values: “).split()

print(“Total number of students: “, x)

print(“Number of boys is : “, y)

print(“Number of girls is : “, z)

print()
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# taking two inputs at a time

a, b = input(“Enter two values: “).split()

	 print(“First number is {} and second number is {}”.
format(a, b))

print()  

# taking multiple inputs at a time 

# and type casting using list() function

x = list(map(int, input(“Enter multiple values: “).split()))

print(“List of students: “, x)

output:

Enter two values: 10 15

Number of boys:  10

Number of girls:  15

Enter three values: 10 15 20

Total number of students:  10

Number of boys is :  15

Number of girls is :  20

Enter two values: 10 15

First number is 10 and second number is 15

Enter multiple values: 10 15 12 13 15 

List of students:  [10, 15, 12, 13, 15]

TASK 5:  Output formatting

# Python program showing use of format() method 
using format() method

print(‘Welcome {} to “{}!”’.format(‘NIMI’, ‘NIMI’)) 

# using format() method and referring  a position of the 
object

print(‘{0} and {1}’.format(‘NIMI’, ‘Portal’))

 print(‘{1} and {0}’.format(‘NIMI’, ‘Portal’))  

# the above formatting can also be done by using 
f-Strings Although, this features work only with python 

 print(f”Welcome {‘nimi’} for \”{‘NIMI’}!\””) 

# using format() method and referring  a position of the 
object

print(f”{‘NImi’} and {‘Portal’}”)

Output:

Welcome NIMI to “NIMI!”

NIMI and Portal	

Portal and NIMI

Welcome nimi for “NIMI!”

NImi and Portal

TASK 6:  Operators in output formatting

# Python program showing how to use

# string modulo operator(%) to print

# fancier output 

# print integer and float value

print(“Integer : %2d, Float : %5.2f” % (1, 2.0)) 

# print integer value

print(“Integer: %3d, Boys : %2d” % (240, 120)) 

# print octal value

print(“Octal: %7.3o” % (25)) 

# print exponential value

print(“Exponential: %10.3E” % (356.08977))

Output:

Integer :  1, Float :  2.00

Integer: 240, Boys : 120

Octal:     031

Exponential:  3.561E+02
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IT & ITES	                                                                                      Exercise 1.39.05 	
	COPA - Elective Module 1 - Programming in Python	

Determine the sequence of execution based on operator precedence
Objectives: At the end of this exercise you shall be able to
•	 state arithmetic operators in Python
•	 state comparison operators
•	 state logical operators
•	 state bitwise operators
•	 state assignment operators 
•	 state operator precedence.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  Arithmetic operators in Python

1	 Arithmatic opeartions as follows:

# Examples of Arithmetic Operator

a = 9

b = 4  

# Addition of numbers

add = a + b  

# Subtraction of numbers

sub = a - b  

# Multiplication of number

mul = a * b  

# Division(float) of number

div1 = a / b  

# Division(floor) of number

div2 = a // b  

# Modulo of both number

mod = a % b  

# Power

p = a ** b  

# print results

print(add)

print(sub)

print(mul)

print(div1)

print(div2)

print(mod)

print(p)

Output:

13

5

36

2.25

2

1

6561

TASK 2:  Comparison operators

1	 Comparison opeartors as follows:

# Examples of Relational Operators

a = 13

b = 33

# a > b is False

print(a > b)

# a < b is True

print(a < b)

# a == b is False

print(a == b)

# a != b is True
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print(a != b)

# a >= b is False

print(a >= b)

# a <= b is True

print(a <= b)

Output:

False

True

False

True

False

True

TASK 3:  Logical operators

1	 Logical opeartors as follows:

# Examples of Logical Operator

a = True

b = False

# Print a and b is False

print(a and b)

# Print a or b is True

print(a or b)

# Print not a is False

print(not a)

output: 

False

True

False

TASK 4:  Bitwise operators

1	 Bitwise opeartors as follows:

# Examples of Bitwise operators

a = 10

b = 4

# Print bitwise AND operation

print(a & b)

# Print bitwise OR operation

print(a | b)

# Print bitwise NOT operation

print(~a)

# print bitwise XOR operation

print(a ^ b)

# print bitwise right shift operation

print(a >> 2)

# print bitwise left shift operation

print(a << 2)

Output:

0

14

-11

14

2

40

TASK 5:  Assignment operators

1	 Assignment opeartors as follows:

# Examples of Assignment Operators

a = 10

# Assign value

b = a

print(b)

# Add and assign value

b += a

print(b)

# Subtract and assign value

b -= a

print(b)

# multiply and assign

b *= a

print(b)

# bitwise lishift operator
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b <<= a

print(b)

Output:

10

20

10

100

102400

TASK 6:  Operator precedence

1	 Operator precedence as follows:

# Examples of Operator Precedence

# Precedence of ‘+’ & ‘*’

expr = 10 + 20 * 30

print(expr)

# Precedence of ‘or’ & ‘and’

name = “Alex”

age = 0

if name == “Alex” or name == “John” and age >= 2: 
print(“Hello! Welcome.”)

else:

print(“Good Bye!!”)

Output:

610

Hello! Welcome.

TASK 7:  Operator associativity

1	 Operator associativity as follows:

# Examples of Operator Associativity

# Left-right associativity

# 100 / 10 * 10 is calculated as

# (100 / 10) * 10 and not

# as 100 / (10 * 10)

print(100 / 10 * 10)

# Left-right associativity

# 5 - 2 + 3 is calculated as

# (5 - 2) + 3 and not

# as 5 - (2 + 3)

print(5 - 2 + 3)

# left-right associativity

print(5 - (2 + 3))

# right-left associativity

# 2 ** 3 ** 2 is calculated as

# 2 ** (3 ** 2) and not

# as (2 ** 3) ** 2

print(2 ** 3 ** 2)

Output

100.0

6

0
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IT & ITES	                                                                                      Exercise 1.40.06 	
	COPA - Elective Module 1 - Programming in Python	

Construct and analyze code segments that use branching statements
Objectives: At the end of this exercise you shall be able to
•	 state if statement
•	 state if-else
•	 state nested-if
•	 state if-elif-else .

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  if statement

1	 if statement as follows:

Example1:

i = 10

if (i < 15): print(“10 is less than 15”)

print(“Welcome to If Statement”)

Output:

	 10 is less than 15

Welcome to If Statement

Example 2:

i = 10

if (i > 15): print(“10 is less than 15”)

print(“Welcome to If Statement”)

Output:

Welcome to If Statement

TASK 2:  if-else

1	 if-else as follows:

Example1:

# python program to illustrate If else statement

#!/usr/bin/python

i = 20

if (i > 15):

    print(“i is smaller than 15”)

    print(“I’m in if Block”)

else:

    print(“i is greater than 15”)

    print(“I’m in else Block”)

print(“I’m not in if and else Block”)

Output:

 is smaller than 15

i’m in if Block

i’m not in if and else Block

Example2: Check Whether a String is Palindrome or 
Not (Fig 1)

Output
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TASK 3:  nested-if

1	 nested-if as follows:

Example1: 

# python program to illustrate nested If statement

#!/usr/bin/python

i = 10

if (i == 10):

	 # First if statement

	 if (i < 15):

		  print(“i is smaller than 15”)

	 # Nested - if statement

	 # Will only be executed if statement above

	 # it is true

	 if (i < 12):

		  print(“i is smaller than 12 too”)

	 else:

		  print(“i is greater than 15”)

Output:

i is smaller than 15

i is smaller than 12 too

TASK 4:  if-elif-else 

1	 if-elif-else  as follows:

Example1: 

# Python program to illustrate if-elif-else ladder

#!/usr/bin/python

i = 20

if (i == 10):

	 print(“i is 10”)

elif (i == 15):

	 print(“i is 15”)

elif (i == 20):

	 print(“i is 20”)

else:

	 print(“i is not present”)

Output:  

	 i is 20

Example2: Find the Largest Among Three Numbers

Output

Fig 2
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IT & ITES	                                                                                      Exercise 1.40.07 	
	COPA - Elective Module 1 - Programming in Python	

Construct and analyze code segments that perform iteration
Objectives: At the end of this exercise you shall be able to
•	 state for loop
•	 state while loop
•	 state while loop with else
•	 state nested loop
•	 state break, continue and pass statement.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  Demonstration of for loop

1	 Example1: Sum of N numbers (Fig 1)

Output: (Fig 2)

Example2: Find the Factorial of a Number (Fig 3)

Output : (Fig 4)

Example3: Check Prime Number Using a flag variable 
(Fig 5) 

Example4: Using a for...else statement. (Figs 6&7)

Output (Fig 8)  

Fig 1

Fig 2

Fig 3

Fig 4
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TASK 2:  Demonstration while loop

Example1: Program to Add Natural Numbers (Fig 9) the output will be: (Fig 10)

Example2: Find the Sum of Natural Numbers (Fig 11)

Output (Fig 12)

Example3:  Print the Fibonacci sequenc    e (Fig 13)

Output (Fig 14)

Fig 5

Fig 6

Fig 7

Fig 8

Fig 9 Fig 10
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TASK 3:  While loop with else

Example : (Fig 15) Output : (Fig 16)

Fig 11

Fig 12
Fig 14

Fig 13

Fig 16
Fig 15
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TASK 4:  Nested loop

Example : (Fig 17) Output : (Fig 18)

TASK 5:  Break , continue and pass statement

Example : Python break (Fig 19)

Output (Fig 20)

Example2: Python continue (Fig 21)

Output (Fig 22)

Example3: pass Statement

a=int (input(“Enter any number :”))

if (a==0):

pass

else:

print (“non zero value is accepted”)

Output:

Enter any number :3

non zero value is accepted                                                                                                        

Fig 18Fig 17

Fig 22

Fig 21

Fig 20

Fig 19
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IT & ITES	                                                                                      Exercise 1.41.08 	
	COPA - Elective Module 1 - Programming in Python	

Document code segments using comments and documentation strings
Objectives: At the end of this exercise you shall be able to
•	 state python comments
•	 state pyhton docstrings.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  Python Comments

1	 Example1: single-line comment (Fig 1) 2	 Example2:  multi-line strings comment (Fig 2)

TASK 2:  Python docstrings

1	 Example1: sing (Fig 3)

Ouput (Fig 4)

Example2: Multi-line Docstrings
def my_function(arg1):
	 “””
	 Summary line.
	 Extended description of function.
	 Parameters:
	 arg1 (int): Description of arg1
	 Returns:
	 int: Description of return value
	 “””
	 return arg1
print(my_function.__doc__)
Output:
    Summary line.
    Extended description of function.
    Parameters:
    arg1 (int): Description of arg1
    Returns:
    int: Description of return value

Fig 2Fig 1

Fig 3

Fig 4
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Example 3:Docstrings for Python functions (Fig 5)

Output (Fig 6)

Example 4: Docstrings for Python class (Fig 7)

Output (Figs 8 & 9)

Fig 5

Fig 6

Fig 7

Fig 9

Fig 8
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IT & ITES	                                                                                       Exercise 1.41.09 	
	COPA - Elective Module 1 - Programming in Python	

Construct and analyze code segments that include list comprehensions, 
tuple, set and dictionary comprehensions
Objectives: At the end of this exercise you shall be able to
•	 state list comprehensions
•	 state tuple in list comprehension
•	 state set comprehensions
•	 state dictionary comprehension.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  : List comprehensions

1	 Example1: Finding Even Numbers Using List 
Comprehension

#Using List Comprehension

evenno=[n for n in range(1,11) if n%2==0]

print (evenno)

Output:

[2, 4, 6, 8, 10]

Example2: Finding square of numbers using List 
Comprehension

#Using List Comprehension

square=[x*x for x in range(1,11)]

print (square)

Output:

[1, 4, 9, 16, 25, 36, 49, 64, 81, 100]

Example3: Nested List Comprehension

List of even numbers from 0 to 10. Nested list 
comprehension will return that expression (list of even 
numbers from 0 to 10) three times(range(3))

#Using List Comprehension

l1=[[n for n in range(10) if n %2==0] for n1 in range(3)]

print (l1)

Output:

[[0, 2, 4, 6, 8], [0, 2, 4, 6, 8], [0, 2, 4, 6, 8]]

TASK 2  : Tuple in List Comprehension

1	 Example 1: Creating a list of tuples using List 
Comprehension with two ‘for’ clause:

#Using tuple in List Comprehension

a1=[‘red’,’green’,’blue’]

b1=[0,1,2]

a2=[(a,b) for a in a1 for b in b1]

print (a2)

Output:

[(‘red’, 0), (‘red’, 1), (‘red’, 2), (‘green’, 0), (‘green’, 1), 
(‘green’, 2), (‘blue’, 0), (‘blue’, 1), (‘blue’, 2)]

Example2: Example tuple comprehension Python

#Using tuple Comprehension

tuple1 = (1, 6, 5, 9, 9, 1, 25, 76)

tuple2 = tuple((i for i in tuple1 if i % 5 == 0))

print(tuple2)

Output:

(5, 25)
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TASK 3  : Set Comprehensions

Example1: How to find even numbers using set 
Comprehension

#Using Set Comprehension

s1={n for n in range(1,11) if n%2==0}

print (s1)

Output:

{2, 4, 6, 8, 10}

Example2: How to find the square of numbers using Set 
Comprehension.

#Using Set Comprehension

s1={n*n for n in range(1,11)}

#Sets are unordered.

print (s1)

Output:

{64, 1, 4, 36, 100, 9, 16, 49, 81, 25}

TASK 4 : Dictionary Comprehension

Example1: How to find the square of numbers using 
Dictionary Comprehension.

#Using Dictionary Comprehension

d1={n:n*n for n in range(1,11)}

print (d1)

Output:

{1: 1, 2: 4, 3: 9, 4: 16, 5: 25, 6: 36, 7: 49, 8: 64, 9: 81, 
10: 100}

Example2: How to iterate through two dictionaries using 
dictionary comprehension.

#Using Dictionary Comprehension

d1={‘color’,’shape’,’fruit’}

d2={‘red’,’circle’,’apple’}

d3={k:v for (k,v) in zip(d1,d2)}

print (d3)

Output:

{‘shape’: ‘circle’, ‘color’: ‘red’, ‘fruit’: ‘apple’}
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IT & ITES	                                                                                       Exercise 1.42.10 	
	COPA - Elective Module 1 - Programming in Python 	

Perform basic operations using built-in modules
Objectives: At the end of this exercise you shall be able to
•	 state basic operations using built-in modules.

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  : Basic operations using built in modules

1	 Example1: User Defined Modules

	 A module is a file containing Python definitions 
and statements. The file name is the module name 
with the suffix .py appended. Within a module, the 
module’s name (as a string) is available as the value 
of the global variable __name__. For instance, use 

your favorite text editor to create a file called fibo.py 
in the current directory with the following contents: 
(Fig 1)

Now enter the Python interpreter and import this module 
with the following command: (Fig 2)

Example 2: importing built-in module math

Now enter the Python interpreter and import this module 
with the following command:

# importing built-in module math

import math  

# using square root(sqrt) function contained 

Fig 2

Fig 1
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# in math module

print(math.sqrt(25))   

# using pi function contained in math module

print(math.pi)   

# 2 radians = 114.59 degrees

print(math.degrees(2))    

# 60 degrees = 1.04 radians

print(math.radians(60))    

# Sine of 2 radians

print(math.sin(2))    

# Cosine of 0.5 radians

print(math.cos(0.5))    

# Tangent of 0.23 radians

print(math.tan(0.23))   

# 1 * 2 * 3 * 4 = 24

print(math.factorial(4))

Output:

5.0

3.141592653589793

114.59155902616465

1.0471975511965976

0.9092974268256817

0.8775825618903728

0.23414336235146527

24

Example3: importing built-in module random

Now enter the Python interpreter and import this module 
with the following command:

# importing built in module random

import random  

# printing random integer between 0 and 5

print(random.randint(0, 5))    

# print random floating point number between 0 and 1

print(random.random())    

# random number between 0 and 100

print(random.random() * 100)    

List = [1, 4, True, 800, “python”, 27, “hello”]  

# using choice function in random module for choosing 

# a random element from a set such as a list

print(random.choice(List))   

Output:

0

0.026096725940513155

26.894824199392342

27

Example4: importing built-in module datetime

Now enter the Python interpreter and import this module 
with the following command:

# importing built in module datetime

import datetime

from datetime import date

import time  

# Returns the number of seconds since the

# Unix Epoch, January 1st 1970

print(time.time())   

# Converts a number of seconds to a date object

print(date.fromtimestamp(454554))  

Output:

1659024623.8910193

1970-01-06

Example5: Directories List for Modules

# importing sys module

>>import sys  

# importing sys.path

>>print(sys.path) (Fig 3)

Example 6.1: importing built-in module OS

import os

os.mkdir(“d:\\tempdir”)

os.chdir(“d:\\tempdir”)

Fig 3
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os.getcwd()

Output: 

Check the created folder on the mentioned location in D 
Drive or not. (Fig 4)

os.rmdir(“d:\\tempdir”)

Output: 

Created folder will be deleted from the mentioned 
location. 

Example6.3: importing built-in module OS

import os

os.listdir(“d:”)

Output:  It will list all the available folder and file on the 
mentioned drive or location. 

[‘$MfeDeepRem’, ‘$RECYCLE.BIN’, 
‘1_5071341518753628456.mkv’, ‘Angamaly_
Diaries_720p.mp4’, ‘Beast.mkv’, ‘Belse wedding’, 
‘Binaries’, ‘CC’, ‘Garden’, ‘GOVT ITI’, ‘I_Am_Legend_
(2007)_720p_Tamil.mp4’, ‘LAPTOP-M1EH6EN’, 
‘MediaID.bin’, ‘msdia80.dll’, ‘NIMI’, ‘Personal_
Agilan’, ‘RRR.mkv’, ‘Sai Studies’, ‘Sai UKG School 
Documents’, ‘SAIMI Academy’, ‘Software’, ‘System 
Volume Information’, ‘The_Pursuit_Of_Happyness_
(2006)_720p_BDRip_[Tamil_+_Telugu_+.mp4’, 
‘VirtualBox VMs’, ‘WebADI.xls’, ‘WINDOWS OS ISO’, 
‘WindowsImageBackup’, ‘www.TamilBlasters.click - 
K.G.F Chapter 2 (2022) Tamil - 720p HDRip - x264 - 
AAC - 1.4GB - HC ESubs.mkv’,]

Example6.2: importing built-in module OS

import os

os.chdir(“..”)

os.getcwd()

Fig 4
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IT & ITES	                                                                                       Exercise 1.42.11 	
	COPA - Elective Module 1 - Programming in Python 	

Solve complex computing problems by using built-in modules
Objectives: At the end of this exercise you shall be able to
•	 state complex computing problems by using built-in modules .

Requirements

Tools/Equipment/Machines

•	 Desktop/ laptop PC		  - 1 No.
•	 Windows OS		  - 1 No.

•	 Python Ver 3.10.5 or latest		  - 1 No.

PROCEDURE

TASK 1:  : Complex computing problems by using built-in modules

Example1: Write a Python program to generate a 
random color hex, a random alphabetical string, random 
value between two integers (inclusive) and a random 
multiple of 7 between 0 and 70

import random

import string

print(“Generate a random color hex:”)

print(“#{:06x}”.format(random.randint(0, 0xFFFFFF)))

print(“\nGenerate a random alphabetical string:”)

max_length = 255

s = “”

for i in range(random.randint(1, max_length)):

    s += random.choice(string.ascii_letters)

print(s)

print(“Generate a random value between two integers, 
inclusive:”)

print(random.randint(0, 10))

print(random.randint(-7, 7))

print(random.randint(1, 1))

print(“Generate a random multiple of 7 between 0 and 
70:”)

print(random.randint(0, 10) * 7)

Output:

Generate a random color hex:

#2566f8

Generate a random alphabetical string:

6

-5

1

Generate a random multiple of 7 between 0 and 70:

35

Example2: . Python program to find the area of a triangle 
whose sides are given

import math

a = float(input(“Enter the length of side a: “))

b = float(input(“Enter the length of side b: “))

c = float(input(“Enter the length of side c: “))

s = (a+b+c)/2

area = math.sqrt(s*(s-a)*(s-b)*(s-c))

print(“ Area of the triangle is: “, area)

Output:

Enter the length of side a: 10

Enter the length of side b: 15.5

Enter the length of side c: 23.9

 Area of the triangle is:  51.69470379062058

Example3: Python program to find the roots of a 
quadratic equation

import math

a = float(input(“Enter the first coefficient: “))

b = float(input(“Enter the second coefficient: “))

c = float(input(“Enter the third coefficient: “))

if (a!=0.0):

    d = (b*b)-(4*a*c) 

    if (d==0.0):

        print(“The roots are real and equal.”) 

        r = -b/(2*a)

        print(“The roots are “, r,”and”, r)

    elif(d>0.0):
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        print(“The roots are real and distinct.”)

        r1 = (-b+(math.sqrt(d)))/(2*a) 

        r2 = (-b-(math.sqrt(d)))/(2*a)

        print(“The root1 is: “, r1)

        print(“The root2 is: “, r2)

    else:

        print(“The roots are imaginary.”)

        rp = -b/(2*a)

        ip = math.sqrt(-d)/(2*a)

        print(“The root1 is: “, rp, “+ i”,ip)

        print(“The root2 is: “, rp, “- i”,ip)

else:

    print(“Not a quadratic equation.”)

Output:

Enter the first coefficient: 5.5

Enter the second coefficient: 6.5

Enter the third coefficient: 7.8

The roots are imaginary.

The root1 is:  -0.5909090909090909 + i 
1.033928558684211

The root2 is:  -0.5909090909090909 - i 
1.033928558684211

Example4: Python program to draw a circle of squares 
using Turtle

import turtle

x=turtle.Turtle()

def square(angle):

    x.forward(100)

    x.right(angle)

    x.forward(100)

    x.right(angle)

    x.forward(100)

    x.right(angle)

    x.forward(100)

    x.right(angle+10)

for i in range(36):

    square(90)

Output: (Fig 1)

Example5: Write a Python program to generate a 
random integer between 0 and 6 - excluding 6, random 
integer between 5 and 10 - excluding 10, random 
integer between 0 and 10, with a step of 3 and random 
date between two dates.

import datetime

print(“Generate a random integer between 0 and 6:”)

print(random.randrange(5))

print(“Generate random integer between 5 and 10, 
excluding 10:”)

print(random.randrange(start=5, stop=10))

print(“Generate random integer between 0 and 10, with 
a step of 3:”)

print(random.randrange(start=0, stop=10, step=3))

print(“\nRandom date between two dates:”)

start_dt = datetime.date(2019, 2, 1)

end_dt = datetime.date(2019, 3, 1)

time_between_dates = end_dt - start_dt

days_between_dates = time_between_dates.days

random_number_of_days = random.randrange(days_
between_dates)

random_date = start_dt + datetime.
timedelta(days=random_number_of_days)

print(random_date)

Output: 

Generate a random integer between 0 and 6:

1

Generate random integer between 5 and 10, excluding 
10:

6

Generate random integer between 0 and 10, with a step 
of 3:

0

Random date between two dates:

2019-02-26

Fig 1
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IT & ITES	 	 Exercise 1.38.01	
COPA - Elective Module II Programming in JAVA	

Installing JAVA
Objectives: At the end of this exercise you shall be able to
•	 learn how to install JAVA and to set the class path, learn and execute different types of data types and 
operators in java, declaration of variables

•	 review and reply to comments.

Requirements

Tools /Equipment/ Instruments

•	 A working PC, internet connection, Text editor, Browser & Java JDK         	 -1 No. / trainee

PROCEDURE

TASK 1:  Installation of java 

Fig 1

1	 open browser, go to link. Click on JDK Download for 
Java download JDK 8. (Fig 1)

2	 Next, (Fig 2)

1	 Accept License Agreement

2	 Download Java 8 JDK for your version 32 bit or JDK download 64 bit.

Fig 2
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3	 Click on download (Fig 3)

	 NOTE: When you click on the Installation link the popup will be open. Click on I reviewed and accept the Oracle 
Technology Network License Agreement for Oracle Java SE development kit and you will be redirectedto the 

login page. If you don’t have an oracle account, you can easily sign up by adding basics details of yours.

Fig 3

4	 Once the Java JDK 8 download is complete, run the exe for install JDK. Click Next (Fig 4)

Fig 4

5	 Select the PATH to install Java in Windows… You can leave it Default. Click next. (Fig 5)

Fig 5

6	 Once you install Java in windows, click Close.
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IT & ITES	 	 Exercise 1.38.02	
COPA - Elective Module II Programming in JAVA	

Setting the Class path
Objectives: At the end of this exercise you shall be able to
•	 create setting class path.

Requirements

Tools /Equipment/ Instruments

•	 A working PC, internet connection, Text editor, Browser & Java JDK         			   1 No. / trainee

Fig 1

2	 Click on advanced system settings. (Fig 2)

Fig 2

PROCEDURE

TASK 1:  Create setting class path	

1	 Right Click on the My Computer and Select the 
properties. (Fig 1)
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3	 Click on Environment Variables to set Java runtime environment. (Fig 3)

Fig 3

4	 Click on new button of user variables. (Fig 4)

Fig 4

5	 Type PATH in the variable name . (Fig 5)

Fig 5
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6	 Copy the path of bin folder which is installed in JDK folder. (Fig 6)

7	 Paste Path of bin folder in Variable value. Click on OK Button. (Fig 7)

8	 Go to command prompt and type javac commands. (Fig 8)

If you see a screen like below, Java is installed.	

Fig 6

Fig 8

Fig 7
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Requirements

Tools /Equipment/ Instruments

•	 A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee

IT & ITES	 	 Exercise 1.38.03	
COPA - Elective Module II Programming in JAVA	

Writing and Executing a simple JAVA Program to display “Hello”
Objectives: At the end of this exercise you shall be able to
•	 write and execute java program
•	 use various data type in Java.

Fig 1

PROCEDURE

TASK 1: Write and execute java program	

Step 1: open text editor

Step 2: write the code

Step 3: Save the file with .java extension

Step 4: open the command prompt

Step 5: change the file path (where your file is existing)

Step 6: give the command javac filename.java (ex: 
javac Demo.java)

Step 7: give command java classname (ex: java Demo) 
(Fig 1)

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



243

IT & ITES	 	 Exercise 1.39.04	
COPA - Elective Module II Programming in JAVA	

Use of various data types in JAVA
Objectives: At the end of this exercise you shall be able to
•	 use of various data types in JAVA.

Requirements

Tools /Equipment/ Instruments

• 	 A working PC, internet connection, Text editor, Browser & Java JDK         			   - 1 No. / trainee.

PROCEDURE

TASK 1: Use various data type in Java 

1	 Create file 2 	 Follow the below code and execute

SOURCE CODE

public class Main {

    public static void main(String[] args) {

    int myNum = 5;                 // integer (whole number)

    float myFloatNum = 5.99f;       // floating point number

    char myLetter = ‘D’;           // character

    boolean myBool = true;         // boolean

    String myText = “Hello”;       // String    

    System.out.println(myNum);

    System.out.println(myFloatNum);

    System.out.println(myLetter);

    System.out.println(myBool);

    System.out.println(myText);

  }

}

Fig 1
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IT & ITES	 	 Exercise 1.39.05	
COPA - Elective Module II Programming in JAVA	

Use various operators in JAVA
Objectives: At the end of this exercise you shall be able to
•	 use various operators in Java.  

Requirements

Tools /Equipment/ Instruments

•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.

PROCEDURE 

TASK 1: Use various operators in Java
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IT & ITES	 	 Exercise 1.39.06	
COPA - Elective Module II Programming in JAVA	

Create and use of local, Instance and class variables
Objectives: At the end of this exercise you shall be able to
•	 use various operators in Java.  

Requirements

Tools /Equipment/ Instruments

•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.
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•	 Declaring (creating) variables

Syntax: -       type variableName = value;

SOURCE CODE

public class VariableExample{

   int myVariable;

   static int data = 30;

   public static void main(String args[]){

      int a = 100;

      VariableExample obj = new VariableExample();

      System.out.println(“Value of instance variable myVariable: “+obj.myVariable);

      System.out.println(“Value of static variable data: “+VariableExample.data);

      System.out.println(“Value of local variable a: “+a);

   }

}

TASK 1: Variables in Java

Fig 1
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IT & ITES	 	 Exercise 1.39.07	
COPA - Elective Module II Programming in JAVA	

Read text from the keyboard using scanner class read text from keyboard 
using console class
Objectives: At the end of this exercise you shall be able to
•	 read text from the keybroard using scanner class.  

Requirements

Tools /Equipment/ Instruments

•	  A working PC, internet connection, Text editor, Browser & Java JDK         	 1 No.

Follow the below code:- 

SOURCE CODE

import java.util.*;  
class UserInputDemo   
{  
public static void main(String[] args)  
{  
Scanner sc= new Scanner(System.in);    //System.in is a standard input stream  
System.out.print(“Enter first number- “);  
int a= sc.nextInt();  
System.out.print(“Enter second number- “);  
int b= sc.nextInt();  
System.out.print(“Enter third number- “);  
int c= sc.nextInt();  
int d=a+b+c;  
System.out.println(“Total= “ +d);  
}  
}  

Fig 1

SOURCE CODE

import java.io.Console;  
class ReadStringTest{    
public static void main(String args[]){    
Console c=System.console();    
System.out.println(“Enter your name: “);    
String n=c.readLine();    
System.out.println(“Welcome “+n);    
}    

Fig 2
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IT & ITES	 	 Exercise 1.40.08	
COPA - Elective Module II Programming in JAVA 	

Use if tge if and if ... else  statement
Objectives: At the end of this exercise you shall be able to
•	 learn conditional statements like IF, IF .... ELSE, Switch statement; understand difference between BREAK 
& CONTINUE keywords; Different kind of loops in JAVA like WHILE, DO-WHILE, FOR Loops. 

Requirements

Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.

PROCEDURE

TASK 1:  Use the if and if.....else statements, Break and Continue keyword

If statement

Syntax:

if (condition) {

// block of code to be executed if the condition is true

}

Fig 1
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If…….else statement

Follow the below syntax:

Fig 2
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IT & ITES	 	 Exercise 1.40.09&12	
COPA - Elective Module II Programming in JAVA 	

Use of the Switch Statements & Break and continue keywords
Objectives: At the end of this exercise you shall be able to
•	 use of the switch statements
•	 use of the break and contine keywords.

Requirements
Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.

Switch statement & Break Keyword
Follow the below syntax:

Fig 1

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



251

Continue Keyword
Syntax: - 

jump-statement;    

continue

SOURCE CODE
//inside the for loop.  
public class ContinueExample {  
public static void main(String[] args) {  
 	 //for loop  
	 for(int i=1;i<=10;i++){  
		  if(i==5){  
		     //using continue statement  
		    continue;//it will skip the rest statement  
	       }  
        System.out.println(i);  
   }  
}  
} 

Fig 2
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IT & ITES	 	 Exercise 1.40.10	
COPA - Elective Module II Programming in JAVA 	

Use of the Do ... While and while - do loops
Objectives: At the end of this exercise you shall be able to
•	 use of the Do ... While and while - do loops.

	 Requirements
Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK			   -1 No. / trainee.

While loop

Syntax: -

while (condition){    

//code to be executed   

Increment / decrement statement  

}

Fig 1

Fig 2Do-While loop
Syntax: -
	 do{    
	 //code to be executed / loop body  
	 //update statement   

	 }while (condition);  
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IT & ITES	 	 Exercise 1.40.11	
COPA - Elective Module II Programming in JAVA 	

Use of the For Loop
Objectives: At the end of this exercise you shall be able to
•	 use of the For Loop in JAVA.

	 Requirements
Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK 			   -1 No. / trainee.

PROCEDURE 

TASK 1: Loops in JAVA

For loop
Syntax:

for (initialization; condition; increment/decrement) {    

//statement or code to be executed    

}

Fig 1
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IT & ITES	 	 Exercise 1.40.13	
COPA - Elective Module II Programming in JAVA 	

Use of the JAVA Character Class Methods
Objectives: At the end of this exercise you shall be able to
•	 use of the JAVA Character Class Methods.

	 Requirements
Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.

Java Number Class

Java Number class is an abstract class which is placed 
in java.lang package. It has four abstract methods and 
two concrete methods. The abstract class Number is 
the superclass of classes BigDecimal, BigInteger, Byte, 
Double, Float, Integer, Long, and Short. This class 
contains a single consructor number().

Number Class Methods

Java Number class provides methods to convert the 
represented numeric value to byte, double, float, int, 
long, and short type. The various Java Number methods 
are as follows-

Java Number byteValue() Method
The byteValue() is a method of Java Number class which automatically converts the given number into a primitive 
byte type and returns the value of the specified number as a byte.

Syntax:

Following is the declaration of byteValue() method:
1	 public byte byteValue()  

Parameter:

Flowchart of Break Statement
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Returns:

The byteValue() method returns the numeric value 
represented by this object after conversion to the 
primitive byte type.

Compatibility Version:

Java 1.1 and above

Example 1
1	 public class NumberByteValueExample1 {  

2	 public static void main(String[] args) {          

3	 Integer i = 123456;        

4	 //Convert number value into byte type  

5	 int Result = i.byteValue();  

6	 System.out.println(“Number as Byte: “+Result);  

7	 }  

8	 }  

Output:
Number as Byte: 64

Example 2
1	 public class NumberByteValueExample2 {  

2	 public static void main(String[] args) {          

3	 Integer i = -123456;  

4	 Float f = 435f;  

5	 Double d = 65868.685;  

6	 //Convert number value into byte type  

7	 System.out.println(“Integer Number as Byte: “+i.
byteValue());  

8	 System.out.println(“Float Number as Byte: “+f.
byteValue());  

9	 System.out.println(“Double Number as Byte: “+d.
byteValue());  

10	}  

11	}  

Output:
Integer Number as Byte: -64

Float Number as Byte: -77

Double Number as Byte: 76

Example 3
1	 import java.io.IOException;  

2	 import java.util.Scanner;  

3	 public class NumberByteValueExample3 {  

4	 public static void main(String[] args)throws 
IOException {  

5	 Scanner scan = new Scanner(System.in);  

6	 System.out.print(“Enter the Number Value: “);  

7	 Integer num = scan.nextInt();     

8	  //Convert number value into byte type  

9	 System.out.println(“Integer Number as Byte: “+num.
byteValue());            

10	scan.close();  

11	  }  

12	}  

Output:
Enter the Number Value: ABCDEF

Exception in thread “main” java.util.
InputMismatchException

	 at java.base/java.util.Scanner.throwFor(Scanner.
java:939)

	 at java.base/java.util.Scanner.next(Scanner.
java:1594)

	 at java.base/java.util.Scanner.nextInt(Scanner.
java:2258)

	 at java.base/java.util.Scanner.nextInt(Scanner.
java:2212)

	 at myPackage.NumberByteValueExample3.
main(NumberByteValueExample3.java:9)
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IT & ITES	 	 Exercise 1.40.14	
COPA - Elective Module II Programming in JAVA 	

Character class methods in JAVA
Objectives: At the end of this exercise you shall be able to
•	 character class methods in JAVA.

	 Requirements
Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.

PROCEDURE 

TASK 1: Character class methods in Java

Fig 1
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IT & ITES	 	 Exercise 1.40.15	
COPA - Elective Module II Programming in JAVA 	

String class methods in JAVA
Objectives: At the end of this exercise you shall be able to
•	 string class methods in JAVA.

	 Requirements
Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.

PROCEDURE 

TASK 1: String class methods in Java

Follow below example: -

Fig 1
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IT & ITES	 	 Exercise 1.40.16	
COPA - Elective Module II Programming in JAVA 	

Create and use array
Objectives: At the end of this exercise you shall be able to
•	 create and use array.

	 Requirements
Tools /Equipment/ Instruments
•	  A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No. / trainee.

PROCEDURE 

TASK 1: Create and use array

1	 To declare an array, define the variable type with square brackets.

2	 use comma to separate inserted value.

SOURCE CODE
public class Main {

  public static void main(String[] args) {

    String[] cars = {“Volvo”, “BMW”, “Ford”, “Mazda”};

    System.out.println(cars[0]);

    int[] num = {23,12,9,17};

    System.out.println(num[2]);

  }

}

Change an Array Element:

To change the value of a specific element, refer to the index number.

SOURCE CODE
public class Main {

  public static void main(String[] args) {

    String[] cars = {“Volvo”, “BMW”, “Ford”, “Mazda”};

    cars[0] = “Opel”;

    System.out.println(“updated value is : “+cars[0]);

  }

}

Fig 1

Fig 2
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To find out how many elements an array has, use the length property:

SOURCE CODE
public class Main {

  public static void main(String[] args) {

    String[] cars = {“Volvo”, “BMW”, “Ford”, “Mazda”};

    System.out.println(“Array length : “+cars.length);

  }

}

Fig 3

Loop Through an Array :
1	 use for loop

2	 use length property 

3	 follow the below code

SOURCE CODE

public class Main {

  public static void main(String[] args) {

    String[] cars = {“Volvo”, “BMW”, “Ford”, “Mazda”};

    for (int i = 0; i < cars.length; i++) {

      System.out.println(cars[i]);

    }

  }

}

Fig 4
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IT & ITES	 	 Exercise 1.41.17	
COPA - Elective Module II Programming in JAVA 	

Create and use of simple classes, objects and methods in JAVA
Objectives: At the end of this exercise you shall be able to
•	 create and use of simple classes, objects and methods in JAVA.

Requirements

Tools /Equipment/ Instruments

• 	 A working PC, internet connection, Text editor, Browser & Java JDK         			   - 1 No.

PROCEDURE

TASK 1:  Create and use simple classes, objects and methods in JAVA

SOURCE CODE

// Create a Main class
public class Main {
 
  // Create a fullThrottle() method
  public void fullThrottle() {
    System.out.println(“The car is going as fast as it can!”);
  }

  // Create a speed() method and add a parameter
  public void speed(int maxSpeed) {
    System.out.println(“Max speed is: “ + maxSpeed);
  }

  // Inside main, call the methods on the myCar object
  public static void main(String[] args) {
    Main myCar = new Main();     // Create a myCar object
    myCar.fullThrottle();      // Call the fullThrottle() method
    myCar.speed(200);          // Call the speed() method
  }
}

Fig 1

1	 To create class, use “class” keyword. 

2	 To create object use “new” keyword.

3	 To declare method use “access_modifier return_type 
function_name()” .
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IT & ITES	 	 Exercise 1.41.18&19	
COPA - Elective Module II Programming in JAVA 	

Passing and returning data and objects to method
Objectives: At the end of this exercise you shall be able to
•	 Passing and returning data and objects to method.

Requirements

Tools /Equipment/ Instruments

• 	 A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No.

PROCEDURE 

TASK 1: Passing and returning data and objects to method

1	 Follow below code

2	 Save that with ‘.java’ extension

3	 Compile and run that.

SOURCE CODE
public class PassByValue {
   static int k =10;
   static void passPrimitive(int j) {
      System.out.println(“the value of passed primitive is “ + j);
      j = j + 1;
   }
   static void passReference(EmployeeTest emp) {
      EmployeeTest reference = emp;
      System.out.println(“the value of name property of our object is “+ emp.getName());
      reference.setName(“Bond”);
   }
   public static void main(String[] args) {
      EmployeeTest ref = new EmployeeTest();
      ref.setName(“James”);
      passPrimitive(k);
      System.out.println(“Value of primitive after get passed to method is “+ k);
      passReference(ref);
      System.out.println(“Value of property of object after reference get passed to method 
is “+          ref.getName());
   }
}
class EmployeeTest {
   String name;
   public String getName() {
      return name;
   }
   public void setName(String name) { 
      this.name = name;
   }
}

Fig 1
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IT & ITES	 	 Exercise 1.41.20	
COPA - Elective Module II Programming in JAVA 	

Use constructors in JAVA
Objectives: At the end of this exercise you shall be able to
•	 use constructors in JAVA.

Requirements

Tools /Equipment/ Instruments

• 	 A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No.

PROCEDURE 

TASK 1: use constructors in Java 
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1	 Constructor name must be the same as its class 
name

2	 A Constructor must have no explicit return type

3	 A Java constructor cannot be abstract, static, final, 
and synchronized

	 NOTE: You can use access modifiers while 
declaring a constructor. It controls the object 
creation. In other words, we can have private, 
protected, public or default constructor in 
Java.

SOURCE CODE

// Java program to illustrate Constructor Chaining
// within same class Using this() keyword
class Temp
{
	 // default constructor 1
	 // default constructor will call another constructor
	 // using this keyword from same class
	 Temp()
	 {
		  // calls constructor 2
		  this(5);
		  System.out.println(“The Default constructor”);
	 }

	 // parameterized constructor 2
	 Temp(int x)
	 {
		  // calls constructor 3
		  this(5, 15);
		  System.out.println(x);
	 }

	 // parameterized constructor 3
	 Temp(int x, int y)
	 {
		  System.out.println(x * y);
	 }

	 public static void main(String args[])
	 {
	 	 // invokes default constructor first
		  new Temp();
	 }
}

Fig 1
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IT & ITES	 	 Exercise 1.41.21	
COPA - Elective Module II Programming in JAVA 	

Create and use overloaded methods in JAVA
Objectives: At the end of this exercise you shall be able to
•	 create and use overloaded methods in JAVA.

Requirements

Tools /Equipment/ Instruments

• 	 A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No.

PROCEDURE 

TASK 1: Create and use overloaded methods in Java

There are two ways to overload the method in java

1	 By changing number of arguments

2	 By changing the data type

	 NOTE: In Java, Method Overloading is not 
possible by changing the return type of the 
method only.

• 	 Method Overloading: changing no. of arguments

SOURCE CODE

	 class Adder{  
	 static int add(int a,int b){return a+b;}  
	 static int add(int a,int b,int c){return 

a+b+c;}  
	 }  
	 class TestOverloading1{  
	 public static void main(String[] args){  
	 System.out.println(Adder.add(11,11));  
	 System.out.println(Adder.add(11,11,11));  
	 }
	 }  

•	 Method Overloading: changing data types of 
arguments

SOURCE CODE

	 class Adder{  
	 static int add(int a, int b){
     return a+b;
	 }  
	 static double add(double a, double b){
	      return a+b;
	 }  
	 }  
	 class TestOverloading2{  
	 public static void main(String[] args){  
	 .System.out.println(Adder.add(11,11));  
	 . S y s t e m . o u t . p r i n t l n ( A d d e r .

add(12.3,12.6)); 
	 .}
	 } 

Fig 1

Fig 2
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IT & ITES	 	 Exercise 1.41.22	
COPA - Elective Module II Programming in JAVA 	

Override methods in JAVA
Objectives: At the end of this exercise you shall be able to
•	 create and use of Overriding methods in JAVA.

PROCEDURE 

TASK 1: Create and use of Overriding methods in JAVA

Requirements

Tools /Equipment/ Instruments

• 	 A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No.

1	 The method must have the same name as in the 
parent class

2	 The method must have the same parameter as in 
the parent class.

3	 There must be an IS-A relationship (inheritance).

SOURCE CODE

Fig 1

//Java Program to demonstrate the real scenario of Java Method Overriding  
	 //where three classes are overriding the method of a parent class.  
	 //Creating a parent class.  
	 class Bank{  
	 int getRateOfInterest(){return 0;}  
}  
	 //Creating child classes.  
	 class SBI extends Bank{  
	 int getRateOfInterest(){return 8;}  
}  
class ICICI extends Bank{  
int getRateOfInterest(){return 7;}  
}  
class AXIS extends Bank{  
int getRateOfInterest(){return 9;}  
}  
//Test class to create objects and call the methods  
class Test2{  
public static void main(String args[]){  
SBI s=new SBI();  
ICICI i=new ICICI();  
AXIS a=new AXIS();  
System.out.println(“SBI Rate of Interest: “+s.getRateOfInterest());  
System.out.println(“ICICI Rate of Interest: “+i.getRateOfInterest());  
System.out.println(“AXIS Rate of Interest: “+a.getRateOfInterest()); 
}  
}  
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IT & ITES	 	 Exercise 1.41.23	
COPA - Elective Module II Programming in JAVA 	

Create and use super class, sub class in JAVA
Objectives: At the end of this exercise you shall be able to
•	 create and use super class and sub class.

Requirements

Tools /Equipment/ Instruments

• 	 A working PC, internet connection, Text editor, Browser & Java JDK         			   -1 No.

PROCEDURE 

TASK 1: Create and use super class and sub class

SOURCE CODE

Package inheritance;
public class Parentclass 
{ 
  void m1()
  { 
    System.out.println(“Superclass m1 method”); 
  } 
} 
public class Childclass extends Parentclass 
{ 
  void m2()
  { 
     System.out.println(“Childclass m2 method”); 
  } 
} 
public class Test 
{ 
  public static void main(String[] args) 
  { 
 // Creating an object of superclass. 
  Childclass c = new Childclass(); // Accessing superclass and subclass members using 

subclass object reference variable. 
    c.m1(); 
    c.m2(); 
   } 
 }

Fig 1

•	 subclass (child) - the class that inherits from another 
class

•	 superclass (parent) - the class being inherited from

To inherit from a class, use the extends keyword.
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IT & ITES	 Excercise 1.42.24&25
COPA - Elective Module II Programming in JAVA  

Virtual methods, abstract class in JAVA

Objectives: At the end of this exercise you shall be able to:
•	 create thread and know about some methods of the Thread class and multithreading
•	 handle exceptions. Know about try-catch, “throw” & “finally” keyword, virtual method and abstract class 

and methods.

	 Requirements

PROCEDURE

TASK 1:  Create and use virtual methods

Tools/Equipment/Machines

•	 A working PC, internet connection, 	Text editor, Browser & Java JDK 	 1 No.

1	 You can override the virtual function with the 
inheriting class function using the same function 
name. 

2	 The virtual function is supposed to be defined in 
the derived class. You can call it by referring to the 
derived class’s object using the reference or pointer 
of the base class.

3	 A virtual function should have the same name and 
parameters in the base and derived class.

4	 For the virtual function, an IS-A relationship is 
necessary, which is used to define the class 
hierarchy in inheritance.

	 The Virtual function cannot be private, as the private 
functions cannot be overridden.

Child.java:

5	 A virtual function or method also cannot be final, as 
the final methods also cannot be overridden.

6	 Static functions are also cannot be overridden; so, a 
virtual function should not be static.

7	 By default, every non-static method in Java is a 
virtual function

Let’s understand it with some examples:

Parent.Java:
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TASK 2:  Create abstract class and methods

1	 Create abstract class and methods as follows.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.42.24&25
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IT & ITES	 Excercise 1.42.26
COPA - Elective Module II Programming in JAVA  

Create interfaces in JAVA

Objectives: At the end of this exercise you shall be able to:
•	 create interfaces in JAVA. 

	 Requirements

Tools/Equipment/Machines

•	 A working PC, internet connection, 	Text editor, Browser & Java JDK	 -1 No.

PROCEDURE

TASK 1:  Create interfaces in JAVA

1	 To declare an interface use “interface” keyword.
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IT & ITES	 Excercise 1.42.27
COPA - Elective Module II Programming in JAVA  

Override method in JAVA

Objectives: At the end of this exercise you shall be able to:
•	 override method in JAVA. 

	 Requirements

Tools/Equipment/Machines

•	 A working PC, internet connection, 	Text editor, Browser & Java JDK 	 -1 No.

PROCEDURE

TASK 1:  Override method in JAVA

There are two ways to overload the method in java

1	 By changing number of arguments.

2	 By changing the data type.

NOTE: In Java, Method Overloading is not 
possible by changing the return type of the 
method only

Fig 1
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IT & ITES	 Excercise 1.42.28
COPA - Elective Module II Programming in JAVA  

Create and implement interfaces in JAVA

Objectives: At the end of this exercise you shall be able to:
•	 create and implement interfaces in Java. 

	 Requirements

Tools/Equipment/Machines

•	 A working PC, internet connection, 	Text editor, Browser & Java JDK			   1 No.

PROCEDURE

TASK 1:  Create and implement interfaces in JAVA

1	 To implement interface use “implements” keyword. 

2	 You cannot instantiate an interface.

3	 An interface does not contain any constructors.

4	 All of the methods in an interface are abstract. 

Fig 1
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IT & ITES	 Excercise 1.42.29
COPA - Elective Module II Programming in JAVA  

Extend interfaces in Java

Objectives: At the end of this exercise you shall be able to:
•	 extend interfaces in Java. 

	 Requirements

Tools/Equipment/Machines

•	 A working PC, internet connection, 	Text editor, Browser & Java JDK			   -1 No.

PROCEDURE

TASK 1:  Extend interfaces in Java

1	 To extend any interface use “extends” keyword. 

Fig 1

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



273

IT & ITES	 Excercise 1.42.30
COPA - Elective Module II Programming in JAVA  

Create and use a package in JAVA

Objectives: At the end of this exercise you shall be able to:
•	 create and use a package in JAVA. 

	 Requirements

Tools/Equipment/Machines

•	 A working PC, internet connection, 	Text editor, Browser & Java JDK			   1 No.

PROCEDURE

TASK 1:  Create and use a package in JAVA

1	 To create package use “package” keyword

2	 Follow below syntax: 

	 package package_name;

Fig 1
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Basic troubleshooting tips for Java issues

Objectives: At the end of this exercise you shall be able to:
•	 download and Install Java
•	 use Java, test Java
•	 remove Old Versions of Java
•	 find Java, always redirected to the java.com download page.

TASK 1:  Download and Install Java

1	 If you are having problems related to Java, the 
following tips should help you getting things working.

2	 Try the offline installer package (Windows only)

3	 The offline installer package will often complete 
successfully even though the online

4	 installer package has encountered a problem. The 
offline installer package file is large and will take 
longer to download than the online installer.

•	 Download the Windows Offline installer

5	 Uninstall any non-working Java installations

6	 Remove prior installations of Java that are not 
working before trying to install again.

•	 Uninstall Java for Windows

•	 Uninstall Java for Mac

7	 Temporarily turn off firewall or antivirus clients

8	 Active firewall or antivirus software may prevent 
Java from installing properly.

9	 Remember to turn your firewall or antivirus software 
back on when you have successfully completed the 
Java install.

10	Why do I get file corrupt message during Java 
installation?

11	This message is most commonly seen by Windows 
XP users. Running a Microsoft utility and trying 
the offline installer may resolve the issue. See the  
installshield FAQ  for more details.

TASK 2:  Check and verify java configuration and Test JAVA

1	 This application will check for Java versions on your 
computer.

2	 Out-of-date versions of Java on your computer 
may present a  serious security risk. If out-of-date 
versions are found, this tool will help you remove 
them.

3	 Close applications and other browser windows, and 
make sure there are no other installations pending, 
before continuing.

4	 UAC (User Account Control) dialogs As removing 
Java from your computer requires administrative 
permissions, when the application is started, 
Windows might trigger a warning requesting 
permission to run as an administrator.

TASK 3:  Remove old versions of JAVA

Why should I uninstall older versions of Java from 
my system?

This article applies to:

1	 Platform(s):  Windows 10, Windows 7, Windows 
8, Windows Vista, Windows XP, Windows 2008 
Server, Windows Server 2012

2	 Windows Users: Improve the security of your 
computer by checking for old versions of Java and 
removing them when you install Java 8 (8u20 and 
later versions) or by using the Java Uninstall Tool.

3	 The latest version of Java is always the recommended 
version as it contains feature updates, vulnerability 
fixes and performance improvements to previous 

versions. You can confirm that you have the latest 
version with the Java Verification page or manually 
checking the Java version.

Should I uninstall older versions of Java?

We highly recommend that you uninstall all older 
versions of Java from your system.

1	 Keeping old versions of Java on your system 
presents a serious security risk. 

2	 Uninstalling older versions of Java from your 
system ensures that Java applications will run with 
the latest security and performance improvements 
on your system.

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.42.30
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How can I remove older versions of Java?

Windows users can safely uninstall older versions 
of Java:

•	 when installing Java 8 (8u20 and above) or

TASK 4:  Always redirected to Java.com when visiting a page with a Java app.

Install the latest Java version

The continual redirection to java.com was a known 
issue affecting Java versions 7u25 and older. This issue 
was fixed with the 7u40 release of Java. To prevent 
prevent the redirect to java.com, download the latest 
Java version from http://java.com.

•	 by using the Java uninstall tool or

•	 by manually uninstalling Java for Windows

IT & ITES : COPA (NSQF - Revised 2022) - Exercise 1.42.30
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